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B Safety Precautions B |

@® When replacing A (Large Type)/AnS (Small Type) Series with Q Series @

Before using products introduced in this publication, please read this Transition

Examples and relevant manuals carefully and pay full attention to safety to handle

the product correctly.

In this publication, the safety precautions are classified into two levels:

"/\ WARNING" and "/\ CAUTION".

Indicates that incorrect handling may cause hazardous conditions,

A WARNING resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions,

A CAUTION resulting in minor or moderate injury or property damage.

Under some circumstances, failure to observe the precautions given under "/\ CAUTION" may lead
to serious consequences.
Observe the precautions of both levels because they are important for personal and system safety.

Make sure that the end users read this publication and keep it in a safe place for future reference.

|
|
|
|
|
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EE—— Design Precautions B

/\ WARNING

e Configure safety circuits external to the programmable controller to ensure that the entire system operates

safely even when a fault occurs in the external power supply or the programmable controller. Failure to do
S0 may result in an accident due to an incorrect output or malfunction.

(1) Configure external safety circuits, such as an emergency stop circuit, protection circuit, and protective
interlock circuit for forward/reverse operation or upper/lower limit positioning.

(2) The programmable controller stops its operation upon detection of the following status, and the output
status of the system will be as shown below.

Status Q Series Module A/AnS Series module
Overcurrent or overvoltage protection of
. . All out puts are turned off. All out puts are turned off.
the power supply module is activated.
The CPU module detects an error such as All outputs are held or turned
a watchdog timer error by the self-diagnostic off according to the parameter All out puts are turned off.
function. setting.

All outputs may turn on when an error occurs in the part, such as 1/0 control part, where the CPU module
cannot detect any error. To ensure safety operation in such a case, provide a safety mechanism or a
fail-safe circuit external to the programmable controller. For a fail-safe circuit example, refer to LOADING
AND INSTALLATION in the QCPU User's Manual (Hardware Design, Maintenance and Inspection).

(3) Outputs may remain on or off due to a failure of an output module relay or transistor. Configure an
external circuit for monitoring output signals that could cause a serious accident.




I Design Precautions B

/\. WARNING

e In an output module, when a load current exceeding the rated current or an overcurrent caused by a load
short-circuit flows for a long time, it may cause smoke and fire. To prevent this, configure an external safety
circuit, such as a fuse.

e Configure a circuit so that the programmable controller is turned on first and then the external power supply.
If the external power supply is turned on first, an accident may occur due to an incorrect output or
malfunction.

e For the operating status of each station after a communication failure, refer to relevant manuals for the
network.
Incorrect output or malfunction due to a communication failure may result in an accident.

e When controlling (changing data) the running programmable controller from a peripheral connected to the
CPU module or from a personal computer connected to an intelligent function module, configure an interlock
circuit in the sequence program to ensure that the entire system will always operate safely.

For other controls for the running programmable controller (program modification and operating status
change (status control)), read relevant manuals carefully, and ensure the safety before operation.
Especially, in the case of a control from an external device to a remote programmable controller, immediate
action cannot be taken for a problem on the programmable controller due to a communication failure.
Configure an interlock circuit in the sequence program, and determine corrective actions to be taken
between the external device and CPU module in case of a communication failure.

/\ CAUTION

e Do not install the control lines or communication cables together with the main circuit lines or power cables.
Keep a distance of 100mm (3.94 inches) or more between them.
Failure to do so may result in malfunction due to noise.

e When a device such as a lamp, heater, or solenoid valve is controlled through an output module, a large
current (approximately ten times greater than normal) may flow when the output is turned from off to on.
Take measures such as replacing the module with one having a sufficient current rating.

e The time for the CPU module to enter the RUN status after the CPU module is powered off and on or reset
will vary depending on the system configuration, parameter settings, and/or program size, etc.
Design the program so that the entire system will operate safely even if the time to reach the RUN status
varies.




E—— Installation Precautions |

/\ CAUTION

e Use the programmable controller in an environment that meets the general specifications in the QCPU
User's Manual (Hardware Design, Maintenance and Inspection).
Failure to do so may result in electric shock, fire, malfunction, or damage to or deterioration of the product.

e To mount the module, while pressing the module mounting lever located in the lower part of the module, fully
insert the module fixing projection(s) into the hole(s) in the base unit and press the module until it snaps into
place.

Incorrect mounting may cause malfunction, failure or drop of the module.

When using the programmable controller in an environment of frequent vibrations, fix the module with a
screw.

Tighten the screw within the specified torque range.

Undertightening can cause drop of the screw, short circuit or malfunction.

Overtightening can damage the screw and/or module, resulting in drop, short circuit, or malfunction.

e When using an extension cable, connect it to the extension cable connector of the base unit securely.
Check the connection for looseness.
Poor contact may cause incorrect input or output.

e When using an SD memory card, fully insert it into the SD memory card slot.
Check that it is inserted completely.
Poor contact may cause malfunction.

e When using an extended SRAM cassette, fully insert it into the cassette connector on the CPU module.
Close the cassette cover to keep the extended SRAM cassette inserted completely.
Poor contact may cause malfunction.

e Shut off the external power supply for the system in all phases before mounting or removing the module.
Failure to do so may result in damage to the product.
A module can be replaced online (while power is on) on any MELSECNET/H remote 1/O station or in the
system where a CPU module supporting the online module change function is used.
Note that there are restrictions on the modules that can be replaced online, and each module has its
predetermined replacement procedure.
For details, refer to the relevant sections in the QCPU User's Manual (Hardware Design, Maintenance and
Inspection) and in the manual for the corresponding module.

e Do not directly touch any conductive part or electronic component of the module, memory card, SD memory
card or extended SRAM cassette. Doing so can cause malfunction or failure.

e When using a motion CPU module and a motion module, make sure that proper modules are combined
before turning on power. If improper modules are used, they may be damaged. For details, refer to the
Motion CPU Module User's Manual.




E—— Wiring Precautions B

/\ WARNING

e Shut off the external power supply for the system in all phases before mounting or wiring the module.
Failure to do so may result in electric shock or damage to the product.

e After mounting or wiring, attach the included terminal cover onto the module before turning the power on or
starting operation.
Failure to do so may result in electric shock.

/\ CAUTION

e Ground the FG and LG terminals to the dedicated conductors for the programmable controller (Class D
(Class 3) or higher grounding).
Failure to do so may result in electric shock or malfunction.

e Use applicable solderless terminals and tighten them within the specified torque range.
If any spade solderless terminal is used, it may be disconnected when the terminal screw comes loose,
resulting in failure.

e Check the rated voltage and terminal layout before wiring to the module, and connect the cables correctly.
Inputting voltage different from the rated voltage, connecting a power supply with a different voltage rating or
incorrect wiring may cause a fire or failure.

e Connectors for external connection must be crimped or pressed with the tool specified by the manufacturer,
or must be correctly soldered.
Incomplete connections could result in short circuit, fire, or malfunction.

e Fit the connectors surely to the module. Poor contact may cause malfunction.

e Do not bundle the control cable or communication cable with the main circuit or power wire, or lay them
adjacently.
Separate these by 100 mm or more.
Failure to observe this could lead to malfunctioning caused by noise.

e When connecting any cable, check the type of the interface to be connected.
Connecting to an improper interface or incorrect wiring may damage the module and external devices.

e Tightening the terminal screws within the specified torque range.
Under tightening the terminal screws can cause short circuit, a fire or malfunction.
Overtightening can damage the screw and/or module, resulting in drop, short circuit, or malfunction.

e Prevent foreign matter such as dust or wire chips from entering the module.
Such foreign matter can cause a fire, failure, or malfunction.

e A protective film is attached to the top of the module to prevent foreign matter, such as wire chips, from
entering the module during wiring.
Do not remove the film during wiring.
Remove it for heat dissipation before system operation.

e When disconnecting any cable from the module, do not pull the cable.
When disconnecting a cable with a connector, hold the connector of the connecting part of the module.
Before disconnecting a cable from the terminal block, loosen the terminal screw on the terminal block.
Pulling the cable with the terminal connected to the module may cause malfunction or damage to the
module or cable.

e Mitsubishi programmable controllers must be installed in control panels.
Connect the main power supply to the power supply module in the control panel through a relay terminal
block.
Wiring and replacement of a power supply module must be performed by maintenance personnel who is
familiar with protection against electric shock. (For wiring methods, refer to the QCPU User's Manual
(Hardware Design, Maintenance and Inspection)).




— Startup and Maintenance Precautions | —

/\ WARNING

e Do not touch any terminal while power is on.
Doing so will cause electric shock.

e Correctly connect the battery connector.
The battery must not be charged, disassembled, heated, thrown into the fire, short-circuited, soldered,
wetted with a liquid or exposed to strong shock.
Doing so will cause the battery to produce heat, explode, or ignite, resulting in injury and fire.

e Shut off the external power supply for the system in all phases before cleaning the module or retightening
the terminal screws or module fixing screws.
Failure to do so may result in electric shock, damage to the module and malfunction.

/\ CAUTION

e Before performing online operations (especially, program modification, forced output, and operation status
change) for the running CPU module from the peripheral connected, read relevant manuals carefully and
ensure the safety.

Improper operation may damage machines or cause accidents.

e Do not disassemble or modify the modules.
Doing so may cause failure, malfunction, injury, or a fire.

e Use any radio communication device such as a cellular phone or PHS (Personal Handy-phone System)
more than 25cm (9.85 inches) away in all directions from the programmable controller.
Failure to do so may cause malfunction.

e Shut off the external power supply for the system in all phases before mounting or removing the module.
Failure to do so may cause the module to fail or malfunction.
A module can be replaced online (while power is on) on any MELSECNET/H remote 1/O station or in the
system where a CPU module supporting the online module change function is used.
Note that there are restrictions on the modules that can be replaced online, and each module has its
predetermined replacement procedure.
For details, refer to the relevant sections in the QCPU User's Manual (Hardware Design, Maintenance and
Inspection) and in the manual for the corresponding module.

e Connection/disconnection of the module to/from the base unit and the extended SRAM cassette and
terminal block to/from the CPU module after the first use of the product shall be limited to 50 times.
(Compliant with JIS B 3502)

Exceeding the limit of 50 times may cause malfunction.

e Connection/disconnection of the SD memory card after the first use of the product shall be limited to 500
times. Exceeding the limit of 500 times may cause malfunction.

e Do not drop or apply shock to the battery to be installed in the module.
Doing so may damage the battery, causing the battery fluid to leak inside the battery.
If the battery is dropped or any shock is applied to it, dispose of it without using.

e Before handling the module, touch a grounded metal object to discharge the static electricity from the human
body.
Failure to do so may cause the module to fail or malfunction.




E— Disposal Precautions C —

/\ CAUTION

e When disposing of this product, treat it as industrial waste.
When disposing of batteries, separate them from other wastes according to the local regulations.
(For details of the battery directive in EU member states, refer to the QCPU User's Manual
(Hardware Design, Maintenance and Inspection).)

E— Transportation Precautions | ——

/\ CAUTION

e When transporting lithium batteries, follow the transportation regulations.
(For details of the regulated models, refer to the QCPU User's Manual (Hardware Design, Maintenance and
Inspection).)




@ When replacing AnS (Small Type) Series with L Series @

Before using products introduced in this publication, please read this Transition
Examples and relevant manuals carefully and pay full attention to safety to handle
the product correctly.

In this publication, the safety precautions are classified into two levels:

"/I\ WARNING" and "/\ CAUTION".

Indicates that incorrect handling may cause hazardous conditions,

A WARNING resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions,

A CAUTION resulting in minor or moderate injury or property damage.

|
|
|
|
|
|

Under some circumstances, failure to observe the precautions given under "/\ CAUTION" may lead

to serious consequences.
Observe the precautions of both levels because they are important for personal and system safety.

Make sure that the end users read this publication and keep it in a safe place for future reference.



I Design Precautions S

/\ WARNING

e Configure safety circuits external to the programmable controller to ensure that the entire system operates
safely even when a fault occurs in the external power supply or the programmable controller. Failure to do so
may result in an accident due to an incorrect output or malfunction.

(1) Configure external safety circuits, such as an emergency stop circuit, protection circuit, and protective
interlock circuit for forward/reverse operation or upper/lower limit positioning.

(2) The mechanical zero return of the positioning function is controlled based on two parameters, zero
return direction and zero return speed, and deceleration is started when the near-point dog is turned
on. Therefore, if the zero return direction is set incorrectly, the positioning function may continue the
operation without deceleration. Configure an interlock circuit for prevention of mechanical damage on the
outside of the programmable controller.

(3) When the CPU module detects an error during operation of the positioning function, the function will
decelerate and stop.

(4) The programmable controller stops its operation upon detection of the following status, and the output
status of the system will be as shown below.

e When the overcurrent or overvoltage protection of the power supply module is activated, all outputs
will be turned off.

e When the CPU module detects an error such as a watchdog timer error by the self-diagnostic
function, all outputs will be held or turned off according to the parameter setting.
All outputs may turn on when an error occurs in the part, such as I/0O control part, where the
CPU module cannot detect any error. To ensure safety operation in such a case, provide a safety
mechanism or a fail-safe circuit external to the programmable controller. For a fail-safe circuit
example, refer to LOADING AND INSTALLATION in the LCPU User's Manual (Hardware Design,
Maintenance and Inspection).

(5) Outputs may remain on or off due to a failure of a transistor on an output circuit. Configure an external
circuit for monitoring output signals that could cause a serious accident.

In an output circuit, when a load current exceeding the rated current or an overcurrent caused by a load
short-circuit flows for a long time, it may cause smoke and fire. To prevent this, configure an external safety
circuit, such as a fuse.

Configure a circuit so that the programmable controller is turned on first and then the external power supply.
If the external power supply is turned on first, an accident may occur due to an incorrect output or
malfunction.

Configure a circuit so that the external power supply is turned off before the programmable controller is
turned off.

If the programmable controller is turned off first, an accident may occur due to an incorrect output or
malfunction.

For the operating status of each station after a network communication failure, refer to relevant manuals for
the network. Incorrect output or malfunction due to a communication failure may result in an accident.

When changing data of the running programmable controller from a peripheral connected to the CPU
module, configure an interlock circuit in the program to ensure that the entire system will always operate
safely.

For other controls for the running programmable controller (program modification and operating status
change (status control)), read relevant manuals carefully, and ensure the safety before operation.
Especially, in the case of a control from an external device to a remote programmable controller, immediate
action cannot be taken for a problem on the programmable controller due to a communication failure.
Configure an interlock circuit in the program, and determine corrective actions to be taken between the
external device and CPU module in case of a communication failure.

If an absolute position is recovered by the positioning function, the servo ON signal may be kept off (the
servo may be kept off) for approx. 20 ms, and the motor may operate. If any problem is caused by the motor
operation when the servo ON signal is turned off, provide an electromagnetic brake so that the motor will be
locked during absolute position recovery.




I Design Precautions S

/\ CAUTION

e Do not bundle the control cable or communication cable with the main circuit or power wire, or lay them
adjacently. Separate these by 100 mm or more as a rule.
Failure to observe this could lead to malfunctioning caused by noise.

e When a lamp load or an inductive load, such as a heater and a solenoid valve, is controlled, a large current
(approximately ten times greater than normal) may flow when the output is turned from off to on. Use a
module having a sufficient current rating.

e The time for the CPU module to enter the RUN status after the CPU module is powered off and on or reset
will vary depending on the system configuration, parameter settings, and/or program size, etc. Design the
program so that the entire system will operate safely even if the time to reach the RUN status varies.

E—— Installation Precautions |

/\ WARNING

e Shut off the external power supply for the system in all phases before mounting or removing the module.
Failure to do so may cause electric shock, damage to the module or malfunction.

/\ CAUTION

e Use the programmable controller in an environment that conforms to "GENERAL SPECIFICATIONS" in the
LCPU User's Manual (Hardware Design, Maintenance and Inspection).
Failure to do so may result in electric shock, fire, malfunction, or damage to or deterioration of the product.

e To mount modules, engage their connectors, slide them until the module connecting hook stops, and lock the
hook securely.
Incorrect mounting may cause malfunction, failure or drop of the module.

e Do not directly touch any conductive part or electronic component of any module.
Doing so can cause malfunction or failure of the module.

e When using an extension cable, connect it to the extension connectors of the branch module and extension
module. After connecting, check the connections for looseness.
Poor contact may cause malfunction.

e When using an SD memory card, fully insert it into the SD memory card slot. Check that it is inserted completely.
Poor contact may cause malfunction.

e Do not directly touch any conductive part or electronic component of the module or SD memory card.
Doing so can cause malfunction or failure.

E— Wiring Precautions - —

/\. WARNING

e Shut off the external power supply for the system in all phases before wiring the module.
Failure to do so may result in electric shock or failure or malfunction of the module.

e After mounting or wiring, attach the included terminal cover onto the module before turning the power on or
starting operation.
Failure to do so may result in electric shock.




E—— Wiring Precautions S

/\ CAUTION

e Ground the FG and LG terminals to the dedicated conductors for the programmable controller (Class D
(Class 3) or higher grounding).
Failure to do so may result in electric shock or malfunction.

e Use applicable solderless terminals and tighten them within the specified torque range.
If any spade solderless terminal is used, it may be disconnected when the terminal screw comes loose,
resulting in failure.

e Check the rated voltage and terminal layout before wiring to the module, and connect the cables correctly.
Inputting voltage different from the rated voltage, connecting a power supply with a different voltage rating or
incorrect wiring may cause a fire or failure.

e Connectors for external connection must be crimped or pressed with the tool specified by the manufacturer,
or must be correctly soldered.
Incomplete connections could result in short circuit, fire, or malfunction.

e Fit the connectors surely to the module.

e Do not bundle the control cable or communication cable with the main circuit or power wire, or lay them
adjacently. Separate these by 100 mm or more as a rule.
Failure to observe this could lead to malfunctioning caused by noise.

e The electric wires and cables connected to the module shall be installed in a duct or secured with clamps.
If such measures are not taken, the cables may sway or move or may be pulled unintentionally, and the
module and cables may be damaged, or malfunction may be caused by cable contact failure.

e When connecting any cable, check the type of the interface to be connected.
Connecting to an improper interface or incorrect wiring may damage the module and external devices.

e Tighten the screws on the terminal block within the specified torque range. Undertightening the screws can
cause short circuit, a fire or malfunction.
Overtightening can damage the screws and/or module, thereby causing fall, short circuit, a fire and
malfunction.

e When disconnecting any cable from the module, do not pull the cable. When disconnecting a cable with a
connector, hold the connector of the connecting part of the module. Before disconnecting a cable from the
terminal block, loosen the terminal screw on the terminal block.

Pulling the cable with the terminal connected to the module may cause malfunction or damage to the module
or cable.

e Prevent foreign matter such as dust or wire chips from entering the module.
Such foreign matter can cause a fire, failure, or malfunction.

e A protective film is attached to the top of the module to prevent foreign matter, such as wire chips, from
entering the module during wiring. Do not remove the film during wiring. Remove it for heat dissipation before
system operation.

e When using the high-speed counter function, ground the shielded wire on the encoder side (relay box).
(Class D (Class 3) grounding or higher)
Failure to do so may cause malfunction.

e Mitsubishi programmable controllers must be installed in control panels. Connect the main power supply to
the power supply module in the control panel through a relay terminal block.
Wiring and replacement of a power supply module must be performed by maintenance personnel who is
familiar with protection against electric shock.
For wiring methods, refer to the LCPU User's Manual (Hardware Design, Maintenance and Inspection).
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— Startup and Maintenance Precaution | —

/\ WARNING

e Do not touch any terminal while power is on.
Doing so will cause electric shock or malfunction.

e Correctly connect the battery connector. The battery must not be charged, disassembled, heated, thrown into
the fire, short-circuited, soldered, wetted with a liquid or exposed to strong shock.
Doing so will cause the battery to produce heat, explode, or ignite, resulting in injury and fire.

e Shut off the external power supply for the system in all phases before cleaning the module or retightening the
terminal screws or connector fixing screws.
Failure to do so may result in electric shock.

/\ CAUTION

e Before performing online operations (especially, program modification, forced output, and operation status
change) for the running CPU module from the peripheral connected, read relevant manuals carefully and
ensure the safety.

Improper operation may damage machines or cause accidents.

e Do not disassemble or modify the modules.
Doing so may cause failure, malfunction, injury, or a fire.

e Use any radio communication device such as a cellular phone or PHS (Personal Handy-phone System) more
than 25 cm away in all directions from the programmable controller.
Failure to do so may cause malfunction.

e Shut off the external power supply for the system in all phases before mounting or removing the module.
Failure to do so may cause the module to fail or malfunction.

e Tighten the screws on the terminal block and the connector mounting screws within the specified torque
range.
Undertightening the screws may cause fall of parts and wires, short circuit and malfunction.
Overtightening can damage the screws and/or module, thereby causing fall, short circuiting and malfunction.

e Connection/disconnection of the module (including the display module) and the terminal block after the first
use of the product shall be limited to 50 times. (Compliant with JIS B 3502)
Exceeding the limit of 50 times may cause malfunction.

e Connection/disconnection of the SD memory card after the first use of the product shall be limited to 500
times.
Exceeding the limit of 500 times may cause malfunction.

e Do not drop or apply shock to the battery to be installed in the module.
Doing so may damage the battery, causing the battery fluid to leak inside the battery.
If the battery is dropped or any shock is applied to it, dispose of it without using.

e Before handling the module, touch a grounded metal object to discharge the static electricity from the human
body.
Failure to do so may cause the module to fail or malfunction.

e Before staring the test run of the positioning function, set the speed limit parameter to a low value and make
preparations to promptly stop the system in case of a hazardous situation.

11




E— Disposal Precautions C —

/\ CAUTION

e When disposing of this product, treat it as industrial waste.
When disposing of batteries, separate them from other wastes according to the local regulations.
(For details of the battery directive in EU member states, refer to "Handling of Batteries and Devices with

Built-in Batteries in EU Member States" in the LCPU User's Manual (Hardware Design, Maintenance and
Inspection).

I Transportation Precautions | —

/\ CAUTION

e When transporting lithium batteries, follow the transportation regulations.

(For details of the regulated models, refer to "Precautions for Battery Transportation" in the LCPU User's
Manual (Hardware Design, Maintenance and Inspection).)
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B Conditions of Use for the Product -

(1) Mitsubishi programmable controller ("the PRODUCT") shall be used in conditions;
i) Where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major or serious
accident; and
i) Where the backup and fail-safe function are systematically or automatically provided outside of the
PRODUCT for the case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general industries.
MITSUBISHI SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT LIMITED TO ANY
AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT
LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR DAMAGE TO PROPERTY CAUSED
BY the PRODUCT THAT ARE OPERATED OR USED IN APPLICATION NOT INTENDED OR EXCLUDED BY
INSTRUCTIONS, PRECAUTIONS, OR WARNING CONTAINED IN MITSUBISHI'S USER, INSTRUCTION
AND/OR SAFETY MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT.

("Prohibited Application")
Prohibited Applications include, but not limited to, the use of the PRODUCT in;

* Nuclear Power Plants and any other power plants operated by Power companies, and/or any other cases in
which the public could be affected if any problem or fault occurs in the PRODUCT.

+ Railway companies or Public service purposes, and/or any other cases in which establishment of a special
quality assurance system is required by the Purchaser or End User.

« Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as Elevator and
Escalator, Incineration and Fuel devices, Vehicles, Manned transportation, Equipment for Recreation and
Amusement, and Safety devices, handling of Nuclear or Hazardous Materials or Chemicals, Mining and
Drilling, and/or other applications where there is a significant risk of injury to the public or property.

Notwithstanding the above, restrictions Mitsubishi may in its sole discretion, authorize use of the PRODUCT in
one or more of the Prohibited Applications, provided that the usage of the PRODUCT is limited only for the
specific applications agreed to by Mitsubishi and provided further that no special quality assurance or fail-safe,
redundant or other safety features which exceed the general specifications of the PRODUCTSs are required. For
details, please contact the Mitsubishi representative in your region.
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B Revisions a

Print Date | Publication Number* ‘ Revision
Jul., 2008 L(NA)0O8121E-A First edition

Jan., 2011 L(NA)08121E-B

CONDITIONS OF USE FOR THE PRODUCT, Replacement options
and module selection guide, Chapter 4, Section 7.3, Section 8.2,
Chapter 11, Chapter 12, Chapter 14, Chapter 15, Chapter 17,
Appendix 1, Appendix 2

| Partial correction |

Safety Precautions, Chapters were reorganized and contents were
revised(whole)

Sep., 2012 L(NA)08121E-C Addition
Section 1.2, Section 2.4, Section 4.3, Section 4.4, Chapter 5 (5),
Section 6.3

Change
Chapter 1 —> Section 1.1, Chapter 4 (Title changed),
Chapter 6 (Title changed), Section 6.3 —> Section 6.4

\ Partial correction \

Safety Precautions, Introduction, Replacement options and module
selection guide

Chapter 3, Section 5.1, Section 5.2, Section 6.1, Section 10.1,
Chapter 14, Appendix 2.2, Appendix 2.6

Sep., 2013 L(NA) 08121E-D Addition
Section 2.2.2, Section 2.3.4, Section 4.6, Section 5.3

Change
Table of contents

Dec., 2014 L(NA) 08121E-E Addition

Section 1.3, Section 2.3, Section 3.2.2, Section 6.2, Section 7.5,
Section 7.6, Section 8.2, Section 8.3, Section 10.2,

Change
Table of contents, Section 2.1, Section 2.2.2, Section 2.3.2,
Section 4.6, Section 9.1, Section 10.1

* The publication number is given on the bottom left of the back cover.

This publication confers no industrial property rights or any rights of any other kind, nor does it confer any
patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving
industrial property rights which may occur as a result of using the contents noted in this publication.

© 2008 MITSUBISHI ELECTRIC CORPORATION
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Introduction

This publication describes case examples of transition from the large type MELSEC-A/QnA
Series, small type AnS/QnAS Series, A0J2(H) Series, and MELSECNET/MINI-S3 systems to
the MELSEC-Q or MELSEC-L Series.

Refer to these examples when considering system configurations and selecting modules during
a system upgrade.

This publication is intended to provide system configuration examples as a supplement to the
replacement handbooks.

For specifications comparisons between A (Large Type and Small Type) and Q/L Series or
precautions for replacement, refer to the following replacement handbooks.

* Transition from MELSEC-A/QnA (Large Type) Series to Q Series Handbook (Fundamentals) 08043ENG
¢ Transition from MELSEC-AnS/QnAS (Small Type) Series to Q Series Handbook (Fundamentals) 08219ENG
* Transition from MELSEC-AnS/QnAS (Small Type) Series to L Series Handbook (Fundamentals) 08258ENG
* Transition from MELSEC-A/QnA (Large Type) Series to Q Series Handbook (Intelligent Function Modules) 08046ENG
¢ Transition from MELSEC-AnS/QnAS (Small Type) Series to Q Series Handbook (Intelligent Function Modules) 08220ENG
* Transition from MELSEC-AnS/QnAS (Small Type) Series to L Series Handbook (Intelligent Function Modules) 08259ENG
* Transition from MELSEC-A/QnA (Large Type), AnS/QnAS (Small Type) Series to Q Series Handbook (Network Modules) 08048ENG
* Transition from MELSEC-AnS/QnAS (Small Type) Series to L Series Handbook (Network Modules) 08260ENG
* Transition from MELSEC-A/QnA (Large Type), AnS/QnAS (Small Type) Series to Q Series Handbook (Communications)  08050ENG
¢ Transition from MELSEC-AnS/QnAS (Small Type) Series to L Series Handbook (Communications) 08261ENG
* Transition from MELSEC-AQ0J2H Series to Q Series Handbook 08060ENG
¢ Transition from MELSECNET/MINI-S3, A2C (I/0) to CC-Link Handbook 08061ENG
* Transition from MELSEC-I/OLINK to CC-Link/LT Handbook 08062ENG
¢ Transition from MELSEC-I/OLINK to AnyWire DB A20 Handbook 08263ENG
e Transition of CPUs in MELSEC Redundant System Handbook (Transition from Q4ARCPU to QnPRHCPU) 08117ENG

+ Before using the products shown in the transition handbooks, catalogues, and transition examples, refer to
the relevant manuals and check the specifications, precautions, and restrictions.
For information on the products manufactured by Mitsubishi Electric Engineering Co., Ltd., Mitsubishi
Electric System & Service Co., Ltd., and other companies, refer to the relevant catalogues and check the
specifications, precautions, and restrictions.
The manuals and catalogues for our products, products manufactured by Mitsubishi Electric Engineering
Co., Ltd., and Mitsubishi Electric System & Service Co., Ltd. are shown in Appendix of each transition
handbook.

+ For details on product compliance with the above standards, please contact your local Mitsubishi Electric
sales office or representative.

+ Products shown in this handbook are subject to change without notice.
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Replacement Options and
Module Selection Guide

Specific modules are selected according to the transition procedure (gradually or simultaneously), module

configuration, and network configuration when replacing A/QnA (Large Type), AnS/QnAs (Small Type) Series
modules with Q/L Series modules.
The following shows module replacement options and references.

Module replacement

Options

To utilize existing
wiring

Use A0J2 renewal tool
manufactured by SC*'

-

References

Example: Section 2.4

To replace with
Q Series 1/0 modules

Select Q Series I/0

» Replace A0J2(H) systems with Q Series
using existing wiring

Transition from MELSEC-A0J2H Series

modules

RRe]

To replace special
function modules with
Q Series modules

Select Q Series modules

>

To add modules
to existing A (Large
Type) Series system

—>

Modify/Replace modules
using A-A1S module
conversion adapter (A1ADP)

» to Q Series Handbook
(L-08060ENG)

Example: Section 6.1

To only replace the CPU
module and continue using
existing A (Large Type)
Series modules

—>

Replace modules using QA
extension base unit and
QA conversion adapter

P Use AnS (Small Type) modules as spare
parts for existing A (Large Type) Series

Example: Section 3.1.1
p Utilize A/QnA (Large Type) Series QA6OB

To replace A (Large Type)
Series 32-point terminal

Replace modules using
Q Series large type base unit

extension base unit

Example: Section 3.1.2

Utilize existing 1/0 modules and extension
base unit with Q Series CPU

(Use QA conversion adapter)

Example: Section 2.1.2

P Upgrade to Q Series using Q Series large

<

block type modules and 1/0 modules type base unit and 1/0 modules
without changing the
viring configuration Replace modules using upgrade Example: Section 2.1.3
v » Upgrade to Q Series using Q Series large
2
ool manufactured by MEE type base unit and 1/0 modules
Example: Section 2.1.2 (2)
Compatibility of Q Series large type
base unit with the upgrade tool
To replace modules Replace modules using Example: Section 2.1.1
» when it is difficult to terminal block converter P Install terminal block converter module
use the Q Series module and terminal module and terminal module externally
large type base unit
Replace modules using FA
goods manufactured by MEE*?
Transition from MELSEC-A/QnA
o | To replace all modules . (Large Type) Series to Q Series
| with Q Series modules P Select Q Series modules » Handbook (Fundamentals)
(L-08043ENG)
. .
*1: SC: Mitsubishi Electric System & Service Co., Ltd.
*2: MEE: Mitsubishi Electric Engineering Co., Ltd.
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Options

To only replace the CPU
module and continue
using the existing AnS
(Small Type) module

To replace only the modules
in the main base unit and
continue using the existing
AnS (Small Type) modules
in the extension base unit

Replace modules using
QA1S extension base

-

References

Example: Section 3.2.1

—>

Replace modules
using Q-Ans base unit
conversion adapter

\/

Utilize AnS/QnAS (Small Type) Series
QA1S60B extension base unit

Example: Item 3.2.2
Replace main base unit with Q Series

To mount Q Series base
unit using existing AnS
(Small Type) base unit
mounting holes

Replace modules using
AnS (Small Type) Series
upgrade tool manufactured
by MEE*

and use existing extension base unit and
modules in it
(Use QA1S conversion adapter)

\ 4

Example: Section 2.2.2

g

To replace existing AnS
(Small Type) 16-point
terminal block module
without changing the
wiring configuration

>

To replace modules when

itis difficultto usethe Q

Series large type base unit

Replace modules using FA
goods manufactured by
MEE*

P Utilize AnS/QnAS (Small Type) module
replacement upgrade tool

Example: Section 2.2.3
p» Replace AnS/QnAS (Small Type) Series

To replace all modules
with Q Series modules

To install L Series DIN rail
using existing AnS (Small
Type) base unit mounting
holes

—>| Select Q Series modules

200 V AC input module A1SX20
[Use FA goods (manufactured by
Mitsubishi Electric Engineering Co., Ltd.)]

»_Transition from MELSEC-AnS/QnAS

Use base adapter
integrated with DIN
rail

" (Small Type) Series to Q Series Handbook
(Fundamentals) (L(NA)08219ENG)

Example: Item 2.3.1

To replace existing AnS (Small
Type) 16-point terminal block
type modules without changing
the wiring configuration

Replace modules using
AnS (Small Type) Series
upgrade tool manufac-
tured by MEE*

P

To obtain information on
tools other than the
upgrade tool

—>

Replace modules using
FA goods manufactured
by MEE*

» Replace using upgrade tool for replacing
with L Series

Example: Item 2.3.2
Replace AnS/QnAS (Small Type) Series
200 V AC input module A1SX20

To replace all modules
with L Series modules

Select L Series
modules

[Use FA goods (manufactured by
Mitsubishi Electric Engineering Co.,
Ltd.)]

Transition from MELSEC-AnS/QnAS

A

P (Small Type) Series to L Series
Handbook (Fundamentals)
(L(NA)08258ENG)

*: MEE: Mitsubishi Electric Engineering Co., Ltd.
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Network replacement

Options

-

References

Example: Section 4.5.1

» Replace A2CCPU with Q Series CPU
and CC-Link

Example: Section 4.5.2

» Replace MELSECNET/MINI(-S3) with
CC-Link

Transition from MELSECNET/MINI-S3,

» A2C(1/O) to CC-Link Handbook
(L-08061ENG)

Example: Section 2.4.3

> To replace networks using Replace network using A2C
existing external wiring shape 1/0 modules

> To replace A2CCPU Replace network using

wiring conversion adapter

To replace networks

> }’vaf‘:fe‘;fs'ﬁndéﬁ\jﬁﬁ'; o> [ Select CC-Link modules
configuration
To replace Use A0J2 | ool

B compact type remote  [— S¢ renewal 100
/O modules manufactured by SC

> gfogipt';s: g‘:ﬂﬂ'tgg »| Replace with MELSECNETH
/O modules remote /O network

» Replace MELSECNET/MINI compact type
remote 1/0 modules with CC-Link

Example: Section 4.5.3

To replace networks

P without changing
existing addresses

—>

Replace with CC-Link/LT

» Replace MELSECNET/MINI(-S3) remote
1/0 station with MELSECNET/H using the
existing external wiring

Example: Section 4.6

To replace networks

using existing
communication cables

Replace with AnyWire
DB A20

P Replace MELSEC-I/OLINK with CC-Link/LT,
AnyWire DB A20

Example: Section 4.6

.

» Replace MELSEC-I/OLINK with CC-Link/LT,
AnyWire DB A20

*: SC: Mitsubishi Electric System & Service Co., Ltd.
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Network replacement

Options

To replace CPU modules

P while retaining the existing
MELSECNET(II)

—>

Replace modules using
MELSECNET(II) local station
data link modules

-

References

Example: Section 4.2

To replace with

» MELSECNET/10 using
existing cables

Upgrade gradually to
Q Series CPU modules

P Replace one of A Series stations with
Q Series while retaining MELSECNET(II)

Example: Section 4.1.1
Replace MELSECNET(II) coaxial loop

Transition to MELSECNET/H
using MELSECNET/B twisted
pair cables

with MELSECNET/10 coaxial bus system
while retaining existing A Series CPUs

Example: Section 4.1.2

To replace networks

P containing a remote
I/0 station

Replace networks using
MELSECNET/H PLC to PLC
network and remote 1/0 network

» Upgrade to MELSECNET/H network
system utilizing existing MELSECNET/B
twisted pair cable

Transition from MELSEC-A/QnA

v ¥ v

Change from remote /O station
to normal station and replace
as one single network

P (Large Type) Series to Q Series
Handbook (Network Modules)
(L-08048ENG)

Example: Chapter 4.3

To gradually replace
p| networks using existing

MELSECNET(II) and
MELSECNET/10

Use a gateway set to
configure networks with
relay stations

P Replace MELSECNET containing a remote
I/O station with MELSECNET/H

Transition from MELSEC-A/QnA

P (Large Type) Series to Q Series
Handbook (Network Modules)
(L-08048ENG)

This section describes the main replacement options. If multiple options are selected or other options
are needed, comprehensive consideration is required to configure the system.
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Part I : Hardware
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1.1 Comparison of A/QnA (Large Type) Series and Q Series base unit mounting area

1. Comparison of base mounting area

1.1 Comparison of A/QnA (Large Type) Series and Q Series base unit mounting area

When upgrading existing A/QnA systems, there are cases where the number of modules increases due to
specification differences. For instance, to replace an A/QnA (Large Type) Series 32-point terminal block type /O
module, two Q Series 16-point terminal block type I/O modules are used. Despite increase in the number of 1/0
slots and extension base stages, the Q Series footprint is smaller than that of the A/QnA (Large Type) Series.
The following example shows a comparison of the mounting areas when the A/QnA (Large Type) Series system
is upgraded to the Q Series.

Solution and Benefit

When replacing each 32-point terminal block type module with two 16-point terminal block type
modules, an additional extension base unit is required due to an increase in the number of modules.
However, the Q Series system fits inside the existing control panel because it is compact in size.

(1) When the A/QnA (Large Type) Series main base unit A35B and the A65B extension base unit are

replaced
= Q38B/Q68B
80 A35B
[ |e
250 D
— Replace
50
80 A65B
250 20

n

Downsized %
50 =

352 Unit: mm

Q38B/Q68B

A35B

Base unit size comparsion

 Tip

The A/QnA (Large Type) Series main base unit and extension base unit differ in size:
+ A35B main base unit: 382 mm (W) x 250 mm (H)
« A65B extension base unit: 352 mm (W) x 250 mm (H)

Whereas the Q Series main base unit and extension base unit are the same size:
+ Q38B main base unit/Q68B extension base unit: 328 mm (W) x 98 mm (H)

Even with the extra 1/0O slots and base units, the base unit installation area for Q Series is smaller than that for

A/QnA (Large Type) Series.
e
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1.1 Comparison of A/QnA (Large Type) Series and Q Series base unit mounting area

(2) When the A/QnA (Large Type) Series main base unit A38B and the A68B extension base unit are
replaced

480

Q312B/Q612B

80

A38B

250

50

80

250

50

20

Downsized =

 —
=]

Tip

The A/QnA (Large Type) Series main base unit and extension base unit differ in size:
+ A38B main base unit: 480 mm (W) x 250 mm (H)

+ AB8B extension base unit: 466 mm (W) x 250 mm (H)

Unit: mm

Q312B/Q612B

A38B

Base unit size comparsion

Whereas the Q Series main base unit and extension base unit are the same size:
+ Q312B main base unit/Q612B extension base unit: 439 mm (W) x 98 mm (H)

Even with the extra I/0O slots and base units, the base unit installation area for Q Series is smaller than that for
A/QnA (Large Type) Series.
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1.2 Comparison of AnS/QnAS (Small Type) Series and Q Series base unit mounting area

130

30

30

130

30

1.2 Comparison of AnS/QnAS (Small Type) Series and Q Series base unit mounting area

The Q Series is compact, and has a smaller mounting area.

It can be mounted within the AnS/QnAS (Small Type) mounting area.

The following example shows a comparison of the mounting areas when the AnS/QnAS (Small Type) Series
system is upgraded to the Q Series.

Solution and Benefit

Using the “AnS to Q Series conversion adapter” (manufactured by Mitsubishi Electric Engineering
Co., Ltd.), the 16-point terminal block type module can fit into the existing space without changing
the wiring.

(1) When the AnS/QnAS (Small Type) Series main base unit A1S35B and the A1S65B extension base
unit are replaced

325 328

Q38B/Q68B

30 A1S35B

98

40

20 245 L5
315 Unit: mm
/ Q35B/Q65B /%%%% / Q38B/Q68B /%%112285
G222
A1S358B | A1538B |

Base unit size comparsion
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1.2 Comparison of AnS/QnAS (Small Type) Series and Q Series base unit mounting area

Existing base unit

Replacement base unit

Outline dimensions Outline dimensions FEMats
A1S35B 325(W)x130(H) Q35B 245(W)x98(H) Width is 80 mm narrower
Q38B 328(W)x98(H) Width is 3 mm wider
A1S38B 430(W)x130(H) Q38B 328(W)x98(H) Width is 102 mm narrower
Q312B 439(W)x98(H) Width is 9 mm wider
A1S65B | 315(W)x130(H) Q65B 245(W)x98(H) Width is 70 mm narrower
Q68B 328(W)x98(H) Width is 13 mm wider
A1S68B 420(W)x130(H) Q68B 328(W)x98(H) Width is 92 mm narrower
Q612B 439(W)x98(H) Width is 19 mm wider

The AnS /QnA (Small Type) Series main base unit and extension base unit differ in size:
* A1S35B main base unit: 325 mm (W) x 130 mm (H)
+ A1S65B extension base unit: 315 mm (W) x 130 mm (H)

Whereas the Q Series main base unit and extension base unit are the same size:
+ Q38B main base unit/Q68B extension base unit: 328 mm (W) x 98 mm (H)

The width will increase if the number of modules increases, i.e., A1S35B to Q68B will increase 3 mm, and
A1S38B to Q312B will increase by 9 mm.
However, this increase can be handled. Confirm the in-panel layout and space and determine whether the

extra modules can be mounted.
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1.3 Comparison of AnS/QnAS (Small Type) Series and L Series mounting area

1.3 Comparison of AnS/QnAS (Small Type) Series and L Series mounting area

The L Series modules are designed to be installed directly on the DIN rails. The modules can be
mounted freely according to the in-panel space.

When replacing AnS/QnAS (Small Type) Series modules with L Series, examine the mounting method
in consideration of the in-panel space.

Solution and Benefit

(1) Using the "AnS to L Series conversion adapter" (manufactured by Mitsubishi Electric
Engineering Co., Ltd.), the module to be mounted has a wiring connector incompatible with
the terminal block of the terminal block type module can fit into the existing space without
changing the wiring.

(2) The number of modules to be newly mounted can be reduced by using various built-in

functions of the CPU.

(1) When the AnS/QnAS (Small Type) Series main base unit A1S35B and the A1S65B extension base
unit are replaced

325 299

30 A1S35B

130

30

30

130

229

30

Unit: mm
315
HISH H General-purpose input function  Interrupt input function  Pulse catch function
M Built-in functions of CPU purpose P e

/

pEE ¢«
General-purpose output function Positioning function\
! L. 1

High-speed counter function\

CC-Link function™

n

' .If. I

_:-=§J -
mm ¥

*1: The CC-Link function can
be used on L26CPU-BT and
L26CPU-PBT.

Although the external dimensions of AnS/QnAS (Small Type) Series are determined by the base unit to be
used, the width of L Series varies depending on the number of selected modules.
For the method for calculating the required width, refer to "Transition from MELSEC-AnS/QnAS (Small Type)

Series to L Series Handbook."
T
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2.1 Replace A/QnA (Large Type) Series with Q Series

2. Utilizing external wiring

2.1 Replace A/QnA (Large Type) Series with Q Series
2.1.1 Install terminal block converter module and terminal module externally
(1) Replace 32-point terminal block type module using connector/terminal block converter module

Solution and Benefit

+ The connector/terminal block converter module can support up to 2mmz2 wires, allowing the use
of existing thick wires without modification.

+ Using a connector/terminal block converter module, an existing 32-point terminal block type

module can be replaced with a 32-point connector type module without increasing the number of

modules.

The following is an example of replacing an A/QnA (Large Type) Series system that contains 32-point terminal
block type input modules (AX41).

@ Instructions
Replace AX41 with QX41, and connect the connector/terminal block converter module.
If QX40 is used instead of QX41, two modules are required to replace each AX41. Also, if existing wires are
thicker than the applicable wire size (0.75 mm?2), wiring modifications may be necessary.

(a) System configuration example

| Current configuration | | After replacement
W=382 mm ‘ ‘ W=328 mm
L4 & o § i - |5 |z | = | o
> o = < < < < S oo _|o_
- N | 5|8|8|8|8|8 528/52|£2|| H=98mm
- % M M M M N H=250 mm 8 g—|o—| o~
g 8|23 |38 3| M IRNIRRIRIn]
QaeB L L
A35B X00... X20.. X40.. X60.. X80..
W=352 mm Replace
° W=328 mm
z z Z Z 2 g o (o o o o o o o =2
&% & | % & |g)|| H2s0mm DU g 585 fefesesese B Hesmm
A65B YCO... YEO... Y100... Y120... Y140... Q68B

*1: Connector/terminal block converter module (A6TBXY36)

(b) Module selection example

Product name Existing model Replacemant model
Power supply module AB1P 2 | Q61P 2
CPU module A2NCPU 1 | Q01UCPU 1
Main base unit A35B 1 | Q38B 1
Extension base unit A65B 1 | Q68B 1
Extension cable ACO06B 1 | QCo6B 1
Input module AX41 4 | QX41 4
Connector/terminal block converter module N/A - | A6TBXY36 4
Connector/terminal block converter module cable| N/A - | ACOTB 4
Input module AX42 1 | QX42 1
Output module AY13 5 | QY10 10
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2.1 Replace A/QnA (Large Type) Series with Q Series

Connector/terminal block converter module

AB6TBXY36 (for 32 points)

Specifications

Width
(All models have the same height and depth)
A6TBXY36 120 mm
A6TBXY54 155 mm
A6TBX70 190 mm

Outline /'}Npi‘r’gcsai?ée‘ Applicable crimping terminal
ABTBXY36 For positive common input modules and sink output modules (standard type) 0.4 kg
1.25-3.5 (JIS)
ABTBXY54 For positive common input modules and sink output modules (2-wire type) 0.5 kg
1.25-YS3A (J.S.T.)
ABTBX70 For positive common input modules (3-wire type) 0.6 kg V1.25:M3 (J.S.T)
ABTBX36-E For negative common input modules (standard type) 0.4 kg 07510 | V1.25-YS3A(J.S.T)
2
ABTBX54-E For negative common input modules (2-wire type) 0.5 kg 2mm® | 235 (JIS)
ABTBX70-E For negative common input modules (3-wire type) 0.6 kg 2YSIAST)
V2-S3 (J.S.T.)
ABTBY36-E For source output modules (standard type) 0.4 kg
V2-YS3A (J.S.T))
ABTBY54-E For source output modules (2-wire type) 0.5 kg
Cables
Model | Outline ‘ Weight Applicable model
ACO05TB 0.5 m, for sink type modules 0.17 kg A6TBXY36
AC10TB 1 m, for sink type modules 0.23 kg ABTBXY54
ABTBX70
AC20TB 2 m, for sink type modules 0.37 kg
AC30TB 3 m, for sink type modules 0.51 kg
AC50TB 5 m, for sink type modules 0.76 kg
AC80TB 8 m, for sink type modules (common current: 0.5 A or lower) 1.2kg
AC100TB 10 m, for sink type modules (common current: 0.5 A or lower) 1.5 kg
ACO5TB-E 0.5 m, for source type modules 0.17 kg ABTBX36-E
AC10TB-E 1 m, for source type modules 0.23 kg ABTBY36-E
ABTBX54-E
AC20TB-E 2 m, for source type modules 0.37 kg
ABTBY54-E
AC30TB-E 3 m, for source type modules 0.51 kg AGTBX70-E
AC50TB-E 5 m, for source type modules 0.76 kg
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2.1 Replace A/QnA (Large Type) Series with Q Series

(2) Replace 32-point contact output type module using "relay terminal module"

Solution and Benefit

+ Using the relay terminal modules, a large type A (Large Type) Series 32-point contact output
module can be replaced while maintaining 8 points/common.
« A wide variety of compatible wire sizes are available using the relay terminal module.
A (Large Type) Series 32-point contact output module AY13: Max. 2 mm?
Relay terminal module: Max. 1.25 mm?
Q Series 16-point contact output module QY10: Max. 0.75 mm?
+ Replacement is possible without the need of additional modules because a module mounted on
the base unit becomes compatible with 32-point connector type modules through the use of the
"connector/terminal block converter module".

The following is an example of replacing contact output modules (AY13) with transistor output modules (QY41P)
and externally converting transistor outputs into contact outputs.

@ Instructions
Replace AY13 with QY41P and connect the relay terminal modules to convert to contact outputs.
With this method, the system can be upgraded without increasing the number of modules on the base unit.
Also, 8 points/common, the same specification as that of the AY13, can be maintained.

(a) System configuration example

| Current configuration | | After replacement |
° O e
>
e 9|3 3|3 |3|¢
21522 33|32
A35B X00... X20.. X40... X60... X80.. Replace

A61P
AY13
AY13
AY13
AY13
AY13

8 points/common
(the same specification
as that of AY13)

Dedicated cable
ACOTE

Reray terminal module| [Reray terminal module

16-point relay terminal module x 2
(ABTE2-16SRN)
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2.1 Replace A/QnA (Large Type) Series with Q Series

(b) Module selection example

Product name

| Existing model ‘

Replacement model

Power supply module A61P 2 | Q61P 2
CPU module A2NCPU 1 | Q01UCPU 1
Main base unit A35B 1 | Q38B* 1
Extension base unit A65B 1 | Q68B 1
Extension cable ACO06B 1 | QCo6B 1
Input module AX41 4 | QX41-S2 4
Connector/terminal block converter module N/A - | A6TBXY36 4
Cable (for connector/terminal block converter module) | N/A - | ACOTB 4
Input module AX42 Qx42 1
Output module AY13 5 | QY41P 5
Relay terminal module N/A - | ABTE2-16SRN 10
Cable (for relay terminal module) N/A - | ACO6TE 5

* The Q312 can be used if the control panel is wide enough. With the Q312, the I/0O modules can be mounted on one base unit,
eliminating the need for the Q68B extension base unit, QC06B extension cable, and one Q61P power supply module.

(c) Relay terminal module (A6TE2-16SRN)

(d) External dimensions

]
Y

i

£

[TTT]

Unit: mm
—

I IEIED n [T r~
Q0 0! 0! 01 O ofF of O of OF oL OF OF OF Of Of w

TT
[ [T

3 || NG ||| |n
|t W [u W |u

0 |n
® |2

EE

R

B

]

52.6

Note: The relay terminal module can function as a relay
terminal block while performing contact outputs.

(e) Cables

The connection cables compatible with AGTE2-16SRN are shown below.

B-side: Second half
16 pts. (Y10 to Y1F)

L

Model Length (L)
ACO6TE 0.6m
AC10TE im
AC30TE 3m
AC50TE 5m
AC100TE 10m

L

32

A-side: First half
16 pts. (YO to YF)



2.1 Replace A/QnA (Large Type) Series with Q Series

(f) Specifications comparison between AY13 and A6TE2-16SRN O): Compatible, /A Partially changed

Compati-

ABTE2-16SRN - Remarks
bility
Use two A6TE2-16SRN modules
. . . A
Number of output points 32 points 16 points when using more than 16 points.
The isolati thod differs, but th
Isolation method Photocoupler Relay AN . © |sfo ation metho .I ers . utthe
isolation performance is equivalent.
Rated switching 24V DC/2 A (resistive Ioad)/ppint, 24V DC/2 A (resistive Ioad)/ppint,
240 V AC/2 A (cos @ =1)/point, | 240V AC/2 A (cos @ =1)/point, O
voltage/current
5 A/lcommon 8 A/lcommon
Minimum switching load 5V DC1mA 5V DC1mA O
Maximum switching 264 V AC 264V AC O
voltage 125V DC 125V DC
Response ON to OFF 10 ms or less 10 ms or less O
time OFF to ON 12 ms or less 12 ms or less O
Mechanical 20 million times or more 20 million times or more O
Rated switching voltage/current | Rated switching voltage/current A
load: 200,000 times or more load: 100,000 times or more The electrical life of
Life 200VAC15A,240VAC1A 200VAC15A,240VAC1A the A6TE2-16SRN is half of
Electrical (cos ® =0.7): 200,000 times or more | (cos ® =0.7): 100,000 times or more the AY13's life. However, the relay
200V ACO.7A, 24OYAC 05A 200V ACO.7A, 24OYAC 05A A for the A6TE2-16SRN can be
(cos @ =0.35): 200,000 times or more | (cos @ =0.35): 100,000 times or more replaced
24VDC1A,100VDCO.1 A 24VDC1A,100VDCO.1 A '
(L/R=7 ms): 200,000 times or more (L/R=7 ms): 100,000 times or more
LA 0 17 3600 times/hour 3600 times/hour O
frequency
c terminal 8 points/common 8 points/common
ommon termina (common terminals: (common terminals: O
arrangement TB9, TB18, TB27, TB36) TB19, TB21)
Operation indicator ON indication (LED) ON indication (LED)
Voltage 24V DC £10% 24V DC £10%
External Ripple voltage: 4 Vp-p or less | Ripple voltage: 4 Vp-p or less The supplied current value will be
power larger.
supply Current 290 mA _ 350 mA _ A
(TYP. 24 V DC, all points ON) | (TYP. 24 V DC, all points ON)
. 38-point terminal block 38-point screw terminal block
E | VAN
xternal connections connector (M3 x 6 screws) (M3 screw) (M3 x 6 screws)
Applicable wire size 0.75 to 2 mm? 0.75 to 1.25 mm? a N S )
Wiring modification is required.
R1.25-3, R1.25-MS83,
Applicable crimping R1.25-3, R2-3, R1.25-B3A, R1.25-C3A, O
terminal RAV1.25-3, RAV2-3 RAV1.25-3, RAV1.25-MS3,
RAV1.25-B3A
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2.1 Replace A/QnA (Large Type) Series with Q Series

(3) Replace A/QnA (Large Type) Series 200 V AC input module AX21
[Use FA goods (manufactured by Mitsubishi Electric Engineering Co., Ltd.)]

Solution and Benefit

+ Use the Q Series large type input module QX21L to replace the modules without changing the
wiring.
Note that if the Q Series large type base unit cannot be used because of space limitations in the
panel or because of the module configuration, etc., replacements can be completed easily by
using the FA goods.

- A dedicated cable is available to connect the programmable controller with the FA goods, so

there's no need to prepare cables when making a replacement.

FA goods

A variety of FA goods, including a terminal block connector conversion module, 1/0 type converter (AC input ->
DC input conversion, DC output signal -> relay output conversion, etc.), are available. Use these convenient
products as relays, signal conversions and a means to reduce wiring when compatible modules are not available
for replacing from the A/QnA (Large Type) Series to the Q Series.

The following is an example of replacing the A (Large Type) I/O module with the Q Series using FA goods.
@ Instruction

(1) Using the FA goods, convert the 200 V AC input into 24 V DC, and lead it in with QX41, etc.
(2) The external wiring will change, but program does not need to be changed since the I/O address is the same.
(3) The following FA goods are used.

Product name | Model | External connection | Remarks

(1) 200 V AC input module insulated with
photo coupler
(2) Input module on programmable controller side
16-point/common QX41, QX42, QH42 and QX41Y41P
2-wire type (3) CC-Link module
AJB5SBTCF1-32D
(4) Connection cable
FA-CBLOOOFM2V and FA-CBLOOOFM2LV

FA-TH16X200A31L
200 V AC photo

coupler insulated )
input module

@ System configuration example

| Current configuration | | New configuration after replacement |
® — | 1 i | g
: : : : 5 Qx41 | Qxat
Ao %1 : Ag o o | o Q61p|Q01U o | 10 | 10
ABTP | cpy | ‘module imodule :module Heplace CRU module moctie moduie
32points  32points 1 l
T X000~ 1 X020~ ! ! ! Q358
A35B (200 V AC 32-point input for AX21)
U FaTriexeoonsiL | FA-TH16X200A31L |
FA-TH16X200A31L | FA-TH16X200A31L |
t
@ Application (CC-Link input module) | 200 VAC input|
AJB5SBTCF1-32D
e E— FA-TH16X200A31L -
- 200 V AC input |
l '—( FA-TH16X200A31L
CC-Link FA-CBLO6FM2LV

other stations



2.1 Replace A/QnA (Large Type) Series with Q Series

® Connection cable

Shape | Model | Cable length
FA-CBLOBFM2LV 0.6m
FA-CBL10FM2LV 1.0m
A : FA-CBL20FM2LV 2.0m
fe W ' FA-CBL30FM2LV 3.0m
FA-CBL50FM2LV 5.0m
FA-CBL100FM2LV 10.0m

® Module external dimensions
175

2-¢8
10, 155 S/
2-04.5 4_.‘26-9
Yo}
~ 0 00 ol 62 63 o4 05 06 o7 o8 09 oA 0B oC oD o Eo T
~1 L5 i
[
= Riiitiiiil
0 T C T ) T >« i > Annmne Y
0 1) v 3
% 1T C 1T D 1T D C 1T D ;’ "
1T C 1T D 1T D C 1T D n LO'
I 7 8
(lesleslsslededeleslslededeslaslesledesdes) o\ 2, | !
® AKXV %1, L
© = \ 0 K o
o 762 | | Lg \ _ B 53.4 ©
S DIN rail Unit: mm

® Module selection example

Product name \ Existing model \ Replacement model
Power supply module AB1P 1 | Q61P 1
CPU module A2NCPU 1 | Q01UCPU 1
Main base unit A35B 1 | Q35B 1
Input module AX21 2 | QX41 or QX42 21
FA goods : Input module N/A — | FA-TH16X200A31L 4
Connection cable N/A - Eﬁggt%%g{iﬂ/ﬂv 2

Tip

» The FA goods input module has a function to convert 200 V AC input signal into 24 V DC, so select a 24 V
DC input connector type module for the programmable controller side input module.

+ The following products are available for the FA goods.
P Triac large capacity (1 A/point) output module
P Transistor large capacity (2 A/point) output module
» Common multi-point 1/0 module
The FA goods can be used when replacement using the Q Series large type 1/0 module conversion adapter
is difficult.
For details on the FA goods manufactured by Mitsubishi Electric Engineering Co., Ltd., please contact your
local Mitsubishi sales office or representative.

- To replace using existing external wiring terminal block, use the Q Series large type input module QX21L.
Refer to "2.2 Upgrade to Q Series using Q Series large type base unit and 1/0 modules" for details.
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2.1 Replace A/QnA (Large Type) Series with Q Series

2.1.2 Replace using Q Series large type base unit and Q Series large input/output module
(1) List of Q Series large type base units and Q Series large input/output modules

Solution and Benefit

+ The Q Series large type I/0O modules allow the use of existing A/QnA (Large Type) Series 32-point
I/0 wiring, eliminating the need for rewiring.

- Performance specifications of the Q Series large type /0O modules are equivalent to those of the
A/QnA (Large Type) Series.

+ The hole size and pitch of the Q Series large type base units are the same as those of the A/QnA
(Large Type) Series, eliminating the need of making new mounting holes.

+ The Q Series large type I/0 modules and standard Q Series modules can be mounted together on
the Q Series large type base unit. For the standard Q Series modules, existing A/QnA (Large
Type) Series connectors or terminal blocks can be utilized without modification by using a

conversion adapter (upgrade tool) manufactured by Mitsubishi Electric Engineering Co., Ltd.

Wired terminal blocks of the existing A (Large Type) Series 1/0 modules can be mounted directly without
modifying the external wiring.

Q Series large type
base unit Q Series large type
1/0 module

Mount directly

< R

i

~— Remove the wired
terminal block
from the existing
1/0 module

Tl el of b od ol ol 8 b 1 aF et

T ————

AT

Upgrade tool (Conversion adapter)
manufactured by Mitsubishi Electric
Engineering Co., Ltd.

Mount directly
Mount a standard Q Series 2
power supply module and

CPU module Q Series large type

1/0 module ~—— Remove the wired

terminal block
from the existing
1/0 module

Q Series module

Q Series large type blank cover (QG69L)
(To mount a standard Q Series module
on a large type base unit)

® Q Series large type base unit options

Product name | Model \ Outline

Q38BL | 8slots, 1 power supply module required, Q Series large type 1/0 module mountable

Q35BL | 5slots, 1 power supply module required, Q Series large type 1/0 module mountable

) Q68BL | 8slots, 1 power supply module required, Q Series large type 1/0 module mountable

Erfltte nsion base Q65BL | 5 slots, 1 power supply module required, Q Series large type 1/0O module mountable
Q55BL | 5 slots, power supply module not required, Q Series large type 1/0 module mountable

Main base unit
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2.1 Replace A/QnA (Large Type) Series with Q Series

@ Q Series large type /0 module options

Outline

Model
Product name Existing A (Large Type)| Q Series
Series module module

32 points, 100 to 120 V AC, rated input current:10 mA (100 V AC, 60 Hz),
AX11 Qx11L | response time: 15 ms or less (OFF to ON), 25 ms or less (ON to OFF),
32 points/common, 38-point terminal block
Input module
32 points, 200 to 240 V AC, rated input current: 10 mA (220 V AC 60 Hz),
AX21 QX21L | response time: 15 ms or less (OFF to ON), 25 ms or less (ON to OFF),
32 points/common, 38-point terminal block
AY10A 16-point contact output, 24 V DC/240 V AC, 2 A/point, 16 A/all points,
QY11AL | All points independent common, 38-point terminal block,
AY11A Surge suppressor (Varistor 387 to 473 V)
AY13 Qy1aL 32-point contact output, 24 V DC/240 V AC, 2 A/point, 5 A/common,
Output module 8 points/common, 38-point terminal block
AY23 QyzaL 32-point triac output, 100 to 240 V AC, 0.6 A/point, 2.4 A/common,
8 points/common, 38-point terminal block
AY41(P) 32-point transistor output 12 to 24 V DC, 0.5 A/point, 4 A/common,
AY51 QvysipPL| 16-point'common protection function (overheat protection function,
AY51-S1 overload protection function), 38-point terminal block
Large type N/A QGe9L Blank cover for mounting existing Q Series module on the Q Series large
blank cover type base unit

® Conversion adapter (upgrade tool) options
[manufactured by Mitsubishi Electric Engineering Co., Ltd.]

Product name

External connections

Input module

AX10 Qx10 ERNT-AQTX10
AX40, AX40-UL Qxa0, x70

Qx40-51 ERNT-AQTX40
AX70, AX70-UL QX70
AX50, AX50-S1 QX50
AX80, AX80-UL QX80 ERNT-AQTX80

(Q Series)

Terminal block
(18 points)

AX41, AX41-UL

QX41, QX41-S2, QX71

AX31-S1 QX41, QX41-S2 FCN connector
: ERNT-AQTX41
AX41-S1 QX41-S1 Q (40P plug)
AX71 QX71
AX81, AX81-S1 QX81, QX81-S2 ERNT-AQTX81 D-Sub connector (37P)
AY10
AY11, AY11-UL
. ERNT-AQTY10
AY11E QY10 Q
AY11EEU .
AY22 Qy22 ERNT-AQTY22 (Tfsr r;'(')';?tlsk;mk
Outout module AY40, AY40P,AY40-UL | QY40P :
P AY70, AY70-UL QY70 ERNT-AQTY40
AY50, AY50-UL QY50 ERNT-AQTY50
AY80 QY80 ERNT-AQTY80
AY41, AY41P, AY41-UL| QY41P ERNT-AQTY41 FCN connector
AY71 QY71 (40P plug)
AY81, AYB1EP QY81P ERNT-AQTY81 D-Sub connector (37P)
AB8AD*
Analog input . Q68ADV ERNT-AQT68AD
module AB8AD-S2 QBBADI
A68ADN* ERNT-AQT68ADN Terminal block
Analog output A62DA, A62DA-S1 Q62DAN ERNT-AQT62DA (18 points)
A68DAV Q68DAVN
ERNT-AQT68DA
module A68DAI, A6BDAI-S1 | Q68DAIN Q
High-speed counter | AD61 QD62-HO1 ERNT-AQTD61 FCN connector
module AD61-S1 QD62-H02 (40P)

* Voltage input or current input is applicable to replacement Q Series modules.
If the existing A (Large Type) Series module uses a combination of voltage and current input, it cannot be replaced using a Q Series
large type base unit and a conversion adapter.
Consider using a conversion adapter (2-slot type) to replace the module with a Q64AD-GH (2 units required). (Refer to Section 2.4 for details)
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2.1 Replace A/QnA (Large Type) Series with Q Series

Tip

Existing A (Large Type) Series wiring harness plugs in without modification.

The Q Series large type base modules are compatible with High Performance Model QCPUs, Universal
model QCPU (except QO0UJCPU), and Remote /O Stations.

Basic Model QCPUs, Process CPUs, Redundant CPUs, and Safety CPU are not compatible.

Neither Q Series large type main base unit nor Q Series large type extension base unit can be used in a
multiple CPU system.

The standard Q Series modules can be mounted on the Q Series large type base unit using the Q Series
large type blank cover.

The Q Series large type base units can be used together with the standard Q Series base units.

(e.g., main base unit: Q312B, extension base unit: Q68BL)

Some modules, such as modules that occupy two slots, cannot be mounted. Refer to "Q Series Large Type
Base Unit/I/O Module/Blank Cover User's Manual" for details.

After replacing the existing connector with the wiring intact, the 64-point connector type 1/0 module can be
used for the Q Series I1/0 module.

A blank cover is required to mount the Q Series large type base unit.

Note that the connector layout changes from top/bottom to left/right, so the position of the lower connector
moves to the upper side.

Check that the existing wiring is long enough.

The 8-slot no power supply required type is not available for the Q Series extension base unit.

When replacing the existing extension base unit to the 8-slot no power supply required type A58B, replace
with the power mounted type Q68BL.

In this case, the mounting width dimensions will increase by 55 mm (411 mm to 466 mm).

Confirm the mounting space, and that the wiring is long enough to move to the mounting position.

2-slot type conversion adapters of the upgrade tool manufactured by Mitsubishi Electric Engineering Co., Ltd.
cannot be used.

For details on the upgrade tool manufactured by Mitsubishi Electric Engineering Co., Ltd., please contact
your local Mitsubishi sales office or representative.
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(2) Upgrade to Q Series modules using Q Series large type base unit

Solution and Benefit

+ Unlike the QA60B extension base unit, which is used to directly mount existing A (Large Type)
Series I/0 modules for a gradual upgrade, the Q Series large type base unit, I/O module, and
conversion adapter (upgrade tool) (manufactured by Mitsubishi Electric Engineering Co., Ltd.)
enables all modules to be upgraded to the Q Series at once and allows use of existing A Series
wiring.

+ Having the same slot width as A (Large Type) Series base units, the Q Series large type base
units permit direct mount of existing 32-point I/0 wiring on the Q Series I/O modules. This can
shorten the upgrade time.

+ Performance specifications of the Q Series large type /O modules are equivalent to those of the

A (Large Type) Series, eliminating concerns about compatibility with the connected external

devices.

The following is an example of upgrading an A (Large Type) Series system to the Q Series using the Q Series
large type base units, I/O modules, and conversion adapters.

@ Instructions
(1) Replace the existing 32-point terminal block type I/O modules with Q Series large base units and 1/0
modules, and use the same terminal blocks to connect with external wiring.
(2) If there is no compatible Q Series large type 1/0 module, use the conversion adapter (manufactured by
Mitsubishi Electric Engineering Co., Ltd.) to replace the existing module with standard Q Series 1/0 module.

® System configuration example

| Current configuration | New configuration after replacement
28
L e o &5 4 _| _| a a
o2 = = = = =
> o S X X X x x
a z - - - - - G L& | © ¢ o o o
€ | g |2 2|2 |2 | % - g | 2| 8] B8] |8
< o o o o o
© © © © ©
— £ £ £ £ £
£ £ £ £ £
e 2 2 2 2 2
D D D (=2} (=2
| £ £ £ £ £
Q35BL i i i i i
A35B
Replace
ACOBB QcoeB
@ QX4
T | % ® ® ?
5] 5] e e s
: 3§ ¢.¢g 8 |28 |83
< é < < < < — & g
] | S E E B
— € € € € €
| 2 k] 8 E] k]
Q65BL 5 5 5 3 3
A65B

* Conversion adapters (upgrade tool)
manufactured by Mitsubishi Electric
Engineering Co., Ltd. are used.
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® Module selection example

Product name

Existing model

Replacemant model

Main base unit A35B 1 Q35BL 1
Extension base unit A65B 1 Q65BL 1
Power supply module A61P 2 | Q61P 2
Extension cable ACO06B 1 QCo6B 1
CPU module A2NCPU 1 QO01UCPU 1
AX11 5 | QX11L 5
Input module QXx41 1
AX41 1 ERNT-A_QTX41 1

(conversion adapter)
AY13 2 | QY13L 2
AY23 1 QY23L 1
Output module QY41P 1
AY41 1 ERNT-AQTY41 1

(conversion adapter)
Q Series large type blank cover N/A - | QGe9L 2

 Tip

* The Q Series power supply and CPU modules can be mounted without a Q Series large type blank cover.
+ Always mount a Q Series large blank cover when mixing the Q Series modules. The Q Series I/O module is
used when using the Mitsubishi Electric Engineering Co., Ltd. upgrade tool, so the Q Series large blank cover

will be required.

+ When the Q Series large type base unit is used, the depth is greater than that of the A Series.

A Series 32-point

1/0 module

=

=]
L
| ] | (] | I

e
| 25

<>

- 140 >

>

129 25

Q Series large type 1/0 module

154

* The depth of ERNT-AQT68DA is 176.2 mm.

40

Q Series /0 module

4 l Conversion adapter
I~ (upgrade tool)
manufactured by
Mitsubishi Electric
Engineering Co., Ltd.
/]
165.3*

Unit: mm
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(3) Upgrade to MELSECNET/H (remote I/O network) system using Q Series large type base unit

Solution and Benefit
+ With the Q Series large type base units and I/O modules, an existing MELSECNET remote I/O network
system can be upgraded to a MELSECNET/H (remote /O network) system by utilizing existing wiring.

Just remount the existing wired terminal block on the Q Series large type base units, /O modules.
The upgrade time can be greatly reduced.

+ In addition to the Q Series large type base units, I/O modules, the conversion adapter (upgrade
tool) (manufactured by MITSUBISHI Electric Engineering Co., Ltd.) can also be used to further
minimize upgrade process.

* For the model names of conversion adapters used as upgrade tools, refer to "Conversion adapter (upgrade tool) options
[manufactured by Mitsubishi Electric Engineering Co., Ltd.]" in page 37.

The following is an example of upgrading a MELSECNET network system consisting of only remote 1/O stations
to a MELSECNET/H (remote I/O network) system using the Q Series large type base units, I/O modules, and
conversion adapters.

@ Instructions
Use Q Series large type base units, I/O modules, and conversion adapters (manufactured by Mitsubishi
Electric Engineering Co., Ltd.) to replace the existing MELSECNET remote 1/0 network system.

(a) System configuration example

QG69L
| Current configuration | | New configuration after replacement | Q Series large type
. ) blank cover
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Q35BL

* Q Series large type blank cover (QG69L) is required when using a Q Series module.
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2.1 Replace A/QnA (Large Type) Series with Q Series

® Module selection example
(1) Master station to remote master station

Product name | Existing model \ Replacemant model

Main base unit A35B 1 | Q35BL 1
Power supply module AB1P 1 Q61P 1
CPU module A2ACPUP21 1 Qo02UCPU 1
Network module N/A - | QJ71LP21-25 1
Q Series large type blank cover N/A - | QGe9L 1
Input module AX11 2 | QX11L 2
Output module AY13 ! QYisL !

AY23 1 QY23L 1

(2) Remote 1/0O station 1

Product name | Existing model \ Replacemant model

Main base unit A35B 1 Q35BL 1
Power supply module A61P 1 Q61P 1
Network module AJ72P25 1 QJ72LP25-25 1
Input module AX11 1 QX11L 1
AY13 1 QY13L 1
tput I

Output module AY23 1 | QveaL 1
Input module AX41 1 QX1 , !
ERNT-AQTX41 (conversion adapter)| 1
QY41P 1

Output module AY41 1
P ERNT-AQTY41 (conversion adapter)| 1
Q Series large type blank cover N/A - | QGe9IL 2

(3) Remote /O station 2
Product name | Existing model \ Replacemant model

Main base unit A35B 1 Q35BL 1
Power supply module A61P 1 Q61P 1
Network module AJ72P25 1 QJ72LP25-25 1
AX11 1 QX11L 1
Input module QX40 1
AX40 1 ERNT-AQTX40 (conversion adapter)| 1
AY13 1 QY13L 1
AY10 1 Qv1o ; !
Output module ERNT-AQTY10 (conversion adapter)| 1
QY40P 1

AY40 1
ERNT-AQTY40 (conversion adapter)| 1
Q Series large type blank cover N/A - | QGe9L 3

» When utilizing existing optical fiber cables, note that the minimum distance between stations may be limited
to 200m depending on the type of cables used. Refer to "Q Corresponding MELSECNET/H Network System
Reference (remote /O network)" for details.

If the distance between stations is less than 200m, the existing optical fiber cables can be utilized without
restrictions.

* When replacing the existing ACPU to a CPU with link function, an empty slot is required to mount the network
module.

If no empty slot is available, the extension base unit must be added or the base unit must be changed to one
with more slots.

A |
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2.1 Replace A/QnA (Large Type) Series with Q Series

2.1.3 Replacement utilizing A (Large Type) upgrade tool
(manufactured by Mitsubishi Electric Engineering Co., Ltd.)

(1) Utilize A (Large Type) unit replacement upgrade tool

Solution and Benefit
+ When replacing the existing A (Large Type) Series modules, there may be cases in which two
replacement modules are needed depending on the specification of the Q Series modules.
In such cases, the terminal blocks of the A (Large Type) Series modules do not need to be replaced
and can be used through the upgrade tool (base adapter and conversion adapter (2-slot type))
manufactured by Mitsubishi Electric Engineering Co., Ltd. Thus, wiring time is greatly reduced.
+ The base adapter (upgrade tool) manufactured by Mitsubishi Electric Engineering Co., Ltd. is
compatible with the 12-slot main/extension base unit, enabling the expansion of slot numbers if
needed.

Upgrade tool manufactured by Mitsubishi Electric Enginee

The upgrade tool manufactured by Mitsubishi Electric Engineering Co., Ltd. consists of: base adapter,
conversion adapter, and conversion adapter fixing mount.
For details on the upgrade tool manufactured by Mitsubishi Electric Engineering Co., Ltd., refer to Section
"2.1.2 Upgrade to Q Series using Q Series large type base unit and I/O modules".
- Base adapter
An adapter to mount a Q Series base unit using installation holes of the existing A (Large Type) Series large
type base unit.
+ Conversion adapter
An adapter to mount an existing A (Large Type) Series module terminal block on the replacement Q Series 1/0
modules, analog modules, or high speed counter modules. (The existing terminal blocks and wires are utilized.)
There are two types of conversion adapters: 1-slot type and 2-slot type.
+ Conversion adapter fixing mount
A mount to fix the conversion adapters.

Q Series main base unit / extension base unit

Base adapter

Q Series 1/0 module

T T T T

st

TTTTITITT

Conversion adapter fixing mount

Conversion adapter (2-slot type)

L . "‘1

ﬁ‘\ Terminal block removed from the existing A (Large Type) Series /O module

Conversion adapter (1-slot type)
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2.1 Replace A/QnA (Large Type) Series with Q Series

(a) Conversion adapter
1) 1-slot type (Mountable to Q Series large type base unit)
Separate adapter are available for the 1/0 module, analog module and high-speed counter module.

The 1-slot type conversion adapter can also be mounted on the Q Series large base unit.
Refer to Section "2.1.2 Upgrade to Q Series using Q Series large type base unit and I/O modules".
2) 2-slot type (Not mountable to Q Series large type base unit)
(a) For 1/0 module

Conversion adapter (2-slot type)

MELSEC-A Series

MELSEC-Q Series

Input/Output MELSEC-A Series MELSEC-Q Series
module model module model
Input AX1™ QX10 x 2 modules ERNT-AQTX11
AX11EU"
AY10A*2, AY10A-UL
AY11A*2 QY18A x 2 modules | ERNT-AQTY10A
AY11AEU*?
AY13*®
AY13E*® QY10 x 2 modules ERNT-AQTY13
Output AY13EU*®
AY23* QY22 x 2 modules ERNT-AQTY23
iig;l _;1'2(51 UL QY50 x 2 modules
ERNT-AQTY51
AYB1™® QY80 x 2 modules
AY81EP*¢

Terminal block
(38-points)

Terminal block
(18-points)
X 2 modules

*1: Replaceable with Q Series large type input module QX11L.
*2: Replaceable with Q Series large type output module QY11AL.

*3: Replaceable with Q Series large type output module QY 13L.
*4: Replaceable with Q Series large type output module QY23L.

*5: Replaceable with Q Series large type output module QY51PL.
*6: Replaceable with one slot when Q Series output module QY81P is selected and conversion adapter ERNT-AQTY81 is used.
(Q Series large type base unit mountable)

(b) For analog module

Input/Output

MELSEC-A Series
module model

MELSEC-Q Series
module model

Conversion adapter (2-slot type)

AB8AD
(Voltage/Current mixed input)

AB8AD-S2
(Voltage/Current mixed input)

AG8ADN

Q64AD-GH x 2 modules*

ERNT-AQT68AD-GH

Input

(Voltage/Current mixed input)

f‘f;lgp‘gg input) QB8ADV x 2 modules

AG1BAD ERNT-AQT616AD

(Current input) Q68ADI x 2 modules

A616DAV Q68DAVN x 2 modules

ERNT-AQT616DA

Output I 616DAI QB8DAIN x 2 modules Q

MELSEC-A Series

Terminal block
(38-points)

MELSEC-Q Series

Terminal block
(18-points)
X 2 modules

* Replacement when using mixed voltage/current input for existing A (Large Type) Series module.
The 1-slot type conversion adapter can be used when using voltage input only or current input only.
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2.1 Replace A/QnA (Large Type) Series with Q Series

(b) Base adapter

An adapter is used to mount a Q Series base unit using installation holes of the existing A (Large Type) Series
large type base unit.

MELSEC-A Series MELSEC-Q Series Mountable conversion adapter fixing mount
module model module model | Base adaptermodel |"op ) or 1o T ERNT-AQFS | ERNT-AQFS5 | ERNT-AQF3
A38B, A38HB Q312B, Q312DB ERNT-AQB38 O O
A38B-UL Q38B, Q38DB ERNT-AQB38 O
Q6128 ERNT-AQB68 O O
AB8B, A68B-UL Q68B ERNT-AQB68 O
A58B, A58B-UL Q68B ERNT-AQBS58 O
Q38B, Q38DB ERNT-AQB35 O O
A35B, A35B-UL Q358 ERNT-AQB35 O
Q68B ERNT-AQB65 O O
ABSB, AB5B-UL Q65B, Q558 ERNT-AQB65 O
A558, A55B-UL Q65B, Q55B ERNT-AQB55 O
A32B, A32B-UL Q33B ERNT-AQB32 O
A62B Q63B, Q528 ERNT-AQB62 O
A52B Q52B ERNT-AQB52 @)

(c) Conversion adapter fixing mount
A mount to fix the conversion adapters.

Conversion adapter fixing mount model \ Description REINEIES
ERNT-AQF12 12-slot conversion adapter fixing mount

ERNT-AQF8 8-slot conversion adapter fixing mount A conversion adapter fixing mount is
ERNT-AQF5 5-slot conversion adapter fixing mount | required to mount conversion adapters.
ERNT-AQF3 3-slot conversion adapter fixing mount

 Tip N —

« Tips for using the upgrade tool manufactured by Mitsubishi Electric Engineering Co., Ltd.
(a) The programmable controller side modules are Q Series modules.
The specifications and functions may be different from those of the A (Large Type) Series modules.
Refer to the specification comparison in the corresponding module's transition handbook to confirm
compliance with the specifications and functions of the external device.
(b) Q Series main/extension base unit can be used with Q Series large type base unit. Select a base unit
according to the module configuration after replacement.
(Example of base unit combination)
» Main base unit: Q312B (Q Series standard type)
(Upgrade tool manufactured by Mitsubishi Electric Engineering Co., Ltd. is used.)
« Extension base unit: Q68BL (Q Series large type base unit)
Note that only the following CPU types can be used with Q Series large type base unit.
» High Performance Model QCPU
» Universal Model QCPU (except for Q0O0JCPU)
» MELSECNET/H remote I/O station
(There are no restrictions on the CPU type if only the upgrade tool manufactured by Mitsubishi
Electric Engineering Co., Ltd. is used.)
+ The 1-slot type conversion adapter may be difficult to mount depending on the existing wire size. In such
cases, consider using a Q Series large base unit.
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2.1 Replace A/QnA (Large Type) Series with Q Series

(2) Compatibility of Q Series large type base unit with the upgrade tool

The following table shows the compatibility of Q Series large type base unit with the upgrade tool manufactured by
Mitsubishi Electric Engineering Co., Ltd. when replacing existing A (Large Type) Series modules with Q Series modules.

Base adapter, Conversion adapter

Item | Q Series large type base unit*! ‘ (Upgrade tool)2
Slot width of base unit* SamS% \r’:giﬂt; :ssetnﬁ if\((3L7a.ggﬁ] Ly)pe) Same width(azg (3 r?:;:i)es base unit
Power supply module | Q Series standard power supply module O O
Basic model QCPU X O
High Performance model QCPU O O
CPU module
Mountable Process CPU X 9)
module Universal model QCPU O O
« VO module Q Series large type /0 modules*® O X
+ Intelligent function Q Series 1-slot module o” O
module Q Series 2-slot occupying module X @)
For terminal block type 16-point I/O module (1-slot type) o7 O
For terminal block type 32-point I/O module (1-slot type) o7 VAN
Conversion | For terminal block type 32-point I/O module (2-slot type) X A
adapter*® For high-speed counter module o7 N
For analog module (1-slot type) o7 VAN
For analog module (2-slot type) X N
Connection of QA/QA1S extension base unit*® O O

O: Applicable (Mountable), 2: Applicable with restrictions (Mountable), X: Not Applicable (Not mountable)

*1:
*2:
Engineering Co., Ltd.

Check mounting conditions before using the upgrade
tool, because wiring space is reduced due to

a decrease in the module's width.

*3:

*4:
*5:

QOO0UJCPU is not compatible.

are same as that of A (Large Type) Series I/O module.
*6:

Number of common points and electrical specifications,etc.,

Since the adapters are mounted on Q Series modules, the

MELSEC-A Series module

| a7s

specifications and functions are same as those of the Q
Series modules. (Please check the transition handbook,
since the specifications and functions are different from those of A (Large Type) Series module)

*7:
*8:
*9:

The Q Series large type blank cover (QG69L) is required.
Only High Performance Model QCPUs can be connected to the QA/QA1S extension base unit.
If the size of the copper wire connected to the terminal block is

larger than 1.25 mm?2, ERNT-AQTX41, AQTY41, AQTX81, D

AQTY81, AQT68AD, AQT68ADN, AQT68DA, and AQTD61

modules may be difficult to mount.
In this case, secure wiring space by leaving empty slots in

modules. For example, mount modules on slot No. 0, 2, 4,

and leave slot No. 1, 3, 5, 7 empty.
Mount a blank cover QG60 on the empty slots.
If there are not enough slots, consider using the Q Seri
type base unit.
*10:

wiring terminal block with the conversion adapter.

(Example) AY51 -> QY50 x 2 modules,
A616AD -> Q68ADV(l) x 2 modules
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Applies when using replacing the existing A (Large Type)
module with the two Q Series modules, and using the existing
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Q Series large type base units can be used with Q Series base units (standard products).
Mount a Q Series base unit (standard product) on the base adapter manufactured by Mitsubishi Electric

MELSEC-Q Series module
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QY50
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adapter

Existing AY51 terminal block



2.2 Replace AnS/QnAS (Small Type) Series with Q Series

2.2 Replace AnS/QnAS (Small Type) Series with Q Series
2.2.1 Replace using AnS size Q Series large type base unit

Solution and Benefit
- The mounting dimensions of the AnS size Q Series large base unit are the same as the A/QnA
(Small Type) Series, so there is no need to additionally drill mounting holes.
- Both the Q Series with upgrade tool (manufactured by Mitsubishi Electric Engineering Co., Ltd.)
and a module without upgrade tool can be mounted on the AnS size Q Series large base unit. The
terminal block used with the A/QnA (Small Type) Series can be used on the Q Series module with
upgrade tool (manufactured by Mitsubishi Electric Engineering Co., Ltd.) without changing the
wire size.

AnS size Q Series large base unit

Q Series module —»|

AnS size Q Series Q Series module

AnS size Q Series large ——> *1
large blank cover

blank cover (QG69LS)

Upgrade tool —> *1: One required for each module mounted

on the AnS size large base unit.

@ List of AnS size Q Series large base units

Product name \ Existing AnS/QnAS module \ Panel mounting type \ DIN rail mounting type*?
. . A1S35B Q35BLS Q35BLS-D
Main base unit
A1S38B Q38BLS Q38BLS-D
A1S65B Q65BLS Q65BLS-D
Extension base unit A1S68B Q68BLS Q68BLS-D
A1S55B Q55BLS Q55BLS-D
AnS size Q Series large N/A QGEILS
blank cover

*2: The DIN rail mounting adaptor compatible with the base unit is enclosed.
*3: One required for each module mounted on the AnS size large base unit.
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2.2 Replace AnS/QnAS (Small Type) Series with Q Series

2.2.2 Replace using A (Small Type) upgrade tool
(manufactured by Mitsubishi Electric Engineering Co., Ltd.)
(1) Utilize AnS/QnAS (Small Type) module replacement upgrade tool

Solution and Benefit
* The MELSEC-ANS Series/MELSEC-Q Series upgrade tool conversion adapter (manufactured by
Mitsubishi Electric Engineering Co., Ltd.) reduces wiring time as the AnS/QnAS (Small Type)
Series 16-point terminal block type module’s terminal block can be used without modification.

+ New mounting holes do not need to be drilled as the MELSEC-AnS Series/MELSEC-Q Series
upgrade tool base adapter (manufactured by Mitsubishi Electric Engineering Co., Ltd.) can be
mounted with the existing main/extension base unit mounting holes.

MELSEC-AnS Series/MELSEC-Q Series upgrade too

(manufactured by Mitsubishi Electric Engineering Co.,

The MELSEC-ANS Series/MELSEC-Q Series upgrade tool (manufactured by Mitsubishi Electric Engineering
Co., Ltd.) is comprised of the base adapter and conversion adapter. This tool can be used with just the base
adapter or conversion adapter.
- Base adapter
This adapter is used to mount the Q Series base unit using the mounting holes for the existing AnS/QnAS
(Small Type) base unit.
- Conversion adapter
This adapter is used to mount the existing AnS/QnAS (Small Type) module’s terminal block onto the Q
Series I/O module or analog module after replacement.
(The terminal block and wiring are used in the original state.)

Existing AnS Series Q Series
' =
2T 2 -
— ] . . Upgrade tool
== d (Base adapter)

Upgrade tool
(Conversion adapter)

Use existing wiring <~— FA goods
for I/0 module /

T Iﬁ

al ® we|
T E G
T

When replacing the AnS Series /0 module with the #

Q Series 1/0 module, the FA goods conversion module AC DC
and interface terminal module can also be used. AC lamp  DC lamp
H24VvDC
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2.2 Replace AnS/QnAS (Small Type) Series with Q Series

(a) List of conversion adapters

@ 1-slot type

Module type

MELSEC-AnS/QnAS Series
module model

MELSEC-Q Series
module model

Conversion adapter model*'*2

A1SX10, A1SX10EU Qx10 ERNT-ASQTXY10
A1SX40 QX40, QX70
-y A1SX40-52 Qx40 ERNT-ASQTX40
A1SX40-51 QX40-51
A1SX80, A1SX80-51, QX80 ERNT-ASQTX80
A1SX80-52
A1SY10, AISY10EU Qv1o ERNT-ASQTXY10
A1SY22 Qvez ERNT-ASQTY22
Output A1SY40, A1SY40P QY40P ERNT-ASQTY40
A1SY50 QY50 ERNT-ASQTY50
A1SY80 QYso ERNT-ASQTY80
A1S64AD Q64AD ERNT-ASQT64AD
- Q68ADV
Analog input -
ginp A1SBEAD v ERNT-ASQT68AD
Q68AD-G ERNT-ASQT68AD-G®
A1S62DA Q62DAN ERNT-ASQT62DA
Anal
nalog output A1S68DAV Q68DAVN ERNT-ASQTE8DA
A1S68DAI Q68DAIN
Analog inputioutput A1S63ADA Q64AD2DA ERNT-ASQT63ADA
. Q68TD-G-HO1 ERNT-ASQT68TD-HO1?
A1S68TD
Thermocouple input S68 Q68TD-G-HO2 ERNT-ASQT68TD-H02°
Temperature -measuring | A1S62RD3(N) 3
resistor input A1S62RD4(N) Q64RD ERNT-ASQTE2RD
QD62
A1SD61 QD62-HO1 ERNT-ASQTD61°?
High-speed counter QD62-H02
module
A1SD62 QD62 ERNT-ASQTD62°
A1SD62E QD62E
A1S62D QD62D ERNT-ASQTD62D
ATSE4TCTT-S1 Q64TCTTN ERNT-ASQTB4TCTT
A1S64TCTRT*
A1S64TCRT-S1 QB4TCRTN ERNT-ASQT64TCRT
Temperature control A1SB4TCTRT®
dul -
mocte ATS62TCTT-S2 QB4TCTTN ERNT-ASQT62TCTT
A1S64TCTRT®
A1S62TCRT-S2 QB4TCRTN ERNT-ASQT62TCRT
A1S64TCTRT?

*1: The module mounting slot position differs, so the wiring length must be adjusted.

*2: If the I/O modules are mounted adjacently using the conversion adapter, mounting may not be possible if the existing wires are thick or
there are many wires. If the wires interfere, lift the wires up toward the front so they are out of the way. If the wires still interfere, leave
one slot open to ensure space for the wires.

*3: Module with fixing frame. The base adapter ASQB3[IN, ASQB6LIN, or ASQB5CIN must be used.

*4: For standard control by thermocouple input.

*5: For standard control by platinum temperature measuring resistor input.

*6: For heating/cooling control by thermocouple input.

*7: For heating/cooling control by platinum temperature measuring resistor input.

Refer to the "Upgrade Tool General Catalog" issued by Mitsubishi Electric Engineering Co., Ltd. for details.
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2.2 Replace AnS/QnAS (Small Type) Series with Q Series

@ 2-slot type (inapplicable to AnS size Q Series large type base units)

MELSEC-AnS/QnAS Series MELSEC-Q Series q
Module type B oy o Conversion adapter model
A1SX20 "
Input QX28 x 2 modules ERNT-ASQTX20
A1SX20EU
A1SY60 ERNT-ASQTY60 "
Output QYB8A x 2 modules 4
A1SY60E ERNT-ASQTY60E
A1S64TCTTBW-S1 w
= QB64TCTTN ERNT-ASQT64TCTTBW
A1S64TCTRTBW
A1S64TCRTBW-S1 .
7 Q64TCRTN ERNT-ASQT64TCRTBW
Temperature control module | A1S64TCTRTBW
with wire breakage detection | A1S62TCTTBW-S2 .
= QB4TCTTN ERNT-ASQT62TCTTBW *
A1S64TCTRTBW
A1S62TCRTBW-S2 .
QB64TCRTN ERNT-ASQT62TCRTBW

A1S64TCTRTBW ©

*1: The XY address will change because two replacement modules are used. The program must be revised.
Consider using FA goods if not changing the XY address.
*2: Model name of set of 1-slot type conversion adapter ERNT-ASQT64TCO and wire breakage detection connector conversion cable.
*3: For standard control by thermocouple input.
*4: For standard control by platinum temperature measuring resistor input.
*5: For heating/cooling control by thermocouple input.
*6: For heating/cooling control by platinum temperature measuring resistor input.
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2.2 Replace AnS/QnAS (Small Type) Series with Q Series

(b) Base adapter

Module t MELSEC-AnS/QnAS Series MELSEC-Q Series o
odule type module model module model 280 ER T e
A1S33B Q33B ERNT-ASQB33N
Q33B+QA1S51B ERNT-ASQB33-S1*2
. . Q35B ERNT-ASQB35N
Main b t
ain base un! A1S358 Q35B+QA1S51B ERNT-ASQB35-517
Q38B ERNT-ASQB38N
A1S38B *
Q38B+QA1S51B ERNT-ASQB38-S1*4
Ex.tension base unit A1S65B Q65B ERNT-ASQB65N
(with power supply) A1S68B Q68B ERNT-ASQB68N
Extension base unit
(without power supply) A1S55B Q55B ERNT-ASQB55N
. A1SJCPU
pPU/basg unit A1SJCPU-S3 gggiﬁzgu ERNT-ASQBOOJN
integrated type A1SJHCPU

*1: The conversion adapter with fixing frame cannot be used with the base adapter that does not have "N" after the conventional model.
*2: The width is 36 mm larger, so mounting space must be secured. (No need to additionally drill mounting holes)

*3: The width is 22 mm larger, so mounting space must be secured. (No need to additionally drill mounting holes)

*4: Mountable within existing space (No need to additionally drill mounting holes)

Tip —

+ External wiring work is eliminated by directly mounting the existing AnS/QnAS (Small Type) I/0O module

terminal block.

When using the conversion adapter, the terminal block cover (enclosed with conversion adapter) must be

replaced.

When replacing the AnS/QnAS Series 1/0 module with connector type external connection method (wiring),

the existing wiring can be used. (The connector, with wires attached, can be connected to the Q Series

module.) Note that after replacement, the Q Series does not have a D-sub 37-pin connector type 1/0

module, so the wiring must be changed to a 40-pin connector.

Note that units with and without the conversion adapter can be used together on the same base unit.

If replacement is difficult from the existing AnS/QnAS (Small Type) I/0O module, the module can be replaced

with the FA goods interface terminal module.

(Example: When A1SX20 is replaced, two QX28 modules will be required. This increases the number of

modules and changes the address. By selecting QX40 and providing the FA goods terminal module

"FA-TH16X200A31L" externally, the number of modules does not need to be increased, and the address will

not change.)

When replacing a system containing an A Series large type extension base unit connected to the

AnS/QnASCPU to the Q Series, the "Q Series large type base unit, Mitsubishi Electric Engineering Co., Ltd.

Upgrade Tool" can be used to replace the A Series large type extension base unit and mounted modules.

Refer to the following section for tips on selecting the "Q Series large base unit, Mitsubishi Electric

Engineering Co., Ltd. Upgrade Tool" in this case.

» Transition from MELSEC-A/QnA (Large Type) Series to Q Series Handbook (Fundamentals) L(NA)08043

»MELSEC-A/QnA (Large), AnS/QnAS (Small) Transition Examples L08121 (-B and higher)

Note that the CPU/base unit integrated CPU type cannot be used with the Q Series large extension base

unit.

+ For details on the upgrade tool manufactured by Mitsubishi Electric Engineering Co., Ltd., please contact
your local Mitsubishi sales office or representative.
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2.2 Replace AnS/QnAS (Small Type) Series with Q Series

(2) Compatibility of AnS size version Q Series large type base unit with the upgrade tool

The following table shows the compatibility of AnS size version Q Series large type base unit with the upgrade
tool manufactured by Mitsubishi Electric Engineering Co., Ltd. when replacing existing A (Small Type) Series
modules with Q Series modules.

AnS size version

Q Series large type base unit*! ‘ Base adapter (Upgrade tool)™

ltem |

Slot width of base unit Sargz r\;veigtgaasse tﬂr?itA( élfég; n‘l;))lpe) Same width(gg i) r?]ﬁ:i)es base unit
Power supply module | Q Series standard power supply module O O
Basic model QCPU X O
High Performance model QCPU O O
Mountable CPU module Process CPU X O
module™s Universal model QCPU o O
Multi-CPU configuration X O
MELSECNET/H remote I/O module O O
+ 1/0 module Q Series 1-slot module™ o* O

« Intelligent function - -
module Q Series 2-slot occupying module X O
For terminal block type 16-point I/O module (1-slot type) O O
Conversion For terminal block type 16-point I/O module (2-slot type) X O®
adapter*® For high-speed counter module o O
For analog module (1-slot type) O O
Connection of QA/QA1S extension base unit*” O O
O: Applicable (Mountable), X: Not Applicable (Not mountable)
*1: AnS size version Q Series large type base units, Q Series base units (standard products) and Q Series

*2:

*3:
*4:

*5:
*6:
*7:

*8:

*9:

large base units can be used together.
Mount a Q Series base unit (standard product) on the base adapter manufactured by Mitsubishi Electric

Engineering Co., Ltd.
MELSEC-ANS Series module MELSEC-Q Series module

Replace with the

terminal block
cover enclosed
with the

conversion

QOO0UJCPU is not compatible. o
The following modules cannot be used.
+ A module whose height is more than 98 mm.
* Amodule with a bracket on top. 34.5 27.4
+ A module with a protrusion, such as a connector, on
the bottom.
+ A module onto which Q7BAT-SET is mounted.
* Example
Q66AD-DG, Q66DA-G, Q68AD-G, Q68RD3-G, Q68TD-G-H02, Q64AD2DA, QD75M1, QD75MH1,
QD75M2, QD75MH2, QD75M4, QD75MH4, or QJ71WS96 with Q7BAT-SET mounted.
Since the adapters are mounted on Q Series modules, the specifications and functions are same as those
of the Q Series modules. (Please check the transition handbook, since the specifications and functions
are different from those of A (Small type) Series module)
The AnS size version Q Series large type blank cover (QG69LS) must be mounted.
Only High Performance Model QCPUs can be connected to the QA/QA1S extension base unit.
This cannot be used with the MELSECNET/H remote /O station, etc.
If the size of the copper wire connected to the terminal block is larger than 1.25 mm?2, it may be difficult to
mount the conversion adapter.
In this case, secure wiring space by leaving empty slots in between modules. For example, mount modules
on slot No. 0, 2, 4, 6, 8, and leave slot No. 1, 3, 5, 7 empty. Mount a blank cover QG60 on the empty slots.
If there are not enough slots, consider using the AnS size version Q Series large type base unit.
Applies when using replacing the existing A (Small Type) module with the two Q Series modules, and using
the existing wiring terminal block with the conversion adapter.
(Example) A1SX20 -> QX28 x 2 modules, A1SYB0(E) -> QY68A x 2 modules
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2.2 Replace AnS/QnAS (Small Type) Series with Q Series

2.2.3 Replace AnS/QnAS (Small Type) Series 200 V AC input module A1SX20 without changing 1/0
address

Solution and Benefit

+ An increase in modules and changes to address can be handled easily by using FA goods.
+ A dedicated cable is available to connect the programmable controller with the FA goods, so
there's no need to prepare cables when making a replacement.

The following is an example of replacing the AnS/QnAS (Small Type) I/0 module with the Q Series using FA
goods.

When replacing the AnS/QnAS (Small Type) 200 V AC input module A1SX20 (16-input points, 16-occupied
points), the Q Series 200 V AC input module is QX28 (8-point input, 16-occupied points), so the number of
modules will increase, and the address will change.

By using the FA goods, the modules can be replaced without increasing the number of modules or changing the
address.

@ Instruction
(1) Using the FA goods, convert the 200 V AC input into 24 V DC, and lead it in with QX40.
(2) The external wiring will change, but program does not need to be changed since the 1/0 address is
the same.
(3) The following FA goods are used.

Product name | Model | External connection | Remarks
FA-TH16X200A31L (1) 200 V AC input module insulated with
200 V AC photo photo coupler

coupler insulated 16-point/common (2) Input module QX40 on programmable

l _ .
input module \ Zwire type controller side

(3) Connection cable FA-CBLOOOTMV20

@ System configuration example

| Current configuration | | New configuration after replacement

e &S|

| | | | Q01UQX40QX40 1/O | I/O | 110
A1S |A2SH| A1S 1 A1S | /O | /O | 1/O (Q61P Py modulemodulemodul
61PN| CPU | X20 | X20 :module;module|module Replace E

I S N qgsB
A18S35B
FA-CBLO6TMV20 FA-CBLO6TMV20
FA-TH16X200A31L | FA-TH16X200A31L

t t
200 V AC input
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2.2 Replace AnS/QnAS (Small Type) Series with Q Series

® Connection cable

Shape

Model

\ Cable length

FA-CBLO6TMV20 0.6m
FA-CBL10TMV20 1.0m
FA-CBL20TMV20 2.0m
FA-CBL30TMV20 3.0m
FA-CBL50TMV20 5.0m
FA-CBL100TMV20 10.0m

® Module selection example

Product name

Existing model

Replacement model

Power supply module A1S61PN 1 Q61P 1
CPU module A2SHCPU 1 QO01UCPU 1
Main base unit A1S35B 1 Q35B 1
Input module A1SX20 2 | QX40 2
FA goods N/A — | FA-TH16X20031L 2
Connection cable N/A — | FA-CBLOOOTMV20 2

 Tip

* The FA goods input module has a function to convert the 200 V AC input signal into 24 V DC. When
replacing a 16-point terminal block type, select a 24 V DC input terminal block type module for the
programmable controller side input module. In addition, select a cable that matches the module type.

+ The following products are available for the FA goods.

« Triac large capacity (1 A/point) output module
+ Transistor large capacity (2 A/point) output module

+ Common multi-point I/O module

The FA goods can be used when replacement using a conversion adapter is difficult.
For details on the FA goods manufactured by Mitsubishi Electric Engineering Co., Ltd., please contact your
local Mitsubishi sales office or representative. TEL052-723-8058 FAX052-723-8062
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2.3 Replace AnS/QnAS (Small Type) Series with L Series

2.3 Replace AnS/QnAS (Small Type) Series with L Series
2.3.1 Replace using A (Small Type) upgrade tool

(manufactured by Mitsubishi Electric Engineering Co., Ltd.)

Solution and Benefit

The existing wiring can be used by using the conversion adapter of the upgrade tool
(manufactured by Mitsubishi Electric Engineering Co., Ltd.) for replacing MELSEC-AnS Series with
MELSEC-L Series. It is unnecessary to drill additional holes, and the man-hour for replacement can
be reduced.

B Conversion adapter
There are available two types of conversion adapters, one for using the existing AnS module
terminal block without making changes to the wiring and the other for type conversion for connector
type input/output modules with different types of connectors.

H Space module

If the wires of the existing terminal block are thick and interfere with the adjacent module, the
conversion adapter to be used may not be mounted. In this case, the wiring space can be secured

to eliminate the interference by installing the space module LG69 on the left of the newly mounted
module.

Space module With space module installed

L Series module

AnS/L conversion
adapter

Wiring terminal block removed
from AnS Series module

When the space module LG69 is used, the number of modules per block is restricted. For details,
refer to "Transition from MELSEC-AnS/QnAS (Small Type) Series to L Series Handbook
(Fundamentals)."

B Base adapter

The base adapter integrated with DIN rail is used to mount the L Series base unit using the existing
mounting holes for the AnS/QnAS Series base unit.

When the base adapter is used, it is unnecessary to fit the DIN rail, and the man-hour for
replacement can be reduced.
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2.3 Replace AnS/QnAS (Small Type) Series with L Series

AnS/QnAS Series

Panel —
. — -
mounting = A E
= || i
— H
= g
= g
— E
* Replace the terminal block
covers with those supplied
with the conversion
adapters.
DIN rail
mounting

* Replace the terminal block
covers with those supplied
with the conversion
adapters.

@ List of conversion adapters

Existing module | New module | Conversion adapter
Module type S ‘ . o o REINENE
A1SX10
A1SX10EU LX10 ERNT-ASLTXY10
A1SX40
A1SX40-S1 ERNT-ASLTX40 Usable The existing wiring can be
A1SX40-S2 used.
LX40C6
Input module A1SX80
A1SX80-S1 ERNT-ASLTX80
A15X80-S2
A1SX81 The exist?ng wiring can be u_sed
LX41C4 ERNT-ASLCXY81 | Unnecessary A ;ﬁepgg'r“\gntmh%jg?p?: Pin
A1SX81-82 connector.
A1SY10
A1SY10EU LY10R2 ERNT-ASLTXY10
A1l SY22 LYZOSG ERNT‘ASLTYZZ The existing Wiring can be
A1SY40 Usable used.
A1SY40P LY40ONT5P ERNT-ASLTY40
Output module A1SY50 ERNT-ASLTY50
A1SY80 LY40PT5P ERNT-ASLTY80
A1SY81 The existing wiring can be used
: by replacing the D-sub 37-pin
A1SYBIER LY41PT1P ERNT-ASLCXY81 Unnecessary connector with the 40-pin
connector.
Analog input :
module A1S64AD L60AD4 ERNT-ASLT64AD Usable The existing wiring can be
Analog output A1S62DA L60DA4 ERNT-ASLT62DA used.
module
High-speed A1SD61 LD62 ERNT-ASLTD61 Usable The existing wiring can be
counter module A1SD62 ERNT-ASLTD62 used.
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2.3 Replace AnS/QnAS (Small Type) Series with L Series

@ List of base adapters

Type | Existing model | Base adapter model

A1S32B ERNT-ASLB32
A1S33B ERNT-ASLB33

Main base unit A1S35B ERNT-ASLB35
A1S38B
A1S38HB ERNT-ASLB38

Extension base unit A1S65B ERNT-ASLB65

(with power supply module) A1S68B ERNT-ASLB68

Extension base unit A1S52B ERNT-ASLBS2

) A1S55B ERNT-ASLB55

(without power supply module) A1S58B ERNT-ASLB5S
A1SJCPU

Integrated type A1SJCPU-S3 ERNT-ASLBJ
A1SJHCPU

For the selection of base adapter, refer to "Transition from MELSEC-AnS/QnAS (Small Type) Series
to L Series Handbook (Fundamentals)."
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2.3 Replace AnS/QnAS (Small Type) Series with L Series

2.3.2 Replace AnS/QnAS (Small Type) Series 200 V AC input module A1SX20 without changing 1/0O
address

Solution and Benefit

(1) Anincrease in modules and changes to address can be handled easily by using FA goods.
(2) A dedicated cable is available to connect the programmable controller with the FA goods, so

there’s no need to prepare cables when making a replacement.

The following is an example of replacing the AnS/QnAS (Small Type) I/O module with the L Series
using FA goods.

When replacing the AnS/QnAS (Small Type) 200 V AC input module A1SX20 (16-input points,
16-occupied points), the L Series 200 V AC input module is LX28 (8-point input, 16-occupied points),
so the number of modules will increase, and the address will change.

By using the FA goods, the modules can be replaced without increasing the number of modules or
changing the address.

@ Instruction
(1) Using the FA goods, convert the 200 V AC input into 24 V DC, and lead it in with LX40C®6.
(2) The external wiring will change, but program does not need to be changed since the 1/0
address is the same.
(3) The following FA goods are used.

Product name ‘ ‘ External connection Remarks

FA-TH16X200A31L

200 VAC . . .
photocoupler 16-point/common (1) 200 V AC input module insulated with photocoupler

! - 7 . (2) Input module LX40C6 on programmable controller side
'r?us)lé'at:d input \ 2-wire type (3) Connection cable FA-CBLOOOYM20™

*1: Wiring work is required on the input module side because the module has unfastened wires with Y terminals.

@ System configuration example

| Current configuration | | When replaced with L Series |
T |
S o) v o | 1o | o
A1S |A2SH| A1S | A1S | 0 | 10 | 1/O Replace L61P | LO2CPU | €8 | €8 |ooiijemodulemodd
61PN | CPU | X20 | X20 module! module! module p D 0 E
A1S35B
FA-CBLO6YM20 FA-CBLO6YM20
FA-TH16X200A31L | FA-TH16X200A31L
1 1

| 200V AC input
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2.4 Replace A0J2 with Q Series

2.4 Replace A0J2 with Q Series

A0J2 upgrade tool

B A0J2 renewal tool features

The A0J2 renewal tool is used to replace existing AOJ2(H) systems with the Q Series.

It consists of an interface module where the existing wired terminal block can be mounted and a base
adapter which enables utilization of the existing installation holes, etc.

A variety of installation methods are available to fit the installation space.

H Interface module features

The interface module has DC to relay output conversion and AC to DC input conversion functions. Hence,
replacement is possible using the interface module along with Q Series connector type DC 1/0 modules.
Dedicated cables are used to connect the interface module to Q Series /0 modules.

- Installation types
(1) Stackable type
+ Existing mounting holes can be used.
« Suitable when there is enough depth.
(A depth of 195 mm (when one interface module
is stacked)/236 mm (when two interface modules
are stacked) or more is required.)

(2) Flat mounting type

+ Existing mounting holes can be used. However,
enough depth and space above the existing
modules are required.
(A space of 62 mm + 30 mm (for heat dissipation)
is required above existing modules)
(A depth of 158mm is required.)

* The required depth is less than that of the
stackable type.

(3) Standalone type
* Although space to install the main base unit

separately is needed, a base unit with a larger
number of 1/O slots can be installed. Suitable
when there is not enough space in the existing
AQJ2(H).
W =189 mm (for Q33B: 3 /O slots),

245 mm (for Q35B: 5 I/O slots),

328 mm (for Q38B: 8 I/0O slots)

*A depth of AOJ2 Series modules is 41 mm per module. (i.e., Total depth of two I/O modules and a CPU is 123

mm.)

A depth of the CPU (A0J2HCPUP21 data link type) is 68 mm.
T
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2.4 Replace A0J2 with Q Series

(1) Structure

Programmable controller

Mounting plate

(for fixing programmable controller)
- 3 slots (standard)
- 5 slots (option (Order separately))

Mounting frame| (2-level, for stackable type)
Terminal block

(For 100/200 V AC, 24 V DC relay)
Interface module (for 240/2800)

Interface module (for 5600)

____________________________________________________________________________

Current configuration After replacement

! 1

! 1

I
A0J2(H) Series X E Q Series programmable controller A0J2 upgrade tool
programmable controller ! i |+ Main base unit (Q33B) + Interface module*2
» CPU module : |:> i | + Power supply module +| Programmable controller
- /0 module : 'l (Qe2P)*t fixing frame set*3

| . | + CPU module » Programmable controller

| ' | «1/0 module connection cable

! 1

*3:

*4:

: Prepare a separate external power supply when not selecting the Q62P.

Refer to "E. Interface module power supply" for the required external 24 V DC power supply capacity.

: The A0J2 upgrade tool is compatible with the interface modules as shown in the table on the next page.

Refer to the following material from Mitsubishi Electric System & Service Co., Ltd. for details on the
"programmable controller fixing frame set", "base adapter" and "mounting plate", etc., that are not
described in these examples.

+ A0J2 Upgrade Tool Catalog (material No.: X900904-165)

The programmable controller fixing frame set is configured of the "base adapter", "mounting plate",
"mounting frame", "terminal block" and "power cable".

The dimensions for the stackable type apply when the programmable controller I/O module is a
connector type module, and the programmable controller connection cable SC-A0JQC**M is being used.
The dimensions will differ according to the module and wiring connector type being used.
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2.4 Replace A0J2 with Q Series

(3) Compeatible interface module list
+ Available models

Model to be discontinued

Alternative model

Model Alternative programmable controller I/O module
Product name| (A0J21/0 module/ : : Interface module
compact type NET/MINI)  Q Series AnS Series
A0J2-E32A/
Intput AJ35PTF-32A QXxa1/ - AJ6SSETGE 132 SC-A0JQIF-32A
module A0J2-E32D/ QX41Y41P ) SC-AOJQIF-32D
AJ35PTF-32D
A0J2-E24R/
AJ35PTE-24R SC-A0JQIF-24R
Output A0J2-E24S/ QY41P/
module AJSSPTE.24S | Qxatyaip ATSY4TP AJB5SBTCF1-32T | SC-A0JQIF-24S
A0J2-E24T/
AJ35PTF-24T SC-A0JQIF-24T
A0J2-E28AR/ A1SH42 AJB65SBTCF1-32D
AJ35PTF-28AR A1SX41+AT1SY41P | +AJ65SBTCF1-a2T | -0 A0JAIF-28AR
AQJ2-E28AS/ A1SH42 AJB65SBTCF1-32D
AJ35PTF-28AS ATSX41+A1SY4TP | +AJB5SBTCF1-32T | o0 AOJQIF28AS
A0J2-E28DR/ A1SH42 AJB65SBTCF1-32D
AJ35PTF-28DR ATSX41+A1SY41P +AJ65SBTCF1-32T | o0 ACJQIF-28DR
A0J2-E28DS/ A1SH42 AJB65SBTCF1-32D
AJ35PTF-28DS ATSX41+A1SY4P +AJ65SBTCF1-32T | o0 ACJAIF-28DS
A0J2-E28DT/ A1SH42 AJB65SBTCF1-32D
-A0JQIF-28DT
AJ35PTF-28DT ATSX41+A1SY41P | +AJE5SBTCF1.32T | SCA0JQIF-28
/O module QX41Y41P
AQJ2-E56AR/ A1SH42 AJ65SBTCF1-32D SC-ACJQIF-56AR
AJ35PTF-56AR A1SX41+A1SY41P |+AJ65SBTCF1-32T
A0J2-E56AS/ A1SH42 AJB65SBTCF1-32D
AJ35PTF-56AS ATSX41+A1SY4P +AJ65SBTCF1-2T | o0 AOJAIF-S6AS
AQ0J2-E56DR/ A1SH42 AJB65SBTCF1-32D
-A0JQIF-56DR
AJ35PTF-56DR AT1SX41+A1SY41P | +AJ65SBTCF1-a2T | S0 AOJQIF-56
A0J2-E56DS/ A1SH42 AJB5SBTCF1-32D
AJ35PTF-56DS ATSX41+A1SY4P +AJ65SBTCF1-32T | o0 ACJAIF-56DS
A0J2-E56DT/ A1SH42 AJ65SBTCF1-32D
AJ35PTF-56DT ATSX41+ATSY41P |+AJE5SBTCF1-32T | o= 0JQIF-56DT

62




2.4 Replace A0J2 with Q Series

(4) Programmable controller connection cable
(connecting interface module and programmable controller I/O module)

Model | Specifications*
SC-A0JQCO3M Cable length: 0.35 m (MIL connector - FCN connector)
SC-A0JQC10M Cable length: 1.0 m (MIL connector - FCN connector)
SC-A0JQC20M Cable length: 2.0 m (MIL connector - FCN connector)
SC-A0JQC30M Cable length: 3.0 m (MIL connector - FCN connector)
SC-A0JQC50M Cable length: 5.0 m (MIL connector - FCN connector)

* For cable length other than described above, please contact your local Mitsubishi sales office or
representative.

(5) Interface module power supply
24 V DC must be supplied as the power source for the interface module.
The power can be supplied from the Q Series power supply module Q62P, but the capacity may be
insufficient depending on the module configuration.
Prepare an external 24 V DC supply if the Q62P 24 V DC capacity (0.6 A) is insufficient.

Model \ Interface module \Module external power supply \ Relay drive power supply

SC-A0JQIF32D 200 mA —

input module SC-A0JQIF32A 210 mA -
SC-A0JQIF24R — 230 mA

Output module SC-A0JQIF24S 370 mA -
SC-A0JQIF24T 70 mA —
SC-A0JQIF28AR 105 mA 125 mA
SC-A0JQIF28AS 290 mA —
SC-A0JQIF28DR 100 mA 125 mA
SC-A0JQIF28DS 285 mA —

I/0 module SC-A0JQIF28DT 130 mA —
SC-A0JQIF56AR 210 mA 230 mA
SC-A0JQIF56AS 580 mA —
SC-A0JQIF56DR 200 mA 230 mA
SC-A0JQIF56DS 570 mA —
SC-A0JQIF56DT 260 mA —

* The above module external power supply sources include the programmable controller side 1/0
module external wiring 24 V DC.
However, these do not include the CC-Link I/O module power supply when replacing to the CC-Link.
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2.4.1 Replace A0J2(H) systems with Q Series using A0J2 upgrade tool

Solution and Benefit

+ Existing A0J2 I/O wiring can be mounted on the A0J2 upgrade tool without modification.

+ The A0J2 upgrade tool takes in AC/DC input and sends these signals to a programmable
controller's input module. It also outputs the signals received from a programmable controller's
output module to the external devices. Therefore, any A0J2 Series I/O modules can be replaced
with QX41Y41P by selecting the appropriate A0J2 upgrade tool.

* QX41Y41P, the 64-point I/0 combined module (32-point input for the first half and 32-point output
for the second half), can be used to replace the A0J2 Series I/0 modules without changing the I/O
assignment.

+ The installation size of the A0J2 upgrade tool is the same as that of the A0J2-E560 I/O modules,

eliminating the need of making new holes.

The following is an example of replacing an A0J2(H) system with Q Series using the A0J2 upgrade tool.

@ Instructions
(1) Replace the AOJ2H Series CPU with a Q Series CPU and the 1/0 modules with QX41Y41P.
The existing I/O address can be used for the QX41Y41P, and program modifications can be avoided.
(2) When the A0J2 renewal tool is used to mount the terminal blocks of the existing A0J2 I/O modules, the
existing external wiring does not need to be changed.
* The A0J2 renewal tool is not assigned an I/O module number.
The "No.=n" in the new configuration keeps track of the order of connection with the modules on the
programmable controller side to avoid changes in I/O addresses.

Check the 1/0O module number in the current configuration and connect the programmable controller side
modules accordingly.

(1) System configuration example

| Current configuration |

A0JCO1 A0JCO1 A0JCO03 A0JCO3

o o o
z < a a a
5] & © © ©
£ | re) re) re)
S o i i i
Y S o [ o
= 2 3 3 3
< < < < <

No. 3 No. 0 No. 1 No. 2
YEO to YF7 X00 to X1F X40 to X5F X80 to X9F
Y20 to Y37 Y60 to Y77 YAO to YB7 *"n" of No.=n indicates the 1/0 module number.
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2.4 Replace A0J2 with Q Series

| New configuration after replacement |

(1) When the stackable type is used -+ With mounting plates for fixing frame set

=58 ~n| & —Q |—Qo
aix= T sE=IzE
X N X X
L 181835 2 o |O>5% 2
z | & [xo0.YE0..| € T |X40..X80..| E
=1 ° oy
Q638 I

_______________

SC-A0JQCO3M (0.35 m I/O connection cable) x 5
SC-A0JQC10M (1.0 m /O connection cable) x 2

SC-A0JQIF24R

No. =3

_ | F'"I R
o 1 ! oc :
a | ! a ,
L ! ! 5 |
o ! X e] i
) e ]
=] I Q
< | o< h
(&] 1 ! [&] \
() | 1 w \
No. =f 1 : No. =1 1
|

SC-A0JQSEL-U2 !
(2-level stackable type) :

SC-A0JQSEL-U1

@ Module selection example (Q Series)

Product name

| Existing module

(1-level stackable type)

SC-A0JQIF56DR

No. =2

SC-A0JQBSL
(Standalone type)

\ Stackable type replacement module

Power supply module Q61P 2
CPU module QoouUCPU 1
Main base unit AOJZHCPU 1 Q33B 1
Extension base unit Q63B 1
I/0 module A0J2-E56DR 3 | QX41Y41P 3
Output module A0J2-E24R 1 | QY41P 1
Extension cable A0JCO01/A0JCO3 4 | QC06B (0.6 m) 1

(CPU built-in power supply _ | 24 V DC power supply module )
24V DC power supply module is used.) (Commercially available)

® A0J2 upgrade tool

Product name |Stackable type replacement module\ Remarks

nterf dul SC-A0JQIF56DR 3

nterface module SC-A0JQIF24R 1

Programmable controller SC-AOJQSEL-U2 1

fixing frame set

(Base adapter + mounting frame) SC-A0JQSEL-U1 1

Mounting plate Change the adapter plate for
SC-A0JQPT3 1

(for Q63B) Q Q33B with the one for Q63B.

Base adapter SC-A0JQBSL 1

(for standalone type)

Programmable controller SC-A0JQCO3M 5 | Cable length: 0.35 m

connection cable SC-A0JQC10M 2 | Cable length: 1.0 m




2.4 Replace A0J2 with Q Series

(2) When the stackable type is used --- With a 5-slot base unit

: SHcalca ool T .
| | 8 [x00...|xd0...|x80... YEO... § !
: © U U U D U U U E SC-A0JQCO3M (0.35 m I/O connection cable) x 3
X Q358 | | I l I | SC-A0JQC10M (1.0 m I/O connection cable) x 4
e [ g | s I [ g |
8| BT B LA
=R - T A - T ] - B
A I A -
88 oy 8 8 |
! /| No. = No.=0 |, ! ! No. =1 X ! No. = X
| SC-AGJQSELU2 l "SC-AJGBSL " SC-AGIQBSL
:_ B _(_2-I_eye_l staclfa_blie Ey?e_) o _: (Standalone type) (Standalone type)
Size description (2-level stackable type: 5-slot base unit is used)
(Q35B)
Q Series programmable controller
&
E24R 33
| E56DR | §"
29 | 190 | 29 Unit: mm
@ Module selection example (Q Series)
Product name | Existing module \ Stackable type replacement module
Power supply module Q61P 1
CPU module AO0J2HCPU 1 | QOOUCPU 1
Main base unit Q35B 1
A0J2-E56DR 3 | QX41Y41P 3
I/0O module
A0J2-E24R 1 | QY41P 1
(CPU built-in power supply _ | 24V DC power supply module i
24 V DC power supply module is used.) (Commercially available)
® A0J2 upgrade tool
Product name |Stackable type replacement module\ Remarks
Intert dul SC-A0JQIF56DR 3
nteriace module SC-A0JQIF24R 1
Programmable controller
fixing frame set SC-A0JQSEL-U2 1
(Base adapter + mounting frame)
Mounting plate 29 mm width increase on both sides as
(for Q35?3)p SC-A0JQPT5 1 | compared to the plate for Q33B. (For replacing
the fixing frame set SC-A0JQPT3)
Base adapter SC-A0JQBSL 5 For E56 (mounting plate)
(for standalone type) * Required for standalone type
Programmable controller SC-A0JQCO3M 3 | Cable length: 0.35 m
connection cable SC-A0JQC10M 4 | Cable length: 1.0 m
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2.4 Replace A0J2 with Q Series

(3) When the standalone type is used

Dfco|ga (g | &
T | § [X00..X40.. Xg0... YEO... £
e}
U U U U U U SC-A0JQC10M (1.0 m I/O connection cable) x 7
QesB I | (=} I I
5] & | 5L s
5 g | - F B S
| @ 8 | s 8
: No. =3 No. =0 | : No. = , : No. =: ,
~ SCAMGBSL “SC-A0JQBSL ~ SC-A0JQBSL
(Standalone type) (Standalone type) (Standalone type)
® Module selection example (Q Series)
Product name | Existing module \ Standalone type replacement module
Power supply module Q61P 1
CPU module QO0UCPU 1
A0J2HCPU 1
Main base unit Q35B 1
Extension base unit N/A -
I/0 module A0J2-E56DR 3 | QX41Y41P 3
Output module A0J2-E24R 1 | QY41P 1
Extension cable A0JCO1/A0JCO3 4 | N/A -
CPU built-in power supply 24 V DC power supply module
24V D | le | ! - .
C power supply module is used.) (Commercially available)
® A0J2 upgrade tool
Product name | Standalone type replacement module \ Remarks
Intert dul SC-A0JQIF56DR 3
nieriace moddle SC-A0JQIF24R 1
Base adapter
(for standalone type) SC-A0JQBSL 3
Programmable controller )
connection cable SC-AoJQC10M 7 | Cable length: 1.0 m

 Tip

+ When using the stackable type, check that there is enough depth.

Also, check the width when using a programmable controller main/extension base unit with 5 slots because it

may have increased.

Select the appropriate cable length between the interface module and the programmable controller (I/O

module) depending on the system configuration.

+ The I/O addresses (X/Y addresses) of existing A0J2 I/O modules are preset according to the 1/0 module

numbers. Check the I1/0 module number that has been set for each existing module.

Connect the A0J2 renewal tool with the 1/0 modules in a way that the same I/O addresses are used when

upgrading to Q Series CPU.

When an output-only module such as SC-A0JQIF24R is used, selecting QY41P as the programmable

controller side module changes the I/O addresses and requires program modification.

In this case, the start I/O address of the affected slots can be re-assigned in 1/0 assignment of Q Series CPU

parameter in order to avoid changes to the program.

+ 24 V DC output power supply of the Q62P can be used as an external power supply for the A0J2 renewal
tool. However, depending on the number of modules used, an extra power supply may be needed. In this

case, prepare an external 24 V DC power supply.
T
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2.4 Replace A0J2 with Q Series

2.4.2 Upgrade to MELSECNET/H (remote I/O network) system using A0J2 upgrade tool

Solution and Benefit

+ Using the A0J2 upgrade tool, AOJ2R25(P25) remote I/O stations can be replaced with
MELSECNET/H remote I/O stations without modifying external wiring.

* By making the same network parameter settings as the current ones, program modifications can

be avoided.

The following is an example of upgrading a MELSECNET network system consisting of only remote 1/O stations
to a MELSECNET/H (remote 1/0O network) system using the A0J2 upgrade tool.

@ Instructions
(1) Replace the MELSECNET network system with MELSECNET/H remote I/O network system. The network
parameter settings remain the same, and it is not necessary to make changes to the program.
(2) Change the cable system from MELSECNET coaxial loop to MELSECNET/H coaxial bus. New wires are
not necessary because the existing coaxial loop cables can be used.

(1) System configuration example

| Current configuration |

Master station © g © g
O, |- 1 | | & © 8 ©
= o o 0 0 o o i Y] i
s | 5 31 3 13 3 2 3 S 3 Y
@ z g 1o 1 8 1 © g < 3 < 3
5 | O E | E | E | E | E < <
21812 Q129
o <T I
X80 to X9F XCO0 to XDF
MELSECNET (Coaxial loop) YAO to YB7 YEO to YF7

SC-A0JQSEL-U1
(1-level stackable type)

SC-A0JQSEL-U1
(1-level stackable type)

! |
Q358 | Q33B ' 1Q33B |
= | |
il o | 2|2 |92 |- | w | > H o | > !
25| 3 S = = - - - > - | past o - - |
%152/ 8|8 |8 B |&| | G |XS|E 8| !|le &I|XT| |
© |GO| E | E| E | E | g | o |0 E|lE| || Q|0 E | E |
° gggga‘oaw”“hoaw”“:
| Pl |
| o |
MELSECNET/H (Coaxial bus) @J_L l 2 LA - £|E| |
I Coaxial bus | | |
| ol |
| o |
| Pl |
| |
| :\ :
| o |
! x g x 1l x ﬂo: x !
| 88 |8 o g 8§
| s L[5 3 = 5|
| £ g = ol < g £ |
! £ 3 3 ! £ 3 E I
| i} < o o 2o < e |
| o &) =2 | o &) =) |
c c c c
| 3 ? |3 h g 2 |3 !
| a4 o L o & ‘
| Pl |
| o |
| Pl |
| ol |

SC-A0JQCO3M (0.35 m I/O connection cable) x 4
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2.4 Replace A0J2 with Q Series

® Module selection example
(1) Programmable controller

Product name | Existing module \ Replacemant module
Power supply module A62P 1 Q62P (with 24 V DC) 3
CPU module A2NCPUR21 1 QO01UCPU 1
Main base unit (master station) A35B 1 Q35B 1
Main base unit (remote 1/O station) N/A - Q33B 2
MELSECNET/H master station module N/A - QJ71BR11 1
MELSECNET/H remote I/O station module| A0J2R25 2 | QJ72BR15 2
I/0 module A0J2-E56DR 2 | QX41Y41P 2
Terminating resistor for coaxial bus link (75 Q)| N/A - | ABRCON-R75 2

(2) A0J2 upgrade tool

Product name | Model \ Remarks
Interface module SC-A0JQIF56DR 2
Programmable controller fixing frame set | SC-A0JQSEL-U1 2
Programmable controller connection cable | SC-A0JQCO3M 4 | Cable length (0.35 m)

 Tip

+ The overall distance of coaxial bus is 500 m (when using 5C2V). Use the following product to extend the
distance up to 2.5 km.
"Repeater Unit for the MELSECNET/10 Coaxial Bus System type A6BR10"

+ When upgrading an optical loop network system, use the "QJ71LP21-25 for the master station" and the
"QJ72LP25-25 for the remote /O station" so that the optical loop can be maintained.
The distance between stations differs depending on the type of optical fiber cables used in the existing
system. Refer to "Q Corresponding MELSECNET/H Network System Reference (Remote I/O network)"
SH-080124 for details.



2.4 Replace A0J2 with Q Series

2.4.3 Replace MELSECNET/MINI compact type remote 1/0 modules with CC-Link

Solution and Benefit
+ By mounting existing terminal blocks on the A0J2 upgrade tool (interface module), the compact
type remote I/0 modules can be replaced with CC-Link modules without modifying external
wiring.
+ Existing compact type remote /O modules and A0J2 upgrade tools have the same number of I/0
points, realizing the system upgrade without program modification.
* For details on the A0J2 upgrade tool, refer to "Section 2.6 Replace A0J2(H) systems with Q
Series using existing wiring".

The following is an example of replacing MELSECNET/MINI compact type remote I/O modules with CC-Link
using the A0J2 upgrade tool.

@ Instructions
(1) Select connector type CC-Link I1/O modules to allow connection with the A0J2 upgrade tools.
(2) Select a CC-Link I/0 module for replacement with a connector type external wiring to enable use of the
A0J2 upgrade tool connection dedicated cable.

(1) System configuration example

| Current configuration |

®
]
[ ]
1/0 module
1/0 module
32-S3

A2NCPU
1/0 module

Terminal block

Terminal block

Terminal block

erminal| AJ71PT

Termi
block

L1
ﬂI/O module

AJ35PTF-56DR
AJ35PTF-56DR
AJ35PTF-56DR

W

Existing terminal block

x
[53
S
e}
=
£
E
8
(o))
£
£
2
>
w

Existing terminal block

X
3]
o
e}
©
k=
£
k)
o
£
=
a
3
w

Existing terminal block
Existing terminal block

Replace

New configuration after replacement |

-

The twisted pair —L
communication cables
must be replaced with
CC-Link dedicated

cables.

N ‘3_:; § § § § Ez [[--SC-AOJEPTZ ﬂ “”-SC-AOJ-(J-PT2 —|| [[--SC-AOJBPTZ . |
z186/g g 8|8 37| ii|avessBTCF1-32D I+t [AJe5SBTCF1-32D I 1 [AJe5SBTCF1-32D I
© ool |8 | ||!—H—\ |||!—H—\ |||!—H—\ '

! + | AJs5SBTCF1-32T |: I + | AJs5SBTCF1-32T | I + | AJB5SBTCF1-32T |:

=

SC-A0J
QIF56DR

SC-A0J SC-A0J
QIF56DR QIF56DR

x x x
3] [3] 3]
o o o
o s} o
© © ©
£ £ £
£ £ £
£ = =
2 2 2
o) =) o)
£ k= £
2 k] 2
X X b

Existing terminal block

x x
[53 [5]
ke o
o o
T K
£ £
£ E
E £
2 2
j=2) D
£ £
2 2
x x
Ll L

E:
E:
E:

SC-A0JQSEL-U1

-level stackable type)

70

SC-A0JQSEL-U1

i ; (1-level stackable type)

SC-A0JQSEL-U1

i ' (1-level stackable type)




2.4 Replace A0J2 with Q Series

® Module selection example
(1) Programmable controller

Product name | Existing module \ Replacemant module
Power supply module A61P 1 Q61P (without 24 V DC) 1
CPU module A2NCPU 1 | Q01UCPU 1
Main base unit A35B 1 | Q35B 1
CC-Link (master module) AJ71PT32-S3 1 | QJB1BT11IN 1
CC-Link input module AJ65SBTCF1-32D 3
CC-Link output module AJ3SPTF-56DR 8 | AJG5SBTCF1-32T 3

Note: Select appropriate I/O modules according to specifications of existing modules.

(2) A0OJ2 upgrade tool

Product name | Model \ Remarks
Interface module SC-A0JQIF56DR 3
Programmable controller fixing frame set | SC-A0JQSEL-U1 3 | For 1-level stackable type
Mounting plate SC-A0JQPT2 3 | For CC-Link I/O modules
Programmable controller connection cable | SC-A0JQCO3M 6 | Cable length (0.35 m)

4 (CC-Link stackable type) R

+ MELSECNET/MINI twisted pair cables must be replaced with CC-Link dedicated cables.
+ CC-Link I/O modules and A0J2 upgrade tools (interface modules) require 24 V DC power supply in addition
to power supply for control. Prepare a 24 V DC power supply separately.
* When using the stackable type renewal tool as shown in the example, make sure there is enough depth.
(Required depth: 120 mm or more)
The mounting plate for CC-Link 1/0 modules is sold separately.
+ Also the CPU can be replaced with LCPU.
When it is replaced with L Series, the CC-Link master module LJ61BT11 or the built-in CC-Link function of
the CPU will be used.
The remote module is common to Q Series and L Series.
e
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3.1 Replace A/QnA (Large Type) Series with Q Series

3. Replacement utilizing existing modules

3.1 Replace A/QnA (Large Type) Series with Q Series
3.1.1 Utilize A/QnA (Large Type) Series QA6LOB extension base unit

Solution and Benefit

+ The QA6CB extension base unit permits reuse of existing A (Large Type) Series modules,
minimizing wiring time.

+ The system can be upgraded even if Q Series compatible modules do not exist.

The CPU can be replaced with the QCPU. An example of using a current A (Large Type) module without
modification to shorten the re-wiring man-hours is shown below.

@ Instructions
(1) Only the CPU is replaced to the Q Series. The current I1/0O module is used.
Replace the existing A (Large Type) main base A38B to QA68B, and mount the existing module.
(2) If the module must be replaced with the Q Series, select the module and then mount on the Q Series main
base unit.
(3) Avoid changing the current I/O assignments.

(1) System configuration example

| Current configuration | | After replacement |

| %
— £ £
= w w
- =
= _ - a a [ = 2
% § % g § 33 s % 5 Replace Modules upgraded
2 2 < | <|8| 5|k from the A Series
< < 3
A38B
1)
= 2| 2
5158
<
QcCo6B * * [}
Qaess | —p—"D—1—"—"—
Existing A Series Empty slots for replacing
modules to Q Series module
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3.1 Replace A/QnA (Large Type) Series with Q Series

(2) Module selection example

Product name Existing module Replacement module
Power supply module (for main base unit) N/A - | Q61P 1
CPU module A3NCPU 1 | QO6UDHCPU 1
Main base unit A38B 1 | Q35B 1
CC-Link master module AJ61BT11 1 | QJ61BT11N 1
MELSECNET/10 network module AJ71BR11 1 | QJ71BR11 1
Ethernet module AJ71E71N3-T 1 | QJ71E71-100 1
Extension base unit N/A - | QA68B 1
Power supply module (for extension base unit) | A61P 1 | Utilize existing module | -
Extension cable N/A - | QCo6B 1
Input module AX41 1 | Utilize existing module | -
Output module AY10 1 | Utilize existing module | -
Analog input module AB8AD 2 | Utilize existing module | -
Analog output module AB8DAI-S1 1 | Utilize existing module | -

 Tip —

* The following A (Large Type) modules cannot be used with QCPU.
These modules must be replaced with those compatible with QCPU.
+ CC-Link master/local module
+ MELSECNET/10 network module
+ Ethernet module
« Computer link module etc.
« After replacing the module, use the parameter I/O assignment and set so that the existing module addresses
are not changed.
+ The QA6BOB extension base units and QA1S60B extension base units are only compatible with High
Performance Model QCPU or Universal Model QCPU (first five digits of serial No. "13102" or higher).
Basic Model QCPUs, Process CPUs, Redundant CPUs, Safety CPUs, and Remote I/O Stations are not
compatible.
+ For precautions and restrictions when using QA60B extension base unit, refer to "QA65B/QA68B Extension
Base Unit User's Manual".
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3.1 Replace A/QnA (Large Type) Series with Q Series

3.1.2 Utilize existing I/0 modules and extension base unit with Q Series CPU
(Use QA conversion adapter)

Solution and Benefit

The QA conversion adapter module enables the existing extension base, including the mounted I/O
modules, to connect to a Q Series main base unit. This can shorten the installation and wiring
modification times.

The following is an example of reusing existing A (Large Type) Series modules with a Q Series CPU using the
QA conversion adapter module.

@ Instructions

(1) Replace the A (Large Type) Series CPU with the Q Series CPU (Q03UDCPU) and mount it on the Q Series
main base unit (Q30B).

(2) To reutilize I/0O modules mounted on the existing A (Large Type) Series main base unit, mount them on the
QA60B extension base unit.

(3) Mount the “QABADP” adapter on the connector of each existing extension base unit to allow the use
of existing modules.

(4) Connect the base units with the Q Series extension cable (QCOB).

(1) System configuration example

| Current configuration | | After replacement |
Replace the A (Large Type)
¢ | CPU with a QCPU 94 ]
2 25| Q Series modules
AL IR IR IEAE: M S~ are mountable
2122 %3 % 3|38 are mountable
Q358

A35B X00.. Extension base stage 1
)
Remount the o | o |l o | o ||
— N N N NA M
modules on the - - - -
QA6LB. HH
ACO06B
QAB5B X00...

Extension base stage 1 QcCoeB

° Extension base stage 2
()
Utilize the modules
% g g g g g and extension base unit. . R R S S
122 =2 |2 |x
HH ES‘S Extension stage
number setting: 2nd stage
A B X140... Il Il Il Il Il T
65 | AB5B X140.. |
ACO06B
QCo6B

Extension base stage 2 Extension base stage 3

¢ ()
e lglglyls|z Utilize the modules . e T Tl o
€ 2|z =z 3 |% and extension base unit. . AR
HH QAB Extension stage
ADP % number setting: 3rd stage
AGSE Y20.. / | A65B vo0. |

* The extension stage number of the QA conversion adapter

should be set in accordance with that of the extension base unit. The adapter allows the A (Large Type) Series extension base unit to be

used as the QCPU's extension base unit. (Max. 7 extension stages)

74



3.1 Replace A/QnA (Large Type) Series with Q Series

® Module selection example

Product name \ Existing module \ Replacement module

Power supply module (Q Series new) N/A - | Q61P 1
Power supply module (for extension base unit) | A61P (main/extension base unit) | 3 | Utilize existing module | -
CPU module A3ACPU 1 | QO3UDCPU*! 1
Main base unit A35B 1 | Q35B*2 1
Extension base unit (1st stage) N/A - | QA65B*3 1
Extension base unit A65B 2 | Utilize existing module | -
QA conversion adapter module N/A - | QAGADP 2
Extension cable N/A - | QCcoe6B*4

Input module Use existing module in original state

Output module Use existing module in original state

*1: Select the module depending on the existing program capacity and contents.
*2: Used to mount the Q Series CPU.

*3: Used to mount modules on the existing main base unit.

*4: Select the cable length according to the arrangement of base units.

 Tip

+ The existing A (Large type) Series extension base unit and mounted modules can be utilized without wiring
modification.

The existing A (Large Type) Series extension base unit can be used without modifying the wiring by replacing
with the extension base QA60B, and remounting the mounted modules.

+ Program modifications can be minimized by using the same 1/0 address for the existing units and setting the
current 1/0 addresses with the parameter I/O assignments.

+ The following A (Large Type) Series module cannot be used with the Q Series CPU. These must be changed
to a Q Series CPU compatible module.

» CC-Link master/local module

» MELSECNET/10 network module

» Ethernet module

» Ethernet module, computer link module
etc.

+ The A (Large Type) Series A6OB/A50B extension base unit with the QA6ADP cannot be used together with
the QA1S60B extension base unit.

* When an AC input module is mounted on the "A50B" extension base unit (without power supply) using the
QABADRP, either the "A60B with QA6ADP" or "QABOB" extension base unit (with power supply) is required in
the system.

+ Set the stage number for QA6ADP according to the setting of the extension base unit.

+ The QAB6ADP QA conversion adapter is only compatible with High Performance Model QCPU or Universal
Model QCPU (first five digits of serial No. "13102" or higher).

Basic Model QCPUs, Process CPUs, Redundant CPUs, Safety CPUs, and Remote I/0O Stations are not
compatible.

+ For the precautions and restrictions when using QA conversion adapter, refer to "QA6ADP QA Conversion

Adapter Module User's Manual".
e
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3.2 Replace AnS/QnAS (Small Type) Series with Q Series

3.2 Replace AnS/QnAS (Small Type) Series with Q Series
3.2.1 Utilize AnS/QnAS (Small Type) Series QA1S60B extension base unit

Solution and Benefit

By using the current AnS/QnAS (Small Type) module, the wiring work during replacement can be
reduced. Replacements can be completed in a short time.

‘Replacement is possible even if a compatible Q Series module is not available.

*If an extension base unit is connected to the current AnS/QnAS (Small Type) series, it can be used

together with the A/QnA (Large Type) QA60B extension base unit.

The CPU can be replaced with the QCPU. An example of using a current A (Small Type) module without
modification to shorten the re-wiring man-hours is shown below.

@ Instructions
(1) Only the CPU is replaced to the Q Series. The current /O module is used.
Replace the existing AnS/QnAS (Small Type) main base A1S35B to QA1S65B, and mount the existing
module.
(2) If the module must be replaced with the Q Series, select the module and then mount on the Q Series main
base unit.
(3) Avoid changing the current 1/0 assignments.

(1) System configuration example (1)

| Current configuration | | After replacement |
Replace AnS/QnAS (Small Type)

o e CPU with QCPU
22 3|35 % |%g iﬂ
s 9 X X ¥ 3 52
815 2 2 5|5 |85
2|9 < | < | x| <
X00r
A1S35B

Replace AnS (Small Type)
main base with QA1SOB,
and mount modules

Empty

A1S61PN
A1SY41P
A1SY41P

QA1S65B
Empty slot for replacing to
@ Module selection example Q Series module
Product name | Existing module | Replacement module

Power supply module (new) N/A — | Q61P 1
Power supply module (for extension base)| A1S61PN 1 Utilize existing module —
CPU module A2SHCPU 1 QO01UCPU 1
Main base unit A1S35B 1 Q33B*! 1
Extension base unit N/A — | QA1S65B*2 1
Connection cable N/A — | QCo6B*® 1
Input module Use existing module in original state

Output module Use existing module in original state

Ethernet interface module A1SJ71E71N-T \ 1 \ QJ71E71-100* 1

*1: Used to mount the Q Series CPU.

*2: Used to mount modules on existing main base unit.

*3: Select the cable length according to the arrangement of base units.
*4: Must be replaced with Q Series module.
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3.2 Replace AnS/QnAS (Small Type) Series with Q Series

(1) System configuration example (2)

| Current configuration | | After replacement |
Replace AnS/QnAS (Small Type) _
° CPU with QCPU S e
22 |- 2|2
E 2 3|5 |8 %= 85 5- 2|2
B 2 ¢ 25 3¢k ) e
| 9| < || x| |<
Q33B
X~ QcoeB
A1S35B Extension base stage 1

Replace AnS (Small Type)

zZ - - o o
main base with QA1S60B, TIX X 5|5 2
and mount modules o |22 w0 f
HH T | < T 2|
ACO06B X00~
QA1S65B
Empty slot for replacing
QC06B with Q Series module

Replace A (Large Type)
extension base QA60B,
and mount modules

I I

AB5B ) QAB5B
/

Extension base stage 1 Extension base stage 2

A61P
AX41
AX41
AY41P
AY41P
ABBAD
AB1P
AX41
AX41
AY41P
AY41P
ABBAD

The QA1S extension base and mounted large type QAG6ADP extension
base cannot be used together, so base must be replaced.

® Module selection example

Product name Existing module Replacement module
Power supply module (new) N/A — | Q61P 1
Power supply module (for extension base 1st stage) | A1S61PN 1 Utilize existing module —
CPU module A2SHCPU 1 QO01UCPU 1
Main base unit A1S35B 1 Q33B*! 1
Extension base unit (1st stage) N/A — | QA1S65B*2 1
Connection cable N/A — | QCo6B*® 1
AnS (Small Type) input module Use existing module in original state
AnS (Small Type) output module Use existing module in original state
Ethernet interface module A1SJ71E71N-T 1 QJ71E71-100* 1
Power supply module (for extension base 2nd stage) | A61P 1 Utilize existing module —
Extension base unit (2nd stage) A65B 1 QAG5B*® 1
Connection cable AC06B 1 | QCoe6B*® 1
A (Large Type) input module Use existing module in original state
A (Large Type) output module Use existing module in original state
A (Large Type) analog /0O module Use existing module in original state

*1: Used to mount the Q Series CPU.

*2: Used to mount modules on existing main base unit.

*3: Select the cable length according to the arrangement of base units.
*4: Must be replaced to Q Series module.

*5: For re-mounting existing A large type extension base unit
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3.2 Replace AnS/QnAS (Small Type) Series with Q Series

Tip —

* The existing AnS/QnAS (Small Type) main base unit can be used without modifying the wiring by replacing
with the extension base QA1S60B and remounting the mounted modules.
The existing A (Large Type) extension base unit can be used without modifying the wiring by replacing with
the extension base QA60B, and remounting the mounted modules.

» The QA1S60B extension base unit cannot be used together with the A (Large Type) extension base A6OB/
A50B) onto which QABADP is mounted.
When using a module mounted on the existing A (Large Type) extension base unit, replace the base unit
with the QA60OB extension base.

+ Connect the base units in the following order.
»Q Series main base unit — Q Series extension base unit —> QA1S60B extension base —> QA60B

extension base

The GOT bus cannot be connected when the QA6OB extension base is connected.
The GOT bus can be connected when only the QA1S60B extension bus is connected.

» Program modifications can be minimized by using the same I/O address for the existing units and setting the
current I/0 addresses with the parameter I/O assignments.

* The following A/QnA (Large Type) module and AnS/QnAS (Small Type) module cannot be used with the Q
Series CPU.
These must be changed to a Q Series CPU compatible module.
»CC-Link master/local module
»MELSECNET/10 network module
»Ethernet module, computer link module, etc.

» The QA1S60B extension base and QA60B extension base are only compatible with High Performance
Model QCPU or Universal Model QCPU (first five digits of serial No. "13102" or higher).
Basic Model QCPUs, Process CPUs, Redundant CPUs, Safety CPUs, and Remote I/O Stations are not
compatible.
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3.2 Replace AnS/QnAS (Small Type) Series with Q Series

3.2.2 Replace main base unit with Q Series and use existing extension base unit and modules in it
(use QA1S conversion adapter)

Solution and Benefit

It is possible to replace the modules including the CPU on the main base unit with Q Series
modules and use the existing input/output modules and extension base unit.
This can reduce the working hours for drilling and wiring modification.

Existing modules Replacement Replacement
step 1 step 2

—

Replacement of
modules on main
base unit with Q
Series modules

— Al
=

=g —
Ies 4 Mounting of

QA1S6ADPto .
extension base unit t modules on extension

Replacement of

QA1SBADP base unit with Q

Series modules
List of Q-AnS base unit conversion adapters

Product name | Model
Q-AnS base unit conversion adapter | QA1S6ADP

 Tip

1. The extension base unit equipped with QA1S6ADP must be installed in the first extension stage.
Since QA1S6ADP does not have an extension cable connector (OUT), it cannot be connected to the base
unit in the second extension stage or higher.
Therefore, when QA1S6ADP is used, the system consists of 2 base units, Q Series main base unit and
AnS extension base unit equipped with QA1S6ADP.
To replace only the CPU with Q Series, it is required to use the QA1S extension base unit. Refer to Item
3.2.1.
2. When the existing A/AnS Series modules are used, the program can be used without changing the
existing I/0 addresses through I/0 assignment by parameters.
For the detailed procedures for setting the 1/0 addresses through 1/0 assignment, refer to Section 3.3.
3. The AnS extension base unit equipped with QA1S6ADP can be used with a high performance model
QCPU or universal model QCPU (the first 5 digits of the serial number must be "13102" or later).
The modules which can be installed in the AnS extension base unit equipped with QA1S6ADP are the
same as those installed in the QA1S extension base unit. For details, refer to "Transition from MELSEC-
AnS/QnAS (Small Type) Series to Q Series Handbook (Fundamentals)."
T
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3.3 Utilize existing A (Large Type) and AnS (Small Type) modules without changing I/O addresses

3.3Utilize existing A (Large Type) and AnS (Small Type) modules without
changing I/O addresses

Solution and Benefit

* The I/O addresses do not need to be changed when reutilizing existing A (Large Type) and AnS
(Small Type) modules with Q Series CPU and mounting the modules on QA60B/A600B+ QA6ADP
or QA1S60B. This can greatly reduce program modification time.

* The A (Large Type) and AnS (Small Type) modules can be used with the same I/0 addresses, so

there is no need to change the external wiring numbers.

The following is an example of how to reuse the program without modifying the 1/0 addresses when replacing the
CPU with a Q Series CPU and keeping the existing I/0O modules on a QA extension base unit.

(1) /0O assignment example

When utilizing existing A (Large Type) and AnS (Small Type) modules with the Q Series CPU, set the existing
module’s I/O addresses to the existing addresses with the PC parameter 1/0 assignment settings. Assign the
addresses for the modules mounted onto the main base unit after the existing module. This will greatly reduce
program modification time.

@ System configuration example (same as in 3.1.1)

| Current configuration | | After replacement |

Replace

Empty
Empty

QJ61BT1IN
QJ71BR11

A61P
A3NCPU
AX41
AJ61BT11
AY10
A68AD
A68AD
A68DAI-S1
AJ71BR11

iy
2]
z
=
<
]
=
I
<

A38B

Empty
Empty

AB8DAI-S1

QA68B
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3.3 Utilize existing A (Large Type) and AnS (Small Type) modules without changing I/0O addresses

® Parameter setting example

Address
0 | QJ61BT11IN Intelli 32 100
) . 1 | QJ71BR11 Intelli 32 120
:\gg;;\se unit 2 | QU71E71-100 Intelli 32 140
3| N/A Empty 16 160
4 | N/A Empty 16 170

‘ Model ‘ Type ‘ Point ‘ Address
5 | AX41 Input 32 00
6 | N/A Empty 32 20
7 | AY10 Output 16 40
Extesion base unit 8 | A6BAD Intelli 32 50
(QA68B) 9 | A68AD Intelli 32 70
10| A68DAI-S1 Intelli 32 90
11| N/A Empty 32 BO
12| N/A Empty 32 DO

 Tip

« Assign the 1/0 numbers in the following order: Q Series to A Series or A Series to Q Series.
* When the order is mixed (i.e., Q Series -> A Series -> Q Series), the CPU does not start up due to an error.
I

81



4.1 Replace MELSECNET(II) with MELSECNET/10

4. Replacement of MELSECNET Network System

4.1 Replace MELSECNET(II) with MELSECNET/10

4.1.1 Replace MELSECNET(II) coaxial loop with MELSECNET/10 coaxial bus system
while retaining existing A Series CPUs

Solution and Benefit

+ When an existing MELSECNET(II) system consists of many stations, the complete network
system can be upgraded to MELSECNET/10 while reusing existing cable installations.

+ By upgrading the entire network at once, the current network parameter settings can be used.

+ Once the network is updated, A Series stations can be replaced with the Q Series in any order

until all the stations are upgraded to the Q Series.

The following is an example of replacing a MELSECNET(II) coaxial loop system's master station with a Q Series
system and upgrading the network to a MELSECNET/10 coaxial bus system.

@ Instructions
(1) Replace one of the MELSECNET(II) stations with the Q Series.
(2) Replace the complete MELSECNET(II) system with MELSECNET/10 coaxial bus system.
(3) Replace the CPU of each station with Q Series CPU sequentially, and eventually replace all CPUs with Q
Series CPUs.
(4) Use the existing settings for the network parameters.

(1) System configuration example

| Current configuration | | Transitional step 1 |
Master station Control station
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> .v— ° o | o 33' % | % o
g | & 3232 > o |8a| 8 ' 8 | m
Z2 |5 81 8 | B T |86 € 8| ¢
S| & € ' E £ (¢] 00 |2
o3| O o' 0 w = = [e]
%'8 % = = |
aE <T ! .
J NET/10 (Coaxial bus)
—l NET/II (Coaxial loop)
@ e o ! ® o_ o !
= b ) o) = = QO =
s | o S 3 g | & 22 |
s ' 5|88 g s 5§ 2.8 &
ol £ £ E 22| 5 E | E <
S8 5 209 £850 2 2 <
o e <T o e <T
; I;
e ) [] ® ° [ —
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=1 o < =] o I -
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£3/2 | oo | ™ 8312 1o 10 | 5
28| 2 = = 28| 2 = = <
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2|52 ¢ SRR
o =) =) o =) =) o
3 |5 818 % 215 818 |5
o0 o 1S £ £ Po| @ = £ .
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4.1 Replace MELSECNET(II) with MELSECNET/10

 Tip

Unless the existing network is in MELSECNET mode or MELSECNET II mode and only the first half is set, the
network parameter settings need to be changed.

If the second half of settings have been made in the MELSECNET II mode or MELSECNET II composite
mode, the B and W station send range must be reset, and the station's inherent parameters must be set, etc.
Furthermore, when AnNNCPUs, AnACPUs or AnSCPUs are part of the system, the program should be modified
because station inherent parameters cannot be set.

For precautions regarding the existing MELSECNET(II) system configuration, refer to "Transition from
MELSEC-A/QnA (Large Type), AnS/QnAS (Small Type) Series to Q Series Handbook (Network Modules)".

| Transitional step 2 | Transition completed
Control station Control station
:E oo | = DE o o | =
S S post S S ps}
o gE 8.8 & o gi’ 3.8 &
s Ol ELE K o Ol E E |
o Q2 3 © Q123
o |o_-e o 1 o | o o =
2 Y 2 2 = =) S 3 | =
g |2 |3 3 |k o |82/ 8 8| 5§
=] -] o ' O m — (3) g £ —
co| & E I E | T g St E g
231229 2 ==
ce[2[] [—
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4.1 Replace MELSECNET(II) with MELSECNET/10

4.1.2 Upgrade to MELSECNET/H network system utilizing existing MELSECNET/B twisted pair cable

Solution and Benefit

When replacing A (Large Type) Series CPU with Q Series CPU in a MELSECNET/B data link
system, the network can be effortlessly updated to twisted bus type MELSECNET/H (PLC to PLC

network) because the existing MELSECNET/B twisted pair cable can be directly utilized. (New cable
installation is not required.)

The following is an example of replacing MELSECNET/B with twisted bus type MELSECNET/H (PLC to PLC
network) utilizing the existing twisted pair cable.

@ Instructions

(1) Replace all A Series CPUs found in the existing MELSECNET/B system with Q Series CPUs.
(2) Utilize the existing MELSECNET/B twisted pair cable.

(3) Modify the terminals of the network modules because the cable connection method has been changed from
screw terminal block type to spring clamp terminal block type.

(1) System configuration example

| Current configuration | Existing MELSECNET/B (ACPU+AJ71AT21B)

Master station Local station Local station

Upgrade to Q Series modules
Replace B

After replacement | MELSECNET/H (PLC to PLC network)(QCPU+QJ71NT11B)

Control station Normal station Normal station

* The existing MELSECNET/B twisted pair cable and terminating resistor ar e utilized.
(Terminal modification is required.)
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4.1 Replace MELSECNET(II) with MELSECNET/10

(2) Specifications of MELSECNET/H (PLC to PLC network)
The following table shows the specifications of twisted bus type MELSECNET/H (PLC to PLC network).

MELSECNET/H(PLC to PLC network) Twisted bus type
QJ71NT11B
8192 points

16384 points

Item
LX/LY
Maximum number of LB
link points per network
LW

16384 points

Maximum number of link
points per station

*MELSECNET/H mode {(LY + LB) / 8 + (2 x LW)} <2000 bytes
*MELSECNET/H Extended mode {(LY + LB) / 8 + (2 x LW)} = 35840 bytes

Communication speed

156 kbps/312 kbps/625 kbps/1.25 Mbps/2.5 Mbps/5 Mbps/10 Mbps
(Switched by network parameters)

Number of stations per network

Up to 32 stations (1 control station, 31 normal stations)

Connection cable

Twisted pair cable or CC-Link Ver.1.10-compatible cable

Overall distance for one network

Communication speed ‘ Twisted pair cable ‘ CC-Link Ver.1.10-compatible cable

156 kbps 1200 m 1200 m
312 kbps 600 m 900 m
625 kbps 400 m 600 m
1.25 Mbps 200 m 400 m
2.5 Mbps 200 m
5 Mbps . 150 m
(Not applicable)
10 Mbps 100 m

(3) Usable twisted pair cable for twisted bus type (Same specifications as those of MELSECNET/B)

The following table shows the specifications of twisted pair cable that can be used for twisted bus type
MELSECNET/H (PLC to PLC network)*.

ltem

Cross section

‘ KNPEV-SB 0.5SQ x 1P (Applicable only when the communication speed is 1.25 Mbps or less.)

Cable

Shielded twisted pair cable

Core

2-core

Conductor resistance (20°C)

39.4 Q/km or less

Insulation resistance (20°C)

10 MQ/km or more

Dielectric withstand voltage V-min

1000 V AC 1 minute

Capacitance (1 kHz)

70 nF/km or less on average

Characteristic impedance (100 kHz)

110+10Q

* The cable terminal (the part where it connects to the module) is a bar solderless terminal.
When utilizing MELSECNET/B twisted pair cable, solderless terminals need to be changed
to bar solderless terminals. For details on the bar solderless terminal and tools dedicated to it,
refer to "Q corresponding MELSECNET/H Network System Reference Manual
(PLC to PLC network)": SH-080049.
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4.1 Replace MELSECNET(II) with MELSECNET/10

 Tip

+ MELSECNET/H (twisted bus type) is compatible with Q Series CPUs only.

All A Series CPUs connected to the existing MELSECNET/B need to be upgraded to Q Series CPUs at once.

+ MELSECNET/H (twisted bus type) is compatible with PLC to PLC network only. It is not compatible with
remote /O network.

To replace MELSECNET/B with MELSECNET/H (remote I/0O network), use optical loop system or coaxial
bus system.

Or, replace MELSECNET/B with MELSECNET/H (PLC to PLC network) and remote I/O stations with normal
stations. (Refer to Section 4.3)

+ For details on Q Series CPU type to which MELSECNET/H network module (twisted bus type: QJ71NT11B)
can be mounted, number of mountable modules per CPU, and network parameter settings, refer to the
following manual.

"Q corresponding MELSECNET/H Network System Reference Manual (PLC to PLC network)" : SH-080049

+ MELSECNET/H (twisted bus type) can use CC-Link cables. The maximum communication speed of the

network is 10 Mbps.
e
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4.2 Replace one of A Series stations with Q Series while retaining MELSECNET(II)

4.2 Replace one of A Series stations with Q Series while retaining MELSECNET(II)
4.2.1 Replace A Series local station with Q Series

Solution and Benefit

(1) Using a local station data link module, the Q Series can directly connect to existing
MELSECNET(II) network as a local station. When replacing A(Large type/Small type)Series CPU
with Q Series CPU, existing wiring can be utilized, and network parameter modification is not
required.

(2) MELSECNET(II) local station data link modules for optical fiber loop, coaxial loop, and

MELSECNET/B are provided to support all types of existing networks.

The following is an example of replacing one of A Series local stations with the Q Series.

@ Instructions
Replace the CPU and other modules on one of the A Series local stations with the Q Series, and mount the
MELSECNET(II) or MELSECNET/B local station data link module on the QA1S6LB extension base unit.

(1) System configuration example

| Current configuration | After replacing local station with Q
Master station Master station
(] e o e e o

No change

Power supply

module
1/0O module
1/0O module
1/O module

§ 43

Power supply

module

1/0O module
1/0O module
1/0 module

A3ACPUP21
A3ACPUP21

MELSECNET(II) (optical loop)

MELSECNET(II) (optical loop) Local station 1

-D_—
5o @ o | @
. o o0 =} =) 3
Local station 1 - |26/ 8| 8| 8
© GO
° s E| €| E
Q| Q| Q
FEAEA IR BB T cos
=} 32 =}
3.5 8183 Replace
55| O | E | E | E [
%é sllele|e g% > > =
cE| < =
5|5 | E| E|E
@ |@g| W | W | W
< | <&

E
%)
R
@

Local station 2

Local station 2

No change

1/0 module
1/0 module
1/0 module
Power supply
module
A2ACPUP21
1/0 module
1/0 module
1/0 module

Power supply

module

A2ACPUP21

(including optical fiber cables)

. Local station 3
Local station 3 T

Replace

Power supply

module
A2NCPUP21

1/O module
1/0 module
1/O module
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4.2 Replace one of A Series stations with Q Series while retaining MELSECNET(II)

® Module selection example
(Local station 1)

Product name

Existing module

Replacement module

Power supply module A61P 1 Q61P 1
CPU module A3ACPUP21 1 QO3UDCPU 1
Main base unit A38B 1 Q38B 1
Input module AXO — | QxOo —
Output module AYO — | QyQ —
MELSECNET(II) local station data link module Embedded in CPU module| 1 A1SJ71AP23Q 1
Extension base (for A1S Series module) N/A — | QA1S65B 1
Extension P<'3wer supply module N/A _ A1S61PN |
(for A1S Series module)

Extension cable N/A — | QCo6B 1

(Local station 3)
Product name

Existing module

Replacement module

Power supply module AB1P 1 Q61P 1
CPU module A2NCPU21 1 QO02UCPU 1
Main base unit A38B 1 Q38B 1
Input module AXOO — | QxXOoOo -
Output module AYOO — | QvyOO —
MELSECNET(II) local station data link module Embedded in CPU module| — | A1SJ71AP23Q 1
Extension base (for A1S Series module) N/A — | QA1S51B*1*2 1
Extension cable N/A — | QCo6B 1

*1: QA1S51B is an extension base that does not require a power supply, so if the extension cable is long, a voltage drop could
prevent the specified voltage from being supplied. Always calculate the voltage drop.

*2: QA1S51B only has an IN type extension connector, so it will be the extension final stage. QA60B (Large Type) extension base

cannot be connected below QA1S51B.

@ Local station data link module options

Model | Outline
A1SJ71AP23Q MELSECNET(II) local station data link module for Sl optical fiber cable
A1SJ71AR23Q MELSECNET(II) local station data link module for coaxial cable
A1SJ71AT23BQ MELSECNET/B local station data link module for shielded twisted pair cable

 Tip

1. Except for the local station replaced with the Q Series, modification to the system configuration and

programs are not required.

2. Minimal setup is required, as network parameter settings (excluding link refresh setting) are automatically
detected by the local station data link module. FROM/TO instructions within sequence program (refresh
program) are required to enable send/receive cyclic data.
A sample program to enable send/receive of cyclic data can be created by "A/QnA -> Q conversion
support tool" (which can be downloaded from the MELFANSweb). (Refer to Section 9.2)

3. If slots are left empty in the replacement Q Series CPU after connecting the A (Large Type) extension
base onto which the QA6LIB extension base unit or QA conversion adapter QA6ADP is connected, the
MELSECNET(II), /B local station data link module can be connected using the A-A1S conversion adapter.
QA1S60B or QA1S51B do not need to be additionally selected in this case.

e
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4.2 Replace one of A Series stations with Q Series while retaining MELSECNET(II)

4.2.2 Replace A Series master station with Q Series
The following is an example of replacing the A Series master station with Q Series.

@ Instructions
(1) Replace the CPU and other modules on the master station with Q Series while maintaining the existing
network.
(2) Since a Q Series station cannot be the master station, set Local station 1 as the master station, set the link
parameters, and change the station number of the rest of the local stations.
(3) Utilize the existing optical fiber cables.

(1) System configuration example

| Current configuration | Change to local station after replacing master station with QCPU
Master station —

Local station 3

Replace —

1/0O module
1/0O module

1/0O module

/O module
1/0O module
1/0 module

Power supply

module

A3ACPUP21

Empty
Empty

MELSECNET(II) (optical loop)

A1SJ71AP

MELSECNET(1I) (optical loop)

Local station 1 Master station

® [} [] e ] )
S ® o o S ® o ©
% o =] =S =] % o = =S =]
2,z | 8| 8| 8 2, 2| 8| 8|8
e} £ £ £ 55 € £ £
231 %ro5lolo 23/%1ololo
S| o = = = Q| o = = =
gg| £e| <

Local station 2 Local station 1

® ° o ° e e
> | - > | -
B 28|88 AN
SRR AR- A=l Nochange — 3, 8|8 B
35| O € € IS o3| O € £ €
58/ 5[ 2|2 ¢ $81 3[1 229
o < = = = g g = = =
(including optical fiber cables)

Local station 3 Local station 2

... ...

> | = > | =

Q | N | o | 0o | O Q | N | O | O | o
Q | o | 5| 3| 35 Q || S| 5|3
2,02 8| BB 3,2 B| B B
I HETHEHE
o X | = o Y X | £
IS e e ge| || = | =

Note: In MELSECNET(II) mode and MELSECNET(II) composite mode, only AnA, AnU, or QnA CPU can be used
for the master station.
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4.2 Replace one of A Series stations with Q Series while retaining MELSECNET(II)

® Module selection example

Product name Existing model Replacement model

Power supply module A61P 1 Q61P 1
CPU module A3ACPUP21 1 QO02HCPU 1
Main base unit A38B 1 Q38B 1
Input module AXO — | Qxo —
Output module AYO — | QyOo —
MELSECNET(II) local station data link module Embedded in CPU module 1 A1SJ71AP23Q 1
Extension base (for A1S Series module) N/A — QA1S65B 1
Extension Pc?wer supply module N/A . A1S61PN ]
(for A1S Series module)

Extension cable N/A - QCo6B 1

® Link parameter settings (MELSECNET(II) composite mode)

Send range (first half) | Send range (second half) Station No. | Send range (first half) |Send range (second half)

Station No.

Points Points Current—New| Points Points
M 256 000 | OFF | 256 500 | 5FF L1 > M| 256 100 1FF | 256 600 | 6FF
1ILA 256 100 1FF | 256 600 | 6FF IIL2 ->1IL1 | 256 200 | 2FF | 256 700 | 7FF
1IL2 256 200 | 2FF | 256 700 | 7FF L3 > L2 256 300 | 3FF - - -
L3 256 300 | 3FF - - - M ->IIL3| 256 000 | OFF | 256 500 | 5FF

Tip

1. The data link module was designed for local stations and cannot be set as master station. For this reason,
a local station that is upgraded to Q Series cannot become the master station. Instead, one of the existing
A Series local stations should be set as the master station. The station numbers should be changed
accordingly, but the I/O address and parameters can remain the same.

2. Minimal setup is required, as network parameter settings (excluding link refresh setting) are automatically
detected by the local station data link module. FROM/TO instructions within sequence program (refresh
program) are required to enable send/receive cyclic data.

A sample program to enable send/receive of cyclic data can be created by "A/QnA -> Q conversion
support tool" (which can be downloaded from the MELFANSweb). (Refer to Section 9.2)

3. For MELSECNET(II), the station numbers must be assigned in the connecting order starting from the new
master station.

4. The QA1S51B extension base without power supply module can be used for the local station data link
module mounting base.

Note that the voltage drop must be calculated if the extension cable is long.
T
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4.3 Replace MELSECNET containing a remote /O station with MELSECNET/H

4.3 Replace MELSECNET containing a remote I/O station with MELSECNET/H
Solution and Benefit

+ Although MELSECNET systems may be a combination of local and remote I/O stations, two
separate networks are necessary when upgrading to Q Series. However, if the existing system
contains only a few remote I/O stations, only one network is needed if remote I/O stations are
replaced with normal (local) stations without changing the cable layout or adding new wiring.

- Even when the remote I/O stations are replaced with the normal stations, it is not required to
modify the control (master) station's network related programs.

The following is an example of upgrading a MELSECNET(II) system to MELSECNET/H by replacing both local
and remote I/O stations with normal stations.

® Instructions

(1) Replace the MELSECNET(II) master station with the MELSECNET/H control station, and the
MELSECNET(II) local and remote 1/O stations with the MELSECNET/H normal stations to maintain a single
network configuration. (This is because the controller network and remote 1/0O network cannot reside on a
single network.)

(2) Add a simple transfer program between LX/LY (link side device) and X/Y (actual I/O device) for the normal
station replaced from the remote 1/O station. With this program, the normal station receives LY sent from

the control station by X and transfers it to actual output address Y; the normal station transfers input X to LY
so that the control station can receive it as X.

« MELSECNET(II): I/O signal transfer between master station and remote station
- Master station input (X) <- Remote station input (X)
- Master station output (Y) -> Remote station output (Y)

« MELSECNET/H: I/O signal transfer between control station and normal station
- Control station input (X) <- Normal station output (Y)
- Control station output (Y) -> Normal station input (X)

92



4.3 Replace MELSECNET containing a remote 1/O station with MELSECNET/H

(1) System configuration example

| Current configuration |

Master station
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| New configuration after replacement |

Control station (Station 5)

—_—
=
(=]
B = B
G2-k2d 11O 151 |se-ted1hLro
- (7] -
ainpow Oy ® <4 ainpow on
wwwwwwwwwww C O |
© o
sinpow /] =] | anpowon
““““““ S © |
anpow o/l | onpow o
< c 0
c Oo=
S | enpow on =0T einpow o
& » £
S = hao 2 = ndo
< [Hangoo m || Ngoo
£ £Ea
5] - d190 29 di9o
N N
o
o
]
8
ainpow Oy 2 |Se-ted1kro Se-led o
s
ainpow /] I ainpow o] ainpow O/l
\\\\\\\\\\\ - | |
L
ainpow Oy} nNu ainpow Oy ainpow Oy
““““““ O L
ainpow Oy ) ainpow Oy ainpow Oyl
- [aV]
WY c
=
Sg-ledTHIO S| anpow o S| ainpowon
) ) =0
HANL0D =|Hangoo = [Hangoo
€ IS
- d190 m- d190 Sl dioo
4 pd

93



4.3 Replace MELSECNET containing a remote /O station with MELSECNET/H

(2) Network parameter modification example
(1) Parameter settings for existing MELSECNET (II) master station

LBLW Setting
/R Trans range Transrange | Msta->Rsta | Msta<-Rsta
Station No. L L L L
Start End Start End Start End Start End
M [ O]-[ FFI|[ 0O]-[ FF]
[L]J|1 |[ 100]-[ 1FF]|[ 100]-[ 1FF]
[L]| 2 |[ 200]-[ 2FF] | [ 200]-[ 2FF]
[R]| 3 ( 1-t 170 1-I 1
[L]|4 |[ 300]-[ 3FF]|[ 300]-[ 3FF]
LXLY Setting
L/R M sta -> L/R sta M sta <- L/R sta
Station No. LY LX/LY L LX/LY
Start‘ End Start‘ End | Start | End | Start | End
M
wy+yc 1-c o=t I-rt e 1-r 1
w2t -t o 1-t rt 1-t 1 1-0 1
[R] |3 |[ 500]-[ 5FF] |[ 0]-[ FF]|[ 500]-[ 5FF]|[ O0]-[ FF]
w4 1-t 1o 1-t ro1-t 1 1-0 1
(2) Parameter settings for MELSECNET/H control station
B MELSECNET/Ethernet network parameter settings
Mdl. 1 Mdl. 2 Mdl. 3 Mdl. 4
Network type MNET/H mode(Ctr Sta)
Start 1/0 No. 0100
Network No. 1
Total stations 5
Group No. 0
StationNo. | e
Mode Online

Network range alloc.set.exist

No sta.inher.para.settings

Refresh para. settings exist

No interrupt settings
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4.3 Replace MELSECNET containing a remote 1/O station with MELSECNET/H

B Network range assignment

LB/LW Settings
Trans range Trans range Trans range Trans range .
Pairing
LB LW Low speed LB Low speed LW
Station No. Points| Start | End | Points| Start | End | Points| Start | End | Points| Start | End
1| 256 | 0100 | O1FF | 256 | 0100 | O1FF Disable
2| 256 | 0200 | O2FF | 256 | 0200 | 02FF Disable
3 Disable
4| 256 | 0300 | O3FF | 256 | 0300 | O3FF Disable
Master1 5| 16 | 0000 | OOOF | 256 | 0000 | OOFF Disable
LX/LY Settings (1)
Trans range (M -> L) Trans range (M <- L)
LY LX LX LY
Station No. Points| Start | End | Points| Start | End | Points| Start | End | Points| Start | End
1
2
3| 256 | 0500 | O5FF | 256 | 0500 | O5FF | 256 | 0500 | O5FF | 256 | 0500 | O5FF
4
Master1 5
B Refresh parameters
Link side PLC side
Points Start End Points Start End
SB Transfer 512 | SBO000 | SBO1FF | <--> 512 | SBO0O00 | SBO1FF
SW Transfer 512 | SW0000 | SWO1FF | <--> 512 | SW0000 | SWO1FF
Transfer 1 8192 | LBOO0OO | LB1FFF | <--> 8192 | BO B1FFF
Transfer 2 8192 | LW0O000 | LWIFFF | <-> 8192 | WO W1FFF
Transfer 3 256 | LX0500 | LXO5FF | <> 256 | X500 X5FF
Transfer 4 256 | LYO500 | LYOS5FF | <> 256 | Y500 Y5FF
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4.3 Replace MELSECNET containing a remote /O station with MELSECNET/H

(3) Parameter settings and link data transfer program for the normal station replaced from the remote 1/O station
B MELSECNET/Ethernet network parameter settings

Mdl. 1 Mdl. 2 Mdl. 3 Mdl. 4
Network type MNET/H mode(Nor Sta)
Start 1/0 No. 0100
Network No. 1
Total stations | -meeeeeee
Group No. 0
Station No. | = eeeeeeeee-
Mode Online

No sta.inher.para.settings

Refresh para. settings exist

No interrupt settings

W Refresh parameters

Link side PLC side
Points Start End Points Start End
SB Transfer 512 SB0000 | SBO1FF | <--> 512 SB0000 | SBO1FF
SW Transfer 512 | SW0000 | SWO1FF | <--> | 512 | SW0000 | SWO1FF
Transfer 1 256 LX0500 | LXO5FF | <--> 256 X500 X5FF
Transfer 2 256 | LY0500 | LYO5FF | <> | 256 | Y500 Y5FF

B Transfer program between link data (LX/LY) and actual I/O (X/Y)

SM400
0 1] [BMOV  Kkaxs00 K40 Ki6 |
Always ON Control Host
station station
receive output module
data start address
r
[BMOV  Kaxo KaY500 K16 |
Host Control
station station

input module  receive
start address data

9 [ END H
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4.4 Gradual replacement of MELSECNET/10 Remote I/O Net

4.4 Gradual replacement of MELSECNET/10 Remote I/O Net
(Utilize QJ72LP25-25(G), QJ72BR15 (MELSECNET/10 mode))

Solution and Benefit

Replace the remote I/O station only in a station unit to the Q Series remote I/O station while utilizing
the current AnU(S)CPU/QnA(S)CPU master station. This allows gradual replacement of the network
to the Q Series.

List of MELSECNET/H (MELSECNET/10 mode) remote I/O network modules
\‘ MELSECNET/10 remote MELSECNET/H (MELSECNET/10 mode) MELSECNET/H remote

(current system) (gradual replacement) (final replacement configuration)

Master station
CPU module AnU(S)CPU/QnA(S)CPU QCPU
Remote master A(1S)J71(Q)LP21 QJ72LP21
station module A(1S)(Q)BR11 QJ72BR11
QJ72LP25-25
Remote 1/0 A(18)J72(Q)LP25 )
. A(19)72(Q)LP25 e o | Qu72BRIS QJ72LP25-25
station (1S)J72(Q)LP25 QJ72LP25G QJ72BR15
work A(18)J72(Q)LP25G A(18)J72(Q)BR15
networ A(18)J72(Q)BR15 * Set mode switch to 8 QJ72LP25G
module * Set mode switch to 0
Mixing possible

Tip

* Replace the MELSECNET/10 mode master station CPU
» The Q Series master station cannot be connected to the A/AnS remote I/O station. When replacing the
current master station with the Q Series in the final stage, all remote 1/O stations must be Q Series stations.
* Replace the A Series special module with the Q Series intelligent function module
» The Q Series intelligent function module's buffer memory can be read/written using the current A/QnA Series
dedicated instructions.
» The sequence program must be revised as the number of occupied points, 1/0 signals and buffer memory
address may change.
* Replace master station CPU to Q Series in final step
(a) Using only 1/0 module
The network can be shifted to the MELSECNET/H remote 1/0 network by changing the mode switch
setting from 8 to 0. There is no need to change the program.
(b) Using the intelligent function module
* The network can be shifted to the MELSECNET/H remote 1/0O network by changing the mode switch
setting from 8 to 0.
* The Q Series intelligent function module's buffer memory read/write instructions must be changed to Q
Series link dedicated instructions. Refer to the "Q Series Compatible MELSECNET/H Remote 1/0
module reference Manual (MELSECNET/10 Mode Section)" for details on the dedicated instructions.
Note:
This replacement is intended for an existing MELSECNET/10 remote 1/0 network system.
Replacement from the MELSECNET (Il, Il mixed) or MELSECNET/B data link system is not supported.
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4.4 Gradual replacement of MELSECNET/10 Remote I/O Net

The method for gradually replacing the existing MELSECNET/10 remote I/O network to the Q Series is explained
below.

® Flow of replacement
(1) Replace the existing station 1 with the Q Series in Step 1.
(2) Replace a random station with the Q Series in Step 2.
(3) In the final step, replace the master station with the Q Series CPU, and shift to the MELSECNET/H remote
I/0O network.
At the same time, replace the stations remaining in the existing network as MELSECNET/10 remote 1/0
network modules to the Q Series.

(1) System configuration example
* Replacing only R1 station with Q Series
(Master station, R2, R3 not replaced)

Current configuration Transitional step 1
(]
Master station Master station
@ ® ® )
w2l n2l,2 w2l 2,2
ol - 3 > =] o — > > >
z 22 S¥SB[58 /58 3z 5858|5858
<0 |<Q|<O <Q|«<Q «Q
MELSECNET/10 remote I/O network (optical) MELSECNET/10 remote I/O network (optical)
R1 station R1 station
e
o o o IFEIFEIFE
— B4 -_— o ae) Ee) Ee)
NnS|asS|as - NH|=SES|=08|s 0
o N&’_g-c L3823 e IS |ZEZEZE
e |35 3E|3E|QE Replace %% c0lcolo0
Ol<0o|<0 <O N —

J iSet Mode to 8

|
|

R2 station R2 station
@ @
o o @ 2| o 2
nw| S| s | ws 0l 93 > >
NS IE£8 £8 28 No change : NS 282858
Cl<o|<0 <Q Cl<Qo|<Q|<Q

I
I

R3 station R83 station
® ®
Q2 2 Q wQ wQ wQ
nlas|oos|ns [Te) > S >
o NQ | QT | Q0T (Ol o] o NQ| Q9T | 2T |.QDT
— N~ S o | O0|= 0 - N~ S o|=0 |5 0
5 58 583858 No change z 5838|538 3¢
(@] g
<Q|<Q|«<Q <Q|<Q|«Q
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4.4 Gradual replacement of MELSECNET/10 Remote I/O Net

Replaced in
step 1

Replace

No change

* Replace R2 station with Q Series
(Master station, R3 not replaced)

| Transitional step 2 |

Master station

A61P
A3U
CPU
AJ71
LP21
A Series
1/0 module
A Series
1/0 module

A Series
1/0 module

MELSECNET/10 remote I/O network (optical)

R1 station

0 mQ wg tng
n.ﬁ‘}'.@%.g-gg-g
— n|lxs Ol 5 O 5 O
© | 2B EIBESE
g |Oa

J|0Q|oQ|cQ

AN

— J iSet Mode to 8

R2 station
I
o ﬁf}'.gg.gg 9-8
T o= = =
© 2B EISERE
g |Oa
JjoQlocQ|oQ
AN

J iSet Mode to 8
S ——

RS station
°®

(0] () ()
nl 2SS 9S | 935
o | 2T | 0T | 2D
~— I\D_ EO OL)O 0’30
2 2= SEIBE|IBE
Ol<Q|<Q |<Q

[l
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* Replace master station and R3
with Q Series (This completes
replacement of all stations with
Q Series)

| Transition completed |

Master station

S ] 2,2
o DA |-V |e3e3
2 89553888
€] oI OD_U) n

59% /0009

Replaced in
step 1

MELSECNET/10 remote I/O network (optical)

R1 station

mw%w%m%

T Ra£828£8

- o= 2 2

S 3B EBE|BE

Cl°Y50/colco
Jlc0Q|cQcQ
AN

Change Mode
from 8 to "0"

Replaced in
Step 2

Replace

]
)
[0y]
(e
o J W Change Mode

R2 station

Q61P
QJ72
|, LP25-25
I/O module
Q Series
1/O module
Q Series
I/O module

from 8 to "0"

R3 station
¢} m% m% m%
T Ra£828£8
= o= = =
g GRBERERE
Jlc0Q|cQ|cQ
AN

o J iSet Mode to 0




4.5 Replace MELSECNET/MINI(-S3) with CC-Link

4.5 Replace MELSECNET/MINI(-S3) with CC-Link
4.5.1 Replace A2CCPU with Q Series CPU and CC-Link (using A2C shape CC-Link 1/0 modules)

Solution and Benefit

+ A2C shape CC-Link remote I/O modules have been developed to replace MELSECNET/MINI(-S3)
systems with CC-Link. Wiring time is reduced because existing terminal blocks can be mounted
directly on the A2C shape CC-Link remote /O module by merely changing the communication
and power lines.

+ Since the mounting size is the same as that of A2C I/0 modules, the new modules can be

mounted using existing holes.

The following is an example of replacing an A2CCPU with a Q Series CPU and A2C 1/0O modules with A2C
shape CC-Link remote I/O modules.

@ Instructions
(1) Replace the A2CCPU with the building block type Q Series CPU and I/O modules with the A2C shape
CC-Link remote 1/0 modules while maintaining the distributed 1/0 system.
(2) Utilizing modules sold for upgrading reduces the external wiring man-hours.
(3) Change the communication cables with CC-Link dedicated cables, and rewire the power cables.

(1) System configuration example

- - X40 to 4F
| Current configuration | X00 to 1F Y20 to 3F Y50 to 5F
s AX41C AY13C e
2
Q
Q X60 to 6F
B XAO0 to BF Y80 to 9F Y70 to 7F
F AX41C AY13C e

| After replacement | Replace

ol |
(&) x > >
8 S g w w *1: Because the master module occupies 32 points, program modifications are needed.
g (Device numbers set for auto refresh in the network parameter setting)
Q33B
AJ65DBTB1-32D AJ65DBTB1-32D AJB5DBTB1-32DR
AJ65DBTB1-32R AJ65DBTB1-32R AJB5DBTB1-32DR

(2) Module selection example

Product name Existing module Replacement module
Power supply module N/A - | Q61P 1
CPU module A2CCPU 1 | QOOUCPU 1
Main base unit N/A - | Q33B 1
Master module N/A - | QJ61BT11N 1
Input module AX41C 2 | AJ65DBTB1-32D 2
Output module AY13C 2 | AJ65DBTB1-32R 2
I/0 combined module AX40Y10C 2 | AJ65DBTB1-32DR 2
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4.5 Replace MELSECNET/MINI(-S3) with CC-Link

A2C shape CC-Link remote 1/0 modules

CC-Link remote I/O modules are available in the same shape and size as some of the A2C 1/0O modules to

facilitate transition.

New mounting holes are unnecessary and existing wiring can be utilized with minor modifications.

Remove the wired

terminal block
from the existing
I/0 module.

M Model list

Model to be discontinued

After replacing the module,
mount the wired terminal block.*!

I

,:;f’ /[

>

1 / i

/
7

.:'II
)

=

/

*1: The communication lines
and power lines need to
be rewired.

Alternative model

Model Outline

AX41C AJBEDBTB1-32D T.ermmal block type, 24 V DC input, 32 points,
AX81C sink/source
AY51C AJB5DBTB1-32T1 Term|.nal bk.)ck type, 0.5 A transistor output,

32 points, sink
AX40Y50C AJ65DBTB1-32DT1 Terminal bl.ock type, 24 V DQ input, 16 pomts.,

0.5 A transistor output, 16 points, /0O composite module
AY13C AJ65DBTB1-32R Terminal block type, relay output, 32 points
AX40Y10C Terminal block type, 24 V DC input, sink/source shared,
AX80Y10C AJ6SDBTB1-32DR 16 points, relay output, 16 points, composite module

Tip —

» The A2C shape CC-Link remote I/O modules can also replace MELSECNET/MINI(-S3) systems consisting
of the AJ71PT32(-S3)/A1SJ71PT32(-S3) building block type master module with CC-Link.
In this case, program modification is not required.

+ For replacing compact type remote 1/0 modules with CC-Link modules, refer to "Section 2.6.3 Replace
MELSECNET/MINI compact type remote I/O modules with CC-Link".

« Also the CPU can be replaced with LCPU.
When it is replaced with L Series, the CC-Link master module LJ61BT11 or the built-in CC-Link function of

the LCPU will be used.

The CC-Link remote module can be connected to any of Q Series and L Series.
e
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4.5 Replace MELSECNET/MINI(-S3) with CC-Link

4.5.2 Replace MELSECNET/MINI(-S3) with CC-Link (using wiring conversion adapter)
Solution and Benefit

By selecting modules with equivalent specifications, existing external wiring can be utilized when
replacing MELSECNET/MINI(-S3) systems with CC-Link.

The following is an example of replacing a MELSECNET/MINI(-S3) system with CC-Link using a wiring
conversion adapter.

@ Instructions
(1) Remove the terminal blocks from existing MELSECNET/MINI(-S3) 1/0 modules, install them in the wiring
conversion adapters, and then mount them on the selected CC-Link remote 1/0 modules.
(2) Change the MELSECNET/MINI communication cables with CC-Link dedicated cables, and rewire
the power cables.

(1) System configuration example

| Current configuration |

A1SX42
A1SX42
A1SY42
A1SY41

AJ35TB1-16D
(16 points)

AJ35TB2-16D
(16 points)

AJ35TB1-16T
(16 points)

A1S61PN
A2SHCPU

7]
@
&
&
=
3
=
<

‘”Terminal block ‘ ‘ Terminal block ‘

Terminal block ‘ ‘
A1S35B

"
To power i !
supply, 1.
"
"

To /O

To 110

E MELSECNET/MINI ':
' (Twisted pair cable) "

CC-Link 1/0O module

Wiring conversion
adapter

After replacement |

® W

o}
i S Elg S 9T . j et Existing
o225 o o S MELSECNET/MINI
b dlg|l=x || = |x S terminal block

b=
A1S35B
Replace the link

module

CC-Link dedicated cable

AJ65BTB1-16D
(16 points)

AJ65BTB2-16D
(16 points)

AJ65BTB1-16T
(16 points)

| AsADP-1MC16D |
Terminal block

| AsADP-2MC16D |
Terminal block

| AsADP-1MC16T |
Terminal block

To power To power To power
supply, supply, » supply,
To 110 To 110 To I10

*1: Terminating resistor
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4.5 Replace MELSECNET/MINI(-S3) with CC-Link

® Module selection example

Product name Existing module Replacement module
MELSECNET/MINI(-S3) master module A1SJ71PT32-S3 1 N/A -
CC-Link master module N/A - A1SJ61BT11 1
Remote input module AJ35TB1-16D 1 AJ65BTB1-16D 1

AJ35TB2-16D 1 AJ65BTB2-16D 1
Remote output module AJ35TB1-16T 1 AJB65BTB1-16T 1
N/A - ABADP-1MC16D (for AJ65BTB1-16D) 1
Wiring conversion adapter (newly added) N/A - ABADP-2MC16D (for AJ65BTB2-16D) 1
N/A - ABADP-1MC16T (for AJ65BTB1-16T) 1

® Model list

Model to be discontinued Alternative model
Product = P
. . emarks (restrictions
name Alternative module Conversion adapter ( )
26-pin conversion adapter*’
| AJ35TB1-16D AJ65BTB1-16D AGKDP_-I MC16D P *1: The overall size is increased
mnggtule due to addition of the adapter
: ; 34-pin conversion adapter*! to the alternative module.
AJ35TB2-16D AJ65BTB2-16D ABADP-2MC16D *2: Additional wiring to CTL+
Outout T (External power supply
utpu 26-pin conversion adapter*" for output) is required.
AJ35TB1-16T AJ65BTB1-16T p q
module J35 6 J65 6 ABADP-1MC16T

 Tip

« MELSECNET/MINI occupies 8 points/station whereas CC-Link occupies 32 points/station. Therefore, except
for modules with a total of 32 points (occupying 4 stations), I/O numbers need to be changed and program
modifications are required. Refer to Section 7.5 for details.

» The communication cables must be changed to the CC-Link dedicated cables.

+ Specifications differ depending on the alternative model. Refer to "Transition from MELSECNET/MINI-S3,
A2C (I/0) to CC-Link Handbook" L(NA)08061ENG for details. .

+ Due to the wiring conversion adapter, the external dimensions /\

increased by 5.1 mm (height) and 28.5 mm (depth). Increased f’ epth

o | Depth of sticking
g@' out part
(terminal block)

Depth of CC-Link
e I/0 module

Increased height || T
: Mounting face

5.1 65

Unit: mm
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4.5 Replace MELSECNET/MINI(-S3) with CC-Link

4.5.3 Replace MELSECNET/MINI(-S3) remote 1/O station (building block type: AJ72PT35) with
MELSECNET/H using the existing external wiring

Solution and Benefit

+ MELSECNET/H (remote I/0 network) can utilize Q Series large type base unit. Wiring time can be
reduced by utilizing the external wiring of MELSECNET/MINI remote I/O station, which consists of
existing building block type I/O modules.

+ Program modification is not required because the number of occupied points are the same for
each I/0 module to be replaced. Therefore, programming time and debugging time after the

replacement is reduced.

@ Instructions
(1) Replace the existing MELSECNET/MINI(-S3) with MELSECNET/H (remote 1/O network).

Install new network cables: optical cable (loop) or coaxial cable (bus).
(Optical cables are used for the following example.)

(2) When the 1/0 module of the existing MELSECNET/MINI(-S3) remote I/O station is of terminal block type,
utilize the existing terminal block with the external wiring through a Q Series large type base unit and the
following products.

+ Q Series large type I/O modules
+ Q Series 1/0 modules + upgrade tool manufactured by Mitsubishi Electric Engineering Co., Ltd.

(3) In MELSECNET/H (remote I/0 network) network parameter, set the master station side devices to be the
same as the ones assigned to the existing MELSECNET/MINI in order to avoid program modification.

(1) System configuration example

| Current configuration | After replacement |

A35B MELSECNET/MINI master station k-3l Remote I/O network master station

Y = o ! ! - o | © 0 o | o
) | | o> S| 33| 3
& | 2| 2 2 0 82a (3|33 |3
> | 2| 32| 2 2 3 o |Go| 2 gl 21228
a o o e, &, © b '—\;LD !
o | Q| £ | E| E} EE S 3% 21228
92 2/2 229 ‘
: : MELSECNET/H remote
l MELSECNET/MIN 1/0 network (Optlcal |00p)
data link system - -
Y | Remote /O station: Station number 1 |
Station number: 1VNumber of occupied stations: | Q35BL [ QGe9L
A35B 16 (number of input/output points: 128) e - \QX41 \0Y41P
N
° Replace & 2z
o g | g
£ > S |8 = | 2|8 |F I8
el 9| || 3| 35| & X 5lz-lc-| E
IEIEIEIEIEEE B
t 1 1 1
Existing | | Existing | | Existing || Existing

H ' terminal| |terminal | |terminal | | terminal
block || block block block
Station number: 17 Number of occupied stations:
| Remote /O station: Station number 2

16 (number of input/output points: 128)
A32B Q338

Q61P I
QJ72LP25
-25

QXx42
QY42P
Empty

AJ72PT35
AX42

Existing Existing
connector | | connector

=
H
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4.5 Replace MELSECNET/MINI(-S3) with CC-Link

(2) Network parameter setting example

The following example shows the network parameter settings of MELSECNET/H (remote 1/O network) after
replacement in the case where the transmission devices of the existing MELSECNET/MINI(-S3) network were

X/Y100 to 1FF.

(1) Existing MELSECNET/MINI(-S3)
Auto refresh parameter

Setup common parameters and IO assignments.
Assignment method

"(" Paints/Start Monitoring time  [200 X 10ms
Total slave
(@ Start/End Ul Ig—

(3) Module selection example

(1) Master station
Product name

\ Existing module

(2) MELSECNET/H after replacement

Network parameter (common parameter)

MNET/H[Remote master)

v
0000
]

2

Replacement module

Power supply module A61P 1 Q61P 1

CPU module A2ACPU 1 QO02UCPU 1

Main base unit A35B 1 Q35B 1

Master module AJ71PT32-S3 1 QJ71LP21-25 1
*For MELSECNET/MINI(-S3) *For MELSECNET/H remote 1/0O network

(2) Remote 1/O station: Station number 1

Product name

\ Existing module

Replacement module

Power supply module A61P 1 Q61P 1
Main base unit A35B 1 Q35BL 1
. AJ72PT35 QJ72LP25-25
Data link/Network module *For MELSECNET/MINI(-S3) 1 | “For MELSECNET/H remote /O network | |
AX11 1 | axiiL 1
Qx4 1
Input module

AX41 1 | ERTN-AQTX41 1
QGesL 1
AY13 1 | aviaL 1
Y41P 1

Output module Q
AY41 1 | ERTN-AQTY41 1
1

QG69L
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4.5 Replace MELSECNET/MINI(-S3) with CC-Link

(3) Remote /O station: Station number 2

Product name \ Existing module \ Replacement module
Power supply module A61P 1 Q61P 1
Main base unit A32B 1 Q33B 1
Data link/Network module A;;z I\SI-E?_SSECN ET/MINI(-S3) 1 iDngl\l/TEPESEZSNET/H remote I/O network | |
Input module AX42 1 QX42 1
Output module AY42 1 | Qv4zep 1

Tip

* The installation of MELSECNET/MINI twisted pair cables needs to be modified according to the upgraded
network.

In the example, optical dual loop is selected to loop the network. When the distance between stations or
overall distance is short, a coaxial bus cable can be used to reduce cable installation time.

+ Some CPUs, such as Basic Model QCPUs (Q00J, Q00, Q01CPU), cannot be set as MELSECNET/H
(remote I/O network) master station.

For selecting CPU type, refer to "Q corresponding MELSECNET/H Network System Reference Manual
(Remote 1/0O network)" SH-080124.

+ If modules other than building type 1/0 modules, such as A2C I/O modules, are mixed in the existing
MELSECNET/MINI(-S3) system, the entire system cannot be upgraded to MELSECNET/H (remote 1/0
network).

In this case, consider separating the system into MELSECNET/H (remote 1/O network) and CC-Link.
(Replacement by dividing a network)
T
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4.6 Replace MELSEC-I/OLINK with CC-Link/LT, AnyWire DB A20

4.6 Replace MELSEC-I/OLINK with CC-Link/LT, AnyWire DB A20

Solution and Benefit

Replace the MELSEC-I/OLINK remote I/O station to the CC-Link/LT or AnyWire DB A20 to upgrade

the remote I/O system.

(1) Replacement configuration example

AJ51T64

Twisted pair cable and cab
tyre cable

-- Up to 16 stations can

be connected

AJ55TBOO-400

| Replacement to CC-Link/LT

CC-Link/LT master module ™

(General-purpose power)
24V DC

Terminating resistor

2]
Remote module

AJ55TBOO-800

AJ55TBOO-1600

|Replacement to AnyWire DB A20

AnyWire DB A20 master module

000000

=

[ et

108

Remote /0 module
for AnyWire DB A20 (input)*

Remote 1/0 module
for AnyWire DB A20 (output)*

AnyWire DB
A20

) (o | | (|
§
ISR

Terminator
or AnyWire DB A20 *

]
-

* AnyWire Corporation product



4.6 Replace MELSEC-I/OLINK with CC-Link/LT, AnyWire DB A20

(2) Comparison of replacement from MELSEC-I/OLINK to AnyWire DB A20 or CC-Link/LT

A comparison of the main functions when replacing MELSEC-I/OLINK to AnyWire DB A20 or CC-Link/LT is
shown below.

(: Compatible, X: Not compatible

Replacement to AnyWire DB A20 Replacement to CC-Link/LT
(MELSEC-Q Series/L Series compatible) (MELSEC-Q Series compatible)

Details Details

Existing I/OLINK external power supply can

External power supply @) X Power adapter must be installed

be used
Connection method O | T-shape branch, tree branch O | T-shape branch
Connection cable O | Existing I/OLINK cable can be used X | Cable must be newly laid
/0 modle type o 4-point, 8-point, 16-point o 2-point, 4-point, 8-point

Input module, output module, 1/0 module Input module, output module, I/0O module

Master module's XY address becomes 1/O
module's XY address

Address does not need to be changed (within
64 points)

Master module 32-points occupied
Programming X | /0 module address is device designated by O
FROM/TO instruction

 Tip

+ The I/0O module specifications differ when replacing MELSEC-I/OLINK with AnyWire DB A20 or CC-Link/LT.
Refer to the following guide and select the replacement I/O module.
» Transition from MELSEC-I/OLINK to AnyWire DB A20
"Transition from MELSEC-I/OLINK to AnyWire DB A20 Handbook: L (NA) 08063ENG"
P Transition from MELSEC-I/OLINK to CC-Link/LT
"Transition from MELSEC-I/OLINK to CC-Link/LT Handbook: L (NA)0O8062ENG"
+ If the I/O module specifications, etc., make it difficult to replace the MELSEC-I/OLINK with AnyWire DB A20
or CC-Link/LT, consider replacing with "CC-Link".
+ AnyWire products are not available in some countries. For details, please consult your local Mitsubishi
representative.
[
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5.1 Replace high-speed counter modules (AD61(S1)) with Q Series modules

5. Replacing with replacement dedicated modules

5.1 Replace high-speed counter modules (AD61(S1)) with Q Series modules

Solution and Benefit
Q Series replacement dedicated modules share the same input filtering system as, and therefore
can replace the A Series high-speed counter module AD61 or AD61S1 without restrictions from the
specifications of existing pulse generators (e.g. an encoder).

@ Instructions
Replace A (Large Type) high-speed counter modules with the following Q Series modules (replacement
dedicated module).
+ AD61 -> QD62-HO01
- AD61S1  -> QD62-H02

(1) System configuration example

| Current configuration |

=2 ° 1/0 signals
% % % % CPU module
Lo w| 8|88 Buffer memory read/write
23 ?j glg g g g y ACPU
[}
OCE | < | < | === Counting range
Pulse AD61(S1) 24-bit unsigned binary
Pulse generator (0 to 16,777,215)
Encoder [Counting speed ] .
(50/10/7 KPPS) o
External control signal Coincidence signal output (1 point)
Controller 9 > >
[Preset]
puse | RTT]
Pulse generator
Counting speed 7 —>
Encoder [(50/1 0/7 KPPS) ] CH2 Coincidence signal output (1 point)
External control signal
Controller >
[Preset] \
Replace Same input
filtering system
| After replacement
1/0 signals
CPU module
Buffer memory read/write
y QCPU (Q Mode)
QD62 Counting range
Pulse -HO01/02 | |32-bit signed binary
Pulse generator N (-2,147,483,648 to 2,147,483,647)
Encoder [Counting speed]
(50/10/7 KPPS) J| 5 N
External control signal % CH1 Coincidence signal output (2 points)
Controller = >
Preset ) [y
Counter function €3
selection 53 % N.____|
Pulse SE|O
Pulse generator g2
> D g
Counting speed || € = —
Encoder [(50/1 0/7 Kpps)] § § CH2 Coincidence signal output (2 points)
External control signa|
Controller
[ Preset ]

Counter function
selection




5.1 Replace high-speed counter modules (AD61(S1)) with Q Series modules

(2) Module wiring

The external wiring method is different between AD61/AD61S1 and QD62-H01/QD62-H02.
+ AD61, AD61S1: Use a terminal block
- QD62-H01, QD62-H02: Use a connector

The following are replacement methods in which existing wiring are preserved.

(a) Replacement using a conversion adapter manufactured by Mitsubishi Electric Engineering Co., Ltd.
The existing modules' terminal blocks and wiring can be utilized. For replacement details, refer to the
following section.

+ Section 2.2 Upgrade to Q Series using Q Series large type base unit and I/O modules
The existing modules' terminal blocks and wiring can be utilized.
For replacement details, refer to Item 2.1.2.
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5.1 Replace high-speed counter modules (AD61(S1)) with Q Series modules

(b) Replacement using a connector/terminal block converter module
This replacement method is suitable when the Q Series large type base unit and conversion adapter
manufactured by Mitsubishi Electric Engineering Co., Ltd. cannot be used due to system configuration and
installation location restrictions.
Connect the input/output wires, which include solderless terminals, from the existing module to the
connector/terminal block converter module using a dedicated cable. This connection is not restricted by
differences in wiring size.
The following shows the wiring configuration when using a connector/terminal block converter module.

Connector Terminal
Signal name terminal block side
number  |terminal number
Phase A pulse input 24 V A20 10
Phase A pulse input 12 V B20 0
1 Phase A pulse input 5 V A19 11
e ABCOM B19 1
FUNC.[] [ [FUSE
e Phase B pulse input 24 V A18 12
Phase B pulse input 12 V B18 2
Phase B pulse input 5 V A17 13
Preset input 24 V B17 3
CH1 | Presetinput 12V A16 14
Preset input 5 V B16 4
CTRLCOM A15 15
Function start input 24 V B15 5
Function start input 12 V Al14 16
apez-Hot Function start input 5 V B14 6
EQU 1
Cable (Coincidence output point No.1) A06 1E
< ACO5TB
AC10TB EQU 2 B0O6 E
AG20TB (Coincidence output point No.2) 0
AC30TB ;
AGEOTE Phase A pulse input 24 V A13 17
Connector/terminal block ﬁg?gg‘?B Phase A pulse input 12 V B13 7
converter module :
AGTBXY36 Phase A pulse input 5 V A12 18
ABCOM B12 8
1 Phase B pulse input 24 V A1 19
Ph Bpl 'pt12V B11 9
ase B pulse inpu
P00OOOOOO pEee TP
Phase B pulse input 5V A10 1A
L] l‘\‘l | L1 Proset input 24 V 810 A
) CH2 Preset input 12 V A09 1B
’ ‘ ‘ ‘ ‘ | | | | ‘ Preset input 5 V B09 B
|‘|‘|H|‘| CTRLCOM A08 1C
Function start input 24 V B08 C
Functi tart input 12 V AQ7 1D
unction start inpu
Function start input 5 V BO7 D
EQU 1
(Coincidence output point No.1) AD5 1F
EQU 2
(Coincidence output point No.2) BOS F
B02
12/24V BO1 24V
A02
oV AOT oV
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5.1 Replace high-speed counter modules (AD61(S1)) with Q Series modules

 Tip

+ The input filtering system and counting speed of replacement Q Series dedicated modules QD62-H01 and
QD62-H02 are the same as those of existing A (Large Type) high-speed counter modules AD61 and
AD61S1.

High-speed counter modules can be replaced without being restrained by the specifications of existing pulse
generators (e.g. an encoder).

- AD61/AD61S1 and QD62-H01/QD62-H02 have different counting ranges.

Modify the program in order to use the same counting range as that of the module before replacement.
« AD61, AD61S1: 0 to 16,777,215 (24-bit unsigned binary)
- QD62-HO1, QD62-H02: -2,147,483,648 to 2,147,483,647 (32-bit signed binary)

» The number of points occupied by the module changes from 32 t016 points, and thus the 1/0O signal
assignment (X/Y) also changes. Due to additional functions, the buffer memory addresses are changed and
program modification is necessary. Check the specification at "High-Speed Counter Module User's Manual':
SH-080036, and modify the program.
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5.1 Replace high-speed counter modules (AD61(S1)) with Q Series modules

(3) Comparison of specification between AD61 and QD62-H01

O: Compatible, 2A: Partial change required

QD62-H01 ‘ Compatibility ‘ Precautions for replacement
. . 32 points 16 points A *
Occupied /O points (/0 assignment: special 32 points) |(I/O assignment: Intelligent 16 points)
Number of channels 2 channel O
Counting speed Set "2" at the intelligent function
switch settings 50 KPPS © module switch setting.
Phase 1-phase input, 2-phase input O
Count
input Signal level 5VDC
signal (qlf,]A q)B)V 12VDC  2to5mA O
’ 24V DC
Counting | 1-phase input 50 KPPS 1-phase input 50 KPPS
speed O *2
(Max.) 2-phase input 50 KPPS 2-phase input 50 KPPS
On QD62-H01, as the value is used
Counting 24-bit unsigned binary 32-bit signed binary values A with 32-bit signed binary values
range (010 16,777,215) (-2,147,483,648 t0 2,147,483,647) chan N
» ge of sequence program is required.
©
§ Counter | Type UP/DOWN preset counter + ring counter function O
L=
2 Minimum 20 us
5 count pulse
» width
S (setinput rise O
= time to 5 ps or
2 less. Duty ratio: 10 ps | 10 ps
g 50%) (1, 2-phase input)
3 o
o Magnitude omparison hi . . _hit o .
8 | comparison | range 24-bit unsigned binary 32-bit signed binary values O
I
£ betueen Set value < count value
S |CPUand | gomparison
'S | AD61/ resul? Set value = count value O
0 QD62 HOT Set value > count value
Preset 12/24 V DC 3/6 mA 5/12/24 V DC 210 5 mA
5V DC5mA
External 0/24 V DC 3/6 mA On QD62-HO01, as the external
ian?t @ | Count disable 1 c m - VAN input specifications differ, confirm
5VDC5mA the external devices specifications.
Function start - 5/12/24 V DC 2to 5 mA
o Transistor Transistor (shinking type) output
External | Coincidence (open collector) output 2 points/channel O
output | output 12/24V DC 0.5 A 12/24V DC 0.5 A/l point 2 A/ 1 common
Internal current consumption
(5V DC) 03A 0.3A O
Weight 0.5 kg 0.11 kg O

*1: A program used before replacement can be utilized by setting the start I/O signal numbers of the modules mounted to the right

of the QD62-HO1 so that they can be the same as that of the module before replacement.

(Set the start number at "Start XY" of the I/0 assignment tab. The number of occupied points of the QD62-HO1 cannot be changed.)

*2: The rise/fall time of a pulse affects the counting speed. Countable counting speeds are as follows.
Counting a pulse greater than t = 50 ps may result in a miscount.

+ For the AD61 and QD62-HO1 (common for 1-phase input and 2-phase input)

t=5 ps: 50 KPPS
t=50 ps: 5 KPPS

-
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5.1 Replace high-speed counter modules (AD61(S1)) with Q Series modules

(4) Comparison of specification between AD61S1 and QD62-H02

O: Compatible, A: Partial change required

AD61S1 QD62-H02 ‘ Compatibility ‘ Precautions for replacement

32 points 16 points A -

Oceupied /O points (1/O assignment: special 32 points) | (I/O assignment: Intelligent 16 points)

Number of channels 2 channel O
Counting speed Set "2" at the intelligent function
switch settings 10KPPS © module switch setting.
Phase 1-phase input, 2-phase input O
Count
input Signal level 5VDC
signal (qISA (pB)V 12VDC  2to5mA O
’ 24V DC
Counting | 1-phaseinput | 10KPPS | 1-phaseinput | 10 KPPS
speed @) *2
(Max.) 2-phase input 7 KPPS 2-phase input 7 KPPS
. . . . o ) On QD62-H02, as the value is used
Counting 24-bit unsigned binary 32-bit signed binary values N with 32-bit signed binary values
range (0to 16,777,215) (-2,147,483,648 t0 2,147,483,647) chan o
» ge of sequence program is required.
[}
§ Counter | Type UP/DOWN preset counter + ring counter function O
S
2 Wl 100 ps 142 s
= count pulse
o width
S (setinput rise O
= time to 5 ps or
] less. Duty ratio: 50 ps | 50 s J1ps |71 us
g 50%) (1-phase input) (2-phase input)
[oX
0] q
o | Magnitude | Comparison i . . . .
8 | comparison | range 24-bit unsigned binary 32-bit signed binary values O
<
£ between Set value < count value
S |CPUaNd | & marison
'S | AD61S1/ | Set value = count value O
a | QDe2-Hoz | result

Set value > count value

Preset 12/24 V DC 3/6 mA 5/12/24 V DC 20 5 mA
5V DC5mA
External 2/24 V/ DC 3/6 mA On QD62-H02, as the external
inpjt a Count disable 1 c m - AN input specifications differ, confirm
5VDC5mA the external devices specifications.
Function start - 5/12/24 V DC 2 to 5 mA
o Transistor Transistor (shinking type) output
External | Coincidence (open collector) output 2 points/channel O
output | output 12/24 V DC 0.5 A 12/24V DC 0.5 A/t point 2 A/ common
Internal current consumption
(5V DC) 03A 0.3A O
Weight 0.5 kg 0.11 kg O

*1: A program used before replacement can be utilized by setting the start I/O signal numbers of the modules mounted to the right
of the QD62-H02 so that they can be the same with that of the module before replacement.
(Set the start number at "Start XY" of the I/O assignment tab. The number of occupied points of the QD62-H02 cannot be changed.)
*2: The rise/fall time of a pulse affects the counting speed. Countable counting speeds are as follows.
Counting a pulse whose rise/fall time is long may result in a miscount.
« For the AD61S1 and QD62-H02

Rise/fall time | 1-phase input ‘ 2-phase input

t=5us 10 KPPS 7 KPPS
t=500 us 500 PPS 250 PPS —'I L—
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5.2 Replace DC input modules with 6 mA rated input current (QX41-S2, QX81-S2)

5.2 Replace DC input modules with 6 mA rated input current (QX41-S2, QX81-S2)

Solution and Benefit
+ When replacing with the existing A Series module, the rated input current of the DC input module
becomes smaller.
In some cases, the previous Q Series DC input modules were not able to detect input signals from
the external devices due to current insufficiency.
Such issue can be solved by using DC input modules with 6 mA rated input current (QX41-S2 and
QX81-S2).
+ The pin arrangement is identical to the existing Q Series DC input module (connector type). The
existing external wiring can be utilized to reduce replacement time.

(1) Image of internal circuit when replacing existing A Series DC input module
The following figures use AX41 and AX42 as an example of how to replace the existing A Series DC input
modules (AX41, AX42, AX81, AX82, A1SX41 and A1SX81). The internal circuits show the rated input currents
and provide countermeasures for current insufficiency.
* AX41 and AX42 have different common wiring, but the rated input current specifications and the

countermeasure of installing an external resistor are the same.

Rated input current
AX41:10 mA
AX42: 7 mA

Proximity sensors AX41-AX42 Proximity sensors \/ QX41
I N A e I

Rated input current
QX41: Approx. 4 mA

24K G0

<

Main circuit

Main circuit
f{f- -\'.
s

()
:
| 934KQ
|
|
|
|
|
|

Repluce Wi'lh Measure to correct the rated
input current insufficiency
0X41-52 .

Rated input current
adjusted in accordance
with the connected device

Rated input current
QX41-S2: Approx. 6 mA

Proximity sensors QX41-S2 Proximity sensors
e w 1 xoo : :
N — — {0 =) | I
| \:- | | |
- : I I

=] ] | T ZaekQ I
el WY e l

G | I |
: £ |} .II | ! : rr/T + \ : :

© I _ ]
H= Aoy : \ /i :

I
| L 1 — | |
[ () ) ! |
L _{TJ__, COMT ! i
bo—-—-——-—=/24vDC "~~~ —
External resistor not required External resistor required (for input current adjustment)

116



5.2 Replace DC input modules with 6 mA rated input current (QX41-S2, QX81-S2)

(2) Specification comparison

(1) Specification comparison of QX41-S2 input module (positive common (sink) type)

Q Series A (Large Type) Series A (Small Type) Series
QX41-S2 A1SX41

Number of input points 32 32 32 64 32
Rated input voltage 20.4t028.8VDC 10.2t0 26.4 V DC 10.2t0 26.4 V DC
Rated input | 24 V. DC| Approx. 6 mA Approx. 4 mA Approx. 10 mA Approx. 7 mA Approx. 7 mA
current 12V DC (N/A) (N/A) Approx. 4 mA Approx. 3 mA Approx. 3 mA
Input resistance Approx. 3.6 kQ Approx. 5.6 kQ Approx. 2.4 kQ Approx. 3.4 kQ Approx. 3.3 kQ
g)ﬁ;rgg;;rtmlnal 32 points / common 8 points / common | 32 points / common |32 points / common
oo e noicomecr | (0TS0l 44 comecor

(2) Specification comparison of QX81-S2 input module (negative common (source) type)

Q Series A (Large Type) Series A (Small Type) Series
QX81-S2 A1SX81

Number of input points 32 32 32 64 32
Rated input voltage 20.4t028.8V DC 10.2t026.4V DC 10.21t0 26.4 V DC
Rated input | 24 V. DC |  Approx. 6 mA Approx. 4 mA Approx. 10 mA Approx. 7 mA Approx. 7 mA
current 12V DC (N/A) (N/A) Approx. 4 mA Approx. 3 mA Approx. 3 mA
Input resistance Approx. 3.6 kQ | Approx. 5.6 kQ Approx. 2.4 kQ Approx. 3.4 kQ Approx. 3.3 kQ
Common terminal )
arrangement 32 points / common 8 points / common 32 points / common |32 points / common

. : 38-point . ;
51)23:23 | connecton D-sut??:opr::ector term(ilr\}% El%cgcc;g;\vr;)ector D-sub fo7n2:.:ctor x 2 D-SUSZ:opr:r:\ector

 Tip —

+ The pin arrangement of the A Series connector type DC input module is the same as the Q Series. Since the
current module connector’s wiring can be used, the replacement can be completed just by switching the
modules.

Note that when using negative common (source) type modules, the A Series DC input module and the
connector are reversed. However, connectors of the existing module can be utilized.

+ QX41-S2 and QX81-S2 can also be used when Q large type base unit is used in combination with the
upgrade tool manufactured by Mitsubishi Electric Engineering Co., Ltd. to connect the existing input module

AX41/AX81's terminal block with the external wiring.
e
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5.3 Replace analog output positioning module (AD70/A1SD70) with Q Series

5.3 Replace analog output positioning module (AD70/A1SD70) with Q Series

Solution and Benefit
Improve functionality of A Series analog output positioning module AD70, A1SD70 (upward
compatibility)

Use the Q Series module positioning unit to replace without concern of the effect onto the machine
system.

@ Instructions
The existing analog output positioning module AD70/A1SD70 is replaced with the Q Series QD73A1.

(1) System configuration example

Existing A Large Type Series Existing A Small Type Series Q Series after replacement
| |
ASmall | | )
Alarge Q Q Series
Type | AD70 A Large Type Type | AT 31070 SASmaII TS;PT cPU QD7:3A1 i
Series module CPU I eries module i
CPU ! |
CPU module Positioning module AD70, A1SD70, QD73A1 Drive module Servo motor
Command pulse Analog | Speed
Electronic| FUL |Deflection D/A voltage mshtrucnon Servo o M
gears counter converter - amplifier B
Sequence Setting Lg — T
program c;t) data
Interface
Current Multiplication
value
T Feedback pulse
i 1 Junun il
Data read/write o {PLG

Parameter data Feedback pulse

Positioning data L

Zero return parameters

The feedback pulse train from the pulse generator (PLG) can pass
through the drive unit (as shown with *1), or directly output to QD73A1
(as shown with *2). The route depends on the servo motor being used.
Refer to the manual for the servo motor and drive module being used
for information on selecting method *1 or *2.

(2) Wiring for external device connection
The existing AD70/A1SD70 external device connection connectors can be used, so there is no need to
change the wiring.
However, the connector orientation will be reversed when replacing the A1SD70.

The existing AD70/A1SD70 required an external 15 V DC + current power supply, but the QD73A1 does not
need an external power supply.

118



5.3 Replace analog output positioning module (AD70/A1SD70) with Q Series

(O: Compatible, A: Partial change required
Precautions for

X: Not compatible

replacement

No. of control axes 1 axis O
- Capacity 1 data O
Positioning data -
Setting method Follows sequence program O
Mode Position control mode (positioning, 2-speed trapezoid positioning) o
Speed/position control changeover mode
Position control mode: absolute method/incremental method
Method ” . O
Speed/position control changeover mode: incremental method
Position -2147483648 to 2147483647 (pulse) o
instruction (with 32-bit sign)
Speed 1 to 400,000 1 to 4,000,000 o Specifications are enhanced.
instruction (pulse/s) (pulse/s) (Upward compatibility)
Acceleration/
. Automatic trapezoid acceleration/deceleration O
- deceleration
Positioning Adtomati
omatic
acL:Jcelrgraltion / Acceleration time: 2 to 9999 ms o
. Deceleration time: 2 to 9999 ms
deceleration
In-position Specifications are enhanced.
P 1 to 2047 pulse 1 to 20479 pulse O P o
range (Upward compatibility)
Backlash
ackias ) None O
compensation
Error
compensation None O
function
Speed instruction output 0 to +10 V DC (setting range: +5 V to +10 V) O
Open collector:
Open collector: 100 kpulse/s 200 kpulse/s T
ficati h. .
Pulse frequency TTL: 100 kpulse/s TTL: 200 kpulse/s O (SS e;:;aclzr: Z:Z;: )anced
Positioning Differential output: 100 kpulse/s Differential output: P P ¥
feedback pulse 1 Mpulse/s
input Connected
P Open collector, TTL, differential output O
encoder type
Multiplication . .
setting Number of feedback pulse inputs can be multiplied to 4, 2, 1 or 1/2 O

Setting method changes

from hardware switch to CPU
Zero return control Provided (two types) O module parameters.

The setting method is different,
but the functions are the same.

JOG operation Provided @)
Absolute method:
. 1.2ms”
Absolute method: 4.4 ms ™ .
“ Incremental method: 1.2 ms
Incremental method: 4.5 ms ] e
N . JOG operation: 1.2 ms Specifications are enhanced.
Starting time JOG operation: 4.3 ms ) O o
. Zero return (near-point dog (Upward compatibility)
Zero return (near-point dog type): 4.4 ms type): 1.2 ms
Zero point return (count type): 5.1 ms yp, -
Zero point return (count
type): 1.2 ms
M function None O
The 5 V DC internal current
Internal current consumption 5VDC 03A 5VDC 052A X consumption must be re-
calculated.
External supply voltage, +15VDC 0.2A . O External power supply in not
current terminal block -15VDC 0.02A required.
48 points 48 points
32 points (No. of I/O slots: 2 slots (No. of I/O slots: 2 slots
(No. of I/O slots: 1 slot occupied) occupied)
Number of occupied I/0 points occupied) (/O assignment: first 16 (/0 assignment: first 16 O
(/0 assignment: 32 points points for open slot points for open slot
for special function module) | Last 32 points for special | Last 32 points for intelligent
function module) function module)
Weight 0.4 kg 0.20 kg O

*1: When using the 2-speed trapezoid with AD70/A1SD70, the starting time is 0.2 ms longer. When using the 2-speed trapezoid with QD73A1,
the starting time does not increase.
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5.3 Replace analog output positioning module (AD70/A1SD70) with Q Series

Tip

* The following points must be observed when making a replacement.

A1SD70 QD73A1 Precautions
No. of occupied slots 1 slot 2 slots *1
48 points 48 points
No. of occupied /0 . 32 p0|.nts . (/0 assignment: first 16 points | (/O assignment: first 16 points .
oints (/0 assignment: 32 points for for open slot for open slot 2
P special function module) Last 32 points for special Last 32 points for intelligent
function module) function module)

» Some address will change.

Buffer memory address |, New items have been added with the revised specifications. 8
Follows CPU module
Mode setting « Follows hardware switch settings. " para_meter Sf ttm?S' . *4
I/0 assignment" -> "switch
setting"
LED display « LED display items have changed. *5
External wiring « Current connector can be used without modifying wiring. *6

*1: Modules occupying two slots cannot be mounted on the Q Series large base unit.
When selecting a Q Series large base to replace modules currently mounted on the same base, the modules must be split
into two bases by adding an extension base.
*2: If the first half of the slots are set to "open 0 points" when replacing the existing A1SD70, set the parameter I/O assignment
setting as shown below so that the QD73A1 address does not change after replacement.
(1) Set first half slots to "open 0 points"
(2) Set last half slots to same address as existing A1SD70 using the head XY setting
When replacing the existing AD70, set the first half slots to "open 0 points".
*3: The program must be revised and added. Refer to the QD731A Positioning Module User's Guide (Details Section).
*4: The mode setting required for positioning changes from hardware switch to parameter 1/0 assignment switch settings.
Refer to the QD731A Positioning Module User's Guide (Details Section) and set the switches to the same as the A1SD70.
*5: Each of the LED display items can be confirmed with the QD83A1 /0 signals. If necessary, prepare external lamps, etc., to
correspond to the LED displays, and display the 1/O input signal ON/OFF status for each item.
*6: The base dimensions for mounting QD73A1 are different, so the module mounting position will change.
The connector orientation will be reversed when replacing A1SD70.
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6.1 Use AnS (Small Type) modules as spare parts for existing A (Large Type) Series modules

6. Replacement utilizing spare part

6.1 Use AnS (Small Type) modules as spare parts for existing A (Large Type) Series
modules

Production of the AnS/QnAS (Small Type) Series and MELSEC-I/OLINK is scheduled to be discontinued on
Notice September 30, 2014.
Refer to Technical News "No. FA-D-0142" for details regarding the production discontinuation.

A-A1S module conversion adapter
It allow the use of AnS (Small type) module that A-A1S module conversion adapter with AnS (Small Type)

module is mounted on the base unit when A (Large Type) Series spare parts are not available.

A (Large Type) main/extension base unit,
QAB0OB extension base unit

A-A1S module conversion adapter (A1ADP-0)

Al

AnS (Small Type) Series 1/0, special function modules, etc.

Model list
Model | Outline
A1ADP-XY For mounting 1/0 modules
A1ADP-SP For mounting special function modules
Notes:

 Up to three adapters per base unit can be used.

« The A-A1S module conversion adapter can also be used with the QAB0B extension base unit, refer to
"Transition from MELSEC-A/QnA (Large Type) Series to Q Series Handbook (Fundamentals)"
L(NA)O0B043ENG or "A-A1S Module Conversion Adapter User's Manual" IB-0800352.

- Specifications differ between the A/QnA and AnS Series modules.

For a comparison of the specifications, refer to "Transition from MELSEC-A/QnA Large Type Series to
AnS/Q2AS Small Type Series Handbook" L(NA)08064ENG.
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6.1 Use AnS (Small Type) modules as spare parts for existing A (Large Type) Series modules

6.1.1 Use AnS (Small Type) I/0 modules as spare parts for A (Large Type) input/output modules

Solution and Benefit

« If the A (Large Type) I/O module malfunctions but replacement is not available, the AnS (Small
Type) /0O module can be installed and used as a spare part, allowing the system to recover
quickly.

« If the A (Large Type) I/O module is not available when the system requires an additional /O

module, the AnS (Small Type) I/O module can be installed and used as a spare part.

(1) System configuration example

| Current configuration | Module to be replaced

e ) )

2
o o = | o - | = 2
“lo|lslslT | T &
& |22z = &

<
A35B

Replace
After replacement |

A3ACPU

%y
o
o+é
Iz
<

A61P

A-A1S module
conversion adapter

A1SX42

A35B
Connector connection
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6.1 Use AnS (Small Type) modules as spare parts for existing A (Large Type) Series modules

(2) Module selection example

Product name \ Existing module \ Replacement module

Power supply module A61P 1 Utilize existing module -
CPU module A3ACPU 1 Utilize existing module -
Main base unit A35B 1 Utilize existing module -

AX41 1 Utilize existing module -
Input module

AX42 1 A1SX42 1
A-A1S module conversion adapter (for A1S) | N/A - A1ADP-XY 1
Output module AY41 2 Utilize existing module -

Tip

+ Replacement is simple because the A1SX42 (AnS (Small Type) module) has the same connector pin
arrangement as the AX42 (A (Large Type) module). Reconnect the external wire connectors after replacing
the modules.

+ Some of the specifications (rated input current etc.) differ between the AX42 and the A1SX42.

Refer to "Transition from MELSEC-A/QnA Large Type Series to AnS/Q2AS Small Type Series Handbook"
L(NA)OB064ENG for details.
T
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6.1 Use AnS (Small Type) modules as spare parts for existing A (Large Type) Series modules

6.1.2 Use AnS (Small Type) module as spare parts for A (Large Type) computer link module

Solution and Benefit

« If the computer link module malfunctions but A (Large Type) Series spare parts are not available,
the AnS (Small Type) computer link module can be installed on the A1ADP adapter and used as a
replacement, allowing the system to recover quickly.

+ If the A (Large Type) computer link module is not available when the system requires an

additional module, the AnS (Small Type) computer link module can be installed on the A1ADP

adapter and used as a spare part.

The following is an example of replacing an A (Large Type) computer link module with AnS (Small Type)
computer link modules using the A-A1S module conversion adapter.

® Instructions

(1) The A (Large Type) computer link modules have two channels (RS232C and RS422), whereas the AnS
Series computer link modules only have one. Therefore, if two channels are used, two modules are

needed.

(2) A program modification is not required if:
+ The AnS module set to the No-protocol mode is mounted on the same slot as the existing module.
+ The AnS module set to the Dedicated protocol mode is mounted on the empty slot.
(This is because the No-protocol mode requires a transmission program but the Dedicated protocol

mode does not.)

(1) System configuration example

| Current configuration |

Module to be replaced |

Empty

&
el = | =
Sl | | &
cEl2 2z
<

° ° L]
]
: B
@ <
e
A35B

After replacement |

AB1P
A3ACPU
A1ADP-SP
+
A1SJ71UC24-R4

A1ADP-SP
+
A1SJ71UC24-R4

A35B

No-protocol
mode

Channel set to

Channel set to
Dedicated protocol
mode
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(1) Computer link module options

Model
A1SJ71UC24-R2

Outline
RS232C: 1 channel

A1SJ71UC24-R4

RS422/485: 1 channel

2-channel
module

—

Ataopsp @

o o

A-A1S
conversion
adapter

A-A1S
conversion
adapter

1-channel
module

A1SJ71UC24-R2 or
A1SJ71UC24-R4

set to No-protocol mode

(Mount this module on the same
slot as the existing module
(AJ71UC24))

_| 1-channel
module

A1SJ71UC24-R2 or
A1SJ71UC24-R4

set to Dedicated protocol mode
(Mount this module on the empty slot)



6.1 Use AnS (Small Type) modules as spare parts for existing A (Large Type) Series modules

® Module selection example (when two channels are used)

Existing module Replacement module

Product name

Power supply module A61P 1 Utilize existing module -
CPU module A3ACPU 1 Utilize existing module -
Main base unit A35B 1 Utilize existing module -
Input module AX41 2 Utilize existing module -
A-A1S module conversion adapter (for A1S) | N/A - A1ADP-SP 2

A1SJ71UC24-R2 1
Computer link module AJ71UC24 1

A1SJ71UC24-R4 1
Output module AY41 1 Utilize existing module -

 Tip

* The AJ71UC24 and A1SJ71UC24-R2/A1SJ71UC24-R4 have the same buffer memory address and
transmission X/Y address assignment for the No-protocol mode.

Therefore, it is not required to modify the program if the module set to the No-protocol mode is mounted on
the same slot as the existing module.

» The module set to the Dedicated protocol mode does not require a programmable controller program. Also,
the external device connected to this module can communicate regardless of its slot address-changing the
address does not affect communication.

However, when the "On-demand function" is used, it is required to modify the program due to changes in the
designated address for the "TO instruction" and handshake X/Y address.

T
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6.2 Use Q Series modules with AnS/QnAS Series utilizing AnS-Q module conversion adapter

6.2 Use Q Series modules with AnS/QnAS Series utilizing AnS-Q module conversion
adapter

Solution and Benefit

In case of a failure of AnS (Small Type) module, even if a spare of the module is not available, the
repair work can be completed quickly by replacing only the defective module with an equivalent Q
Series module.

® Example of configuration with AnS-Q module conversion adapter

~Failure

AnS-Q module conversion

AnS-Q module conversion adapter (base)

adapter (body)

Q Series ~~
extension cable

Q Series module
to be newly mounted

(1) Model list
Product name | Model

AnS-Q conversion module adapter Body A1SADP-Q
A1SADP-Q SET1
(Set of body and 1-slot base) Base A1SADP-Q51B
AnS-Q conversion module adapter Body A1SADP-Q
A1SADP-Q SET2
(Set of body and 2-slot base) Base A1SADP-Q52B
Q Series extension cable QCO05B, QC06B, QC12B, QC30B

 Tip

1. The existing AnS module and the newly mounted Q Series module may differ in part of the specifications
or may not be program compatible. Reconfirm the specifications, or reexamine the program.

2. When an existing AnS module is replaced with a Q Series module, the existing wiring of the AnS module
can be used by using a conversion adapter manufactured by MEE. However, conversion adapters with
fixing mounts cannot be used.

For details, refer to "Transition from MELSEC-AnS/QnAS (Small Type) Series to Q Series Handbook
(Fundamentals)."
e
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7.1 Replace instructions with different QCPU instruction format (excluding AnACPU/AnUCPU dedicated instructions)

7. Precautions for utilizing ACPU programs in QCPU

Pay attention to the following points when executing "Change PLC type" and utilizing the ACPU program with the
QCPU.
+ The instruction format will change, so the instructions may be switched to a different type when the PLC type
is changed.
Instructions that use an accumulator (A0, A1) with the ACPU do not describe the device name or device No.
in the instruction format. However, these are described in the instruction format with the QCPU instruction.
* The instruction specifications will differ, so the program must be corrected.
* There are replacement candidate instructions when executing "Change PLC type", but these will be switched
to "SM1255" as instructions that cannot be replaced because of a difference in specifications.
There are several inquires for explaining the specifications of the replacement instructions and for revising the
program after replacement.
Matters frequently asked questions when utilizing the QCPU program with the QCPU are explained as precautions.

@ Peripheral devices using existing A (Large Type) and A0J2 Series CPU program
The following CPU types are incompatible with GX Developer, so the PLC type must be changed to GX
Developer compatible CPU types with the following instructions before the programs can be used.
» CPUs not compatible with GX Developer

AnCPU (including those with link function)
A3HCPU (including those with link function)
A3MCPU (including those with link function)
A0J2CPU (including those with link function)
A52GCPU, A3BVCPU, A73CPU

The CPU types incompatible with GX Developer can be changed to those compatible with GX Developer through

"Change PLC type" by using the A/QnA -> Q conversion support tool.
Refer to Section 9.1 for the PLC type change operation by using the A/QnA -> Q conversion support tool.
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7.1 Replace instructions with different QCPU instruction format (excluding AnACPU/AnUCPU dedicated instructions)

7.1 Replace instructions with different QCPU instruction format
(excluding AnACPU/AnUCPU dedicated instructions)

7.1.1 Instructions that use accumulators (A0, A1)
Some QCPU operation processing instructions are different from their corresponding ACPU instructions in

format.
This section explains the instructions that have different specified formats.

Frequently asked questions regarding the conversion of ACPU to QCPU program

(Inquiry example)
1. Instructions with different format from that of ACPU instructions are used when
upgrading to QCPU. Is further program modification necessary?

2. The devices "SD718 and SD719", which were not used in ACPU, are automatically part
of the QCPU instructions after replacement. What are these devices for? Is operation
affected by these devices?

3. "Change PLC type" executes a direct conversion of several ACPU instructions, such as
assignment and saving of operation data, but the instruction format remains similar to
that of ACPU instructions. Is it possible to further simplify the QCPU instructions using a
similar method?

(Answer)
ACPU instructions that use accumulators (A0 and A1) have different formats when
converted to QCPU instructions. These accumulators are replaced by devices SD718 and
SD719.
Therefore, the same operation as in ACPU is executed even if the instruction format is
different and SD718 and SD719 are used.
In addition, a group of multiple instructions, such as instructions to transfer data to the
ACPU accumulators (A0 and A1), can be converted to QCPU instructions and further
modified to simplify the program and reduce the number of steps.

(1) Instructions that use accumulators (A0 and A1)
(1) ACPU
Instructions that use accumulators (A0 and A1) can execute operations without explicitly specifying AO and
A1 as the source and destination device. Also, the operation result is stored in the accumulators A0 and
A1 without specifying the device in which it is stored in.
(2) QCPU
QCPU instructions need to specify a source and destination device.
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7.1 Replace instructions with different QCPU instruction format (excluding AnACPU/AnUCPU dedicated instructions)

(2) ACPU to QCPU instruction replacement
Replacing ACPU program with QCPU program using "Change PLC type" converts ACPU instructions into
QCPU instructions. Therefore, even if the accumulators A0 and A1 are not explicitly specified in the ACPU
program, the devices SD718 and SD719 will automatically take over the accumulators' functionalities in the
QCPU program.
However, if A0 and A1 are explicitly described in the ACPU program, the devices SD718 and SD719 will
directly replace the accumulators.
The program converted through "Change PLC type" will execute normally and modifications are not necessary.

(3) Changing to QCPU instruction format
The automatically converted programs will execute without problems. However, modifying the instructions into
QCPU format will significantly simplify the program and reduce the number of steps.

(4) List of instructions that use accumulators (AO and A1)

Funct QCPU/QnACPU AnUCPU/AnACPU/AnNCPU
unction
Format of instructions Remarks Format of instructions Remarks
[ROR[D[n] . D: Rotation data [ROR[n] " Hoation data s set
Right rotation of Rotation data is set
. . - Rotation data is se
16-bit data  D: Rotation data .
[RCR[D|n| in A0.*!
* Use SM700 for carry flag + Use M9012 for carry flag.
- Rotation data is set
[ROL[D|n] * D: Rotation data in AD.*
Left rotation of Rot t-' data i t
16-bit data - D: Rotation data s nolation dafa is se
|[RCL[D|n] in A0.*!
* Use SM700 for carry flag - Use M9012 for carry flag.
. . + Rotation data is set
DROR|D]|n] - D: Rotation data DROR]|n] 1 AD. A 2
Right rotation of Rot t,' d ta is set
. . * Rotation data is se
32-bit data + D: Rotation data .
DRCR|D|n] DRCR|n] in AO, A1.*2
* Use SM700 for carry flag + Use M9012 for carry flag.
.  Rotation data is set
DROL [D|n] - D: Rotation data DROL | n] T AD. Aq 2
Left rotation of - : i
30.bit data * D: Rotation data * Rotation data is set
DRCL [D[n]| « Use SM700 for carry flag DRCL |n] in AQ, A1.*2
* Use M9012 for carry flag.
16-bit data ~SER [si[s2lDln] . Search result i_s stored ~SER [sils2ln] . Search result is stored
search in D, D +1 device in AO, A1.
32-bit data DSER [s1[s2/D]n] . search result is stored DSER[S1[s2ln] . search result is stored
search in D, D +1device in AO, A1.
16-bit data -‘| » Check result is stored » Check result is stored
(SUM| SUM]
checks sum[s|D] in D device S in AO.
32-bit data DSUM[S[D] . Qheck re_sult is stored DSUM . Qheck result is stored
checks in D device in AO.

*1 Rotation result is stored in AO.
*2 Rotation result is stored in A0 and A1.
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7.1 Replace instructions with different QCPU instruction format (excluding AnACPU/AnUCPU dedicated instructions)

(5) Program replacement example
(1) Right rotation of 16-bit data instruction (ROR)

| ACPU program |

X0 * (Transfer the rotation data to AQO)

o— | [ MovP D0 A0
Instruction Rotation
execution execution
condition device

* (Execute the rotation)
[ RORP K3
* (Transfer the rotation result)
[ MovP A0 DO
Rotation
execution
device
MS?OI1 2 -~
" \N(ID%eck Carr
C fl y
aryag ON/OFF
16 [END
| Replacement QCPU program |
X0 (Transfer the rotation data)

0 | | [ MovP DO SD718
Instruction Rotation ACPU [AO]
execution execution converted
condition device to special D

(Execute the rotation)
[ RORP SD718 K3
ACPU [A0]
converted
to special D
(Transfer the rotation result)
[ MovP SD718 DO
ACPU [A0] Rotation
converted execution
to special D device
r f
Carry flag eck Carry
(ACPU'M9012) ON/OFF
51 [END
| Equivalent QCPU program in instruction format |
Execute rotation of and store the result in the specified device.
X0

o— | [ RORP DO K3
Instruction Rotation
execution execution
condition SM700 device

I (Mo
" ~ Check Carry
Carry flag
(ACPUM9012) ON/OFF
39 [END
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7.1 Replace instructions with different QCPU instruction format (excluding AnACPU/AnUCPU dedicated instructions)

(2) Search instruction (SER)

| ACPU program |

* Execute the search instruction: store the result in the accumulators (A0, A1).

X1
0 | | [ SERP D10 D100 K10
Instruction Search data Head device of
execution storage device  searched data
condition
* (Search result: transfer location first matched location)
[ MmovP A0 DO
First matched
location
* (Search result: transfer the number of matched data)
[ MovP A1 D1
Number of
matches
20 [END

| Replacement QCPU program |

* Execute the search instruction: store the result in SD718 and SD719, which are replacement for AQ and A1.

X1
0 | | [ SERP D10 D100 SD718 K10
Instruction Search data Head device of  First matched
execution storage device  searched data location found
condition
(Transfer the first matched location found)
[ MmovP SD718 DO
First matched First matched
location found  location
(Transfer the number of matched data)
[ movP SD719 D1
Number of Number of
matched data matches
77 [END
| Equivalent QCPU program in instruction format |
* Execute the search instruction: store the result in the specified devices (DO, D1).
X1
0 |} [ SERP D10 D100 DO K10
Instruction Search data Head device of  First matched
execution storage device  searched data location
condition -
34  END
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7.1 Replace instructions with different QCPU instruction format (excluding AnACPU/AnUCPU dedicated instructions)

7.1.2 ASCII code conversion instruction "ASC"

ASCII code conversion instruction is replaced with "SM1255" because it is an unconvertible instruction and its
specification is incompatible with QCPU. Modification in accordance with the specifications is needed. (For Basic
model QCPUs, it is replaced with "SM999".)

This section explains replacement of the ASCII code conversion instruction "ASC".

Frequently asked questions regarding the conversion of ACPU to QCPU program

(Inquiry example)
1. Instead of the "$MOV" instruction, which has similar functionality, the ASCII code
conversion instruction "ASC" is replaced with "SM1255" as an unconvertible instruction.
Are the "$MOV" and "ASC" instructions the same?

2. The Transition Handbook (Fundamentals) lists MOV as a conversion candidate for the
"ASC" instruction. Are there any precautions in this modification?

(Answer)
The "ASC" instruction in ACPU, and the "$MOV" instruction in QCPU are slightly different.
For this reason, "ASC" is replaced with "SM1255" as an unconvertible instruction. Check
the specifications and functions before changing to the "$MOV" instruction.

(1) Specifications of ASCII codes conversion instruction
The following are the ASCII code conversion instruction specifications for ACPU and QCPU
(1) ACPU (Instruction: ASC)
« Converts up to 8 characters.
« When there are 7 characters or less, it is converted and stored as 8 characters (4 words).
(space (20H) is stored until reaching 8 characters.)
« "P" is not appended to the instruction, however, the operation is only executed when the execution
condition pulses ON.
(2) QCPU (Instruction: $MOV)
« Converts up to 32 characters.
+ Device points of storage destination may change (number of characters + 1 byte (rounded up in units of
word)).
+ Execute the operation as long as the execution condition is ON.
(To execute the operation only when the condition for instruction execution pulses ON, change the
instruction to "$MOVP".)
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7.1 Replace instructions with different QCPU instruction format (excluding AnACPU/AnUCPU dedicated instructions)

(2) Occupied device points
The "ASC" instruction in ACPU occupies 4 words. The number of device points occupied by the "$MOV"
instruction in QCPU may change according to the number of characters+1 byte.
When replacing an "ASC" instruction that specifies 8 characters with the "$MOV" instruction in QCPU, the
number of occupied points increases because the stored ASCII code occupies 4 devices + 1 word (delimiter
"00H"). If the additional device was being used for other purposes, its content will clear to "O000H".
Modification is necessary when the devices used by the "ASC" instruction +1 are used for other operations.

(Example of stored data)

(1) 5 characters
ACPU: (ASC 1234A DO0)
QCPU: ($MOV "1234A" D0)

Device | ACPU | QcpPu
DO 3231 (H) 3231 (H)
D1 3433 (H) 3433 (H)
D2 2041 (H) 0041 (H)
D3 2020 (H) No change
D4 No change No change

(2) 8 characters
ACPU: (ASC 1234ABCD DO0)
QCPU: ($MOV "1234ABCD" DO0)

Device ‘ ACPU ‘ QCPU
DO 3231 (H) 3231 (H)
D1 3433 (H) 3433 (H)
D2 4241 (H) 4241 (H)
D3 4443 (H) 4443 (H)
D4 No change 0000 (H)
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7.1 Replace instructions with different QCPU instruction format (excluding AnACPU/AnUCPU dedicated instructions)

(3) Program replacement example

| ACPU "ASC" instruction program |
* Up to 8 characters of ASCII codes are stored in DO to D3.

MO
0 | [AsC ABCD1234 DO H

* Up to 8 characters of ASCII codes are stored in D10 to D13.

* 5 characters are specified. Higher byte of D12: 20H, D13: 2020H.
M1

14 [ [ AsC XYZ789 D10 Iz

28 [ END H

| Replacement QCPU program |

(Unconvertible instructions are replaced with SM1255)
* Conversion to character string instruction, ASC, is unconvertible and replaced with "SM1255".

MO
0 [ (sm1255 H
* Conversion to character string instruction, ASC, is unconvertible and replaced with "SM1255".
M1
3 [ (sm1255 H
6 [END Iz
| Modified QCPU program using "$MOV" instruction |
8 characters are specified, and ASCII codes are stored in DO to D3.
Since "00H" is added after the last character, "0000H" is stored in D4.
When the program is replaced, make sure that D4 is not used elsewhere for other purposes.
MO
o‘ [ [ smovP "ABCD1234" DO Iz
Stores ASCII code of up to 32 characters in D10.
The last occupied device is D25 when 32 characters are specified.
However, "0000H" is stored in D26 because "00H" is added after the last character.
M1
103 I I [$MOVP "'1234567890123456" D10 ]—
203 [END Iz
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7.2 Replace AnACPU/AnUCPU dedicated instructions

7.2 Replace AnACPU/AnUCPU dedicated instructions

AnACPU/AnUCPU dedicated instructions can be converted into QCPU instruction format. This section explains
the replacement of AnACPU/AnUCPU dedicated instructions.

Frequently asked questions regarding the conversion of ACPU to QCPU program

(Inquiry example)

Several AnACPU/AnUCPU dedicated instructions were used in the program. However,
converting the program to QCPU format reduced them to just one instruction. Can this
program be executed as it is?

(Answer)
Replacing AnACPU/AnUCPU dedicated instructions with QCPU instructions changes and
simplifies the instruction format.
Further modification of the program is not necessary.

(Inquiry example)

Can the AnACPU/AnUCPU dedicated instructions for special function modules also be
replaced?

(Answer)

AnACPU/AnUCPU special function modules and QCPU intelligent function modules have
different functions, specifications, number of occupied points, etc.

The AnACPU/AnUCPU special function module instructions cannot access the QCPU,
therefore, they are replaced with "SM1255" as unconvertible instructions.

Modify the program according to the functions and specifications of QCPU intelligent
function modules.

Instructions for extended file registers and data link are also replaced with "SM1255."
Please modify the instructions in accordance with QCPU functions and specifications.
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7.2 Replace AnACPU/AnUCPU dedicated instructions

(1) Representations of dedicated instruction
The QCPU unifies AnACPU/AnUCPU dedicated instructions- LEDA, LEDB, LEDC, SUB, and LEDR- into one
single instruction, which has the same format as the basic and application instructions.
Instructions that do not have a corresponding QCPU instruction are replaced with "OUT SM1255". Replace or
delete the instructions that have been converted to "OUT SM1255".

QcPu | AnACPU/AnUCPU
Command
I I [ LEDA®B) [Instruction name H
Command — LEDC/SUB | B H
F—— Instruction name [S[D] n}—{ — LEDC/SUB | D H
— LEDC/SUB | n H

S, D, nindicate the data used in the instructions.

(2) Dedicated instructions with changed instruction names
In AnACPU/AnUCPU, dedicated instructions share the same name as basic and application instructions.
In QCPU, instruction names have been changed.

Function | QCPU | AnACPU/AnUCPU

Floating decimal point addition E+ ADD

Floating decimal point subtraction E- SUB

Floating decimal point multiplication E* MUL

Floating decimal point division E/ DIV

Data dissociation NDIS DIS

Data linking NUNI UNI

Changing check pattern CHKCIR, CHKEND CHK, CHKEND
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7.2 Replace AnACPU/AnUCPU dedicated instructions

(3) Program replacement example
(1) Direct output instructions

| AnACPU/AnUCPU program |

* Direct output.

MO * (DOUT: Direct output instructions)
0 | | [ LEDA DOUT
[LEDC Y10
Direct output
device
[ LEDR
18 [ END
| Replacement QCPU program |
* Direct output.
MO
0 [ (by1o0
Direct output
device
4 [END

(2) Conversion instruction from hexadecimal ASCII to BIN 32-bit data
| _AnACPU/AnUCPU program |

* Conversion from hexadecimal ASCII to BIN 32-bit data.

MO * (Conversion instruction from ASCII to BIN)
0 | | [ LEDB DHABIN
[LEDC DO
Head device of
ASCII data
[LEDC D10
Conversion
result
[ LEDR
21 [END
| Replacement QCPU program |
* Conversion from hexadecimal ASCII to BIN 32-bit data.
MO * (Conversion instruction from ASCII to BIN)
0 [ [ DHABINP DO D10
Head device of Conversion
ASCII data result
6 {END
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7.2 Replace AnACPU/AnUCPU dedicated instructions

(3) Addition instruction of floating decimal point type real number

L_AnACPU/AnUCPU program ||

* Real number addition instruction.

* (E+: Replacement for ADD, real number
M2 addition instruction )
0 [ | [ LEDB ADD Iz
[LEDC D10
Head device of
data to be added
[LEDC D20
Head device
of first addend
[LEDC D30
Head device
of addition result
[ LEDR Iz
24 [ END Iz
| Replacement QCPU program |
* Real number addition instruction.
M2 * (E+: Replacement for ADD, real number addition instruction )
0 | | [E+P D10 D20 D30
Head device of data Head device Head device
to be added of first addend of addition result
7 [ END Iz
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7.3 Use index register as a 32-bit (2-word) device

7.3 Use index register as a 32-bit (2-word) device

After replacing ACPU instructions that use index registers, review and modify the programs because the A
Series and Q Series index registers differ in specifications (Z and V are for ACPU, and Z0 to Z15 are for QCPU).
The following are precautions for converting ACPU instructions that use index registers.

Frequently asked questions regarding the conversion of ACPU to QCPU program

(Inquiry example)

1. Device modification using index registers resulted in different Z and V device numbers.
Which QCPU devices are the Z and V devices in ACPU replaced with?

2. Index registers were used as 32-bit devices (2 words) in ACPU. However, when
upgrading to QCPU, the values of the index registers used for other purposes were
overwritten.

Can index registers be used as 32-bit devices (2 words) in QCPU?

(Answer)

The ACPU index registers, Z, Z1 to Z6, V, and V1 to V6, are replaced with Z0 to Z15.

If the index registers were used as 16-bit devices (1 word) in ACPU, the device numbers
will change once upgraded to QCPU. However, modification of the program is unnecessary.
If the index registers were used as 32-bit devices (2 words) in ACPU, the combination of Z
and V converts to Zn and Zn+1 in QCPU.

The index register numbers are different after replacement and modification of the program
is necessary.
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7.3 Use index register as a 32-bit (2-word) device

(1) Replacing index register
"Z, Z1 to Z6, V, V1 to V6" and "Z0 to Z15" are used as index register for the ACPU and QCPU, respectively.
Therefore, their specifications differ.
"V"is used as edge relay for the QCPU. This device is used to store the PLS/PLF information of the contacts
found at the start of the ladder block.
The following table shows how the index registers should be replaced when changing ACPU programs to
QCPU programs using "Change PLC type".

ACPU | QcPu
z 20
Z110 26 Z11026
v z7
V1 to V6 810213

Tip —

When indexing timer/counter contact instructions, such as "LD TQ", the index register limitations do not apply
to AnA/AnUCPU.

Due to the specifications, only index registers Z0 and Z1 can be used to index timer/counter contact
instructions in QCPU.

If the existing AnNA/AnUCPU program uses index registers other than Z and Z1, the instructions are
unconvertible and are replaced with SM1255. In this case, it is necessary to modify the program.
[

(2) Index register 32-bit specification
When using index registers in 32-bit instructions in ACPU, Z register is the low- order 16 bits and the V
register, with the same number as Z, is the high-order 16 bits.
Alternatively, the QCPU treats Zn and Zn + 1 as the low-order and high-order 16 bits respectively.
The index registers should be corrected if "Change PLC type" is performed on a program that includes 32-bit
index registers.
The following is an example of instructions that have 32-bit operation results.

Instruction ‘ ACPU ‘ QCPU
V1, ZA1 Z2, Z1
DA b0 2] (High order) (Low order) (High order) (Low order)
Z1(Quotient) Z1(Quotient)
BY o 2 V1(Remainder) Z2(Remainder)

When converting an ACPU program to QCPU using "Change PLC type", the operation result may be stored
to an unintended index register number.
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7.3 Use index register as a 32-bit (2-word) device

(3) Program replacement example

(1) When using index register as 16-bit (1-word) data

The index register numbers will change after converting the ACPU program to QCPU, but it is not necessary

to modify the program.

| ACPU program |

* Indexing devices with index register Z.

MO
0 [} [ movP DO ROZ
. Logging data Data logging
Dg(t)i]I%%%:gg save destination
[ INCP z
* Indexing devices with index register V.
M1
9 [ } [ MovP Wo R1000V
. Logging data Data logging
Dgct)%lr?%%lgg save destination
[ INCP Y
18 {END
| Replacement QCPU program |
* Indexing devices with index register Z.
MO
0 [} [ movP DO R0Z0
. Logging data Data logging
Data logging ST
command 20 <- replaced ACPU device "Z" save destination
[ INCP 20
* Indexing devices with index register V.
M1
6 [ | [ MovP wo R1000Z7
. Logging data Data logging
Data logging S
command 27 <- replaced ACPU device "V" save destination
[ INCP z7
12 [END
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7.3 Use index register as a 32-bit (2-word) device

(2) When using index register as 32-bit (2-word) data

The index register numbers and their combination will change after converting the ACPU program to QCPU.

It is necessary to modify the program.

| ACPU program |

0 r H
0 | | [P DO K10 z
Data to be A
divided Quotient is stored in Z and remainder
is stored in V.
[ movP v ROZ1
Remainder data
Z1 does not interfere with the division instruction. F save destination
[ INCP 1 H
18 [END H
| Replacement QCPU program |
X0
0 [ | [P DO K10 20 H
Data to be YA
divided Quotient is stored in Z0 and remainder
is stored in Z1.
[ MovP 1 ROZ1
Remainder data
Z1 is not stored in the proper location because Z1 is overwritten save destination
by the remainder of the division instruction.
[ INCP 1 H
12 [END H
| Modified/corrected QCPU program |
X0
0 [ | [P DO K10 20 H
Data to be A\
divided Quotient is stored in Z0 and remainder
is stored in Z1.
[ MovP zZ1 R0Z2
Remainder data
Since Z1 is overwritten by the remainder of the division save destination
instruction, change it to an unused index register.
[ INcP z2 H
12 [END H
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7.4 Utilize SFC programs (Replace MELSAP-II with MELSAP3)

7.4 Utilize SFC programs (Replace MELSAP-II with MELSAP3)

Solution and Benefit

* The SFC program (MELSAP-II) created in ACPU can be converted to QCPU SFC program
(MELSAP3) through "Change PLC type" in GX Developer. This program can be used without
further modifications.

« SFC program (MELSAP3) has the same specifications in QnACPU as in QCPU. Therefore, it is not
necessary to modify the program after executing "Change PLC type" in GX Developer.

+ SFC programs (MELSAP-II and MELSAP3) created with MS-DOS-compatible programming

software (SWOIVD/NX-GPPA and SWOIVD/NX-GPPQ) can be converted and utilized after being
imported to GX Developer.

This chapter explains how to replace SFC programs (MELSAP-II) created in ACPU with SFC programs
(MELSAPS3) for QCPU and the necessary modifications after the replacement.
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7.4 Utilize SFC programs (Replace MELSAP-II with MELSAP3)

(1) Operation for utilizing SFC program

Procedure 1: Changing programmable controller type in GX Developer

"Change PLC type" is a function that changes the target programmable controller type of the data being read
through GX Developer. The sequence programs are also automatically converted to comply with the target
programmable controller. However, instructions that cannot convert automatically are replaced with the
instructions shown below.

+ High Performance Model QCPU: OUT SM1255

+ Basic Model QCPU: OUT SM999

Search for these "OUT" instructions or SM1255/SM999 devices and manually modify the converted programs.
Additionally, intelligent function modules and network modules may require program and parameter
modifications.

(Project menu)

= MELSOFT series GX Developer (Unset project] - [LD{Eq
TNEEEER Edit FindiReplace  Comvert  Wiew  Online  Diagnostic

Mew project .. Chrl+m | | ,,}l‘
Dpen project ... Chrl40 @' @ = é

Clase project @ | ¥ ([Change PLC type] window)
Save Chrl+s _l_ _‘ —
Save s . ﬁ gl o = Change PLC type %]
Delete project ... - FLC zefies
Copy .. I | OCPUGMade) ~|

&| Fa | F7 | =F5 Cancel
Edit Data 3 FLC tppe

Imnport File 4 —
Export File: 4

* For detail operation instructions, refer to the following manual.
Transition from MELSEC-A/QnA(Large Type)Series to Q Series Handbook(Fundamentals)(L-08043ENG)
[7.1.2 Changing programmable controller type]

Tip

Files in GPPQ/GPPA format, which were created/saved using SWOIVD-GPPA, SWOIVD/NX-GPPQ, should be
converted into GX Developer format using "Import file".
Execute "Change PLC type" after the file is imported to GX Developer.
* For detail operation instructions, refer to the following manual.
Transition from MELSEC-A/QnA(Large Type)Series to Q Series Handbook(Fundamentals)(L-08043ENG)
[7.1.4 Reading (Reusing) other format files]
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7.4 Utilize SFC programs (Replace MELSAP-II with MELSAP3)

Procedure 2: Program settings in GX Developer

When SFC programs have been created as ACPU program file, they are replaced with the following 2
programs.

+ Ladder instructions: MAIN

+ SFC programs: MAIN-SFC

To execute multiple programs, such as "MAIN" and "MAIN-SFC", go to "Program" found in "Parameter" of PLC
to set the program name, execution type, and the order of execution during each scan.

(Program file name after changing programmable controller type)

i MELSOFT series GX Developer (
T Project  Edit Find/Feplace  Gonvert

Progam <] | E
ME SRR

e Rk e
= == ol 7= =

(Program settings window)

= {Unset project)
= @ Program 0O parameter setting
MAIN
% MAIN-5FC PLC name | PLC system | PLC file | PLCRAS | Device Program |Bootﬁ|e |SFC | 110 assignment
= @ Device comment
@ COMMENT
— Fixed scan =
@ P G > = Progiam Program name | Execute type ke Iy vt —
T —— b AIN 1 Al Scan - -
Metwork param MAIN-SFC 2 |MalN-5FC Scan b hd
@ Device memory =

* For detail operation instructions, refer to the following manual.
Transition from MELSEC-A/QnA(Large Type)Series to Q Series Handbook(Fundamentals)(L-08043ENG)
[7.7.10 Setting method when multiple sequence programs are created]
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7.4 Utilize SFC programs (Replace MELSAP-II with MELSAP3)

(2) Precautions for replacing MELSAP-II with MELSAP3
The basic operation of the MELSAPS is the same as the MELSAP-II, but the specifications are partially

different.

This section provides the precautions for the replacement.

(1) Starting SFC program
The SFC program can be started by using the special relay for starting/stopping the SFC program.
The special relay used for starting/stopping SFC programs changes according to the programmable

controller type.

ACPU: M9101 -> QCPU: SM321
Please take the precaution listed below because the specifications of the special relays are different for

each CPU.

Specifications

Precautions for replacement

MELSAP-II (M9101)

Switches on and off with user

operation.

MELSAP3 (M321)

SFC program starts up at default,

since system is automatically turned

on.

When starting/stopping the SFC program
according to user conditions, operations
such as turning SM321 on/off must be
handled in the program.

(2) Block information (SFC information device)

The MELSAP-II and MELSAP3 have different method of executing the "Block START/STOP" and
"Reading of the number of active steps and active step numbers" with block information (SFC
information device).

ltem

Block START/
STOP methods

Specifications

MELSAP-II

[START]

Switching the block active bit
on executes forced start.
[STOP]

Switching on the block clear
bit stops the block and
switching it off executes
forced stop.

MELSAP3

[START]

Switching on the block
START/STOP bit forcibly
starts the corresponding
block.

[STOP]

Switching off the block
START/STOP forcibly stops
the corresponding block.

Precautions for replacement

[START]

The program does not need adjustments
when a SFC program for ACPU is
converted to QCPU because

the "Block active bit" is replaced with
"Block START/STOP" bit.

[STOP]

The "Block clear bit" resets the "Block
START/STOP bit".

Add the SFC control instruction

"RST BLm" to the program.

Delete the program that switches

the "Block clear bit" on/off.

The number of
active steps

and active step
numbers reading

Reads the number of active
steps in the corresponding
block and active step numbers.

Reads only the number of active
steps in the corresponding block.

To read the active step numbers,
use the "Active step batch readout
instructions (MOV, DMOV, BMOV)".
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7.4 Utilize SFC programs (Replace MELSAP-II with MELSAP3)

IMPORTAN'I'

Performing the following operations on SFC programs created with SWOIVD/NX-GPPA may result in
abnormal SFC chart display and cause creation fault in GX Developer.

+ Executing "Import file" in GX Developer to import an SFC program saved in a personal computer.

+ Executing "Read from PLC" in GX Developer to read an SFC program from an ACPU.
If a creation fault occurs in the SFC chart, add a dummy step with SWOIVD/NX-GPPA and import the file to GX
Developer.

1. Creation fault examples

o { 0 O O ] []
I;E No step { “t, No step {
2. SFC chart modification
examples
(When adding a dummy step) (When changing to jump transition)

RIS

T Jump T
destination
step

. Selective coupling
Qj:-::-:?ns?; changes to jump transition.
y step The jump destination step

is the one immediately
following the coupling
before modification.
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7.4 Utilize SFC programs (Replace MELSAP-II with MELSAP3)

(3) Precautions for modifying SFC chart

(a) Add "X (dummy step)" as an additional step
If "] (step)" is added, the step number + "?" is displayed/printed due to un-programmed operation output.
(b) As shown below, create a transition condition program in the additional step using a series transition (+).

% I I < Tran

If the transition condition program is not created, the transition condition number + "?" is displayed/printed
due to un-programmed transition condition.
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7.5 Method for maintaining existing addresses when replacing MELSECNET/MINI(-S3) with CC-Link

7.5 Method for maintaining existing addresses when replacing MELSECNET/MINI(-S3)
with CC-Link

The existing MELSECNET/MINI(-S3) and the CC-Link differ in the number of occupied points per
station: the former has 8 points per station, and the latter 32 points.

When the existing and new modules differ in the number of occupied points or the number of the
existing modules differs from that of the new modules, it is necessary to change the addresses to be
used in the sequence program. However, the existing addresses can be maintained by transferring
input/output data using the existing address of each station (module) by FROM/TO instructions without
using the CC-Link auto refresh function.

® Replacement example

(1) Number of occupied points per station
The number of occupied points per existing MELSECNET/MINI(-S3) station is 8. A module with
more than 8 points requires more than one station.

*Example of existing configuration

AJT1PT| Input/output
A61P |ACPU 30.53 module
A35B ]
AX11C — AX41C —— AJ35TB2-16D —— AX10Y10C [— AY13C
Station No.1 Station No.5 Station No.9 Station No.11 Station No.15
(4 stations, (4 stations, (2 stations, (4 stations, (4 stations,
32 points occupied) 32 points occupied) 16 points occupied) 32 points occupied) 32 points occupied)
(X100 to X11F) (X120 to X13F) (X140 to X14F) (X150 to X15F)

(Y160 to Y16F) (Y170 to Y18F)

MELSECNET/MINI(-S3)

AJ35TB2-16D is
replaced with:
e

*Example of new configuration

AX11C is replaced with: AX41C is replaced with:
- N

AY13C is replaced with:
X

AX10Y10C is replaced with:
)\

r Al

r

" R ~ ﬁ [ ﬁ

QUsieT .J AJGSSBTB2N | _ | AJG5SBTB2N | _ | AJBSDBTBY | _ | AJESSBTB3 ...

Q61P |[QCPU Input/output | ,* -16A -16A -32D -16D s

1N module ' '

. D : Station No.1 Station No.2 Station No.3 Station No.4 :

' H (X100 to X10F) (X110 to X11F) (X120 to X13F) (X140 to X14F) H

Q33B H ' '
1)

[ . -’ ]

CC-Link :

'

'

L}

’
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7.5 Method for maintaining existing addresses when replacing MELSECNET/MINI(-S3) with CC-Link

(2) Method for maintaining existing addresses
The existing addresses can be maintained by transferring transmitted and received data by FROM/
TO instructions for each station without auto refresh setting.
The CC-Link communication conditions including the station information must be set by the
parameters.

(3) FROM/TO instructions sample program for transfer of transmitted and received data

(1) Address allocation table

Buffer memory Buffer memory Model name of Devices to be .
address on input address on replacement used by FROM/ Daeu\;ger;fc;ebsi usse?:?nfor
side output side module TO instructions 9
. EO AJB5SBTB2N-16A X100 to 10F X100 to 11F
Station No.1 ===~ e (X110 to 11F: Not in use)
E2 AJB5SBTB2N-16A X110 to 11F
Station N0.2 |~ X120 t? 13F
E3 (X130 to 13F: Not in use)
E4
Station No.3 |~ T AJB5DBTB1-32D X120 to 13F X140 to 15F
E6 AJ65SBTB3-16D X140 to 14F X160 to 17F
Station N0.4 |- . .
E7 (X170 to 17F: Not in use)
E8 AJ65SBTB2N-16A X150 to 15F
Station N0.5 |- X180 t? 19F
E9 (X190 to 19F: Not in use)
16A AJB65SBTB2N-16R Y160 to 16F Y1AO to 1BF
Station No.6 ; )
168 (Y1BO to 1BF: Not in use)
16C
StatonNo.7 | | 1 6D """"""""" AJ65DBTB1-32R Y170 to 18F Y1CO to 1DF

* Sample program

Data transfer
Command Receipt of input data to the first modul ted in place of
eceipt of input data to the first module mounted in place o
L | |——{ FROM | HO | HOEO | K4X100 | KI }—| the existing AX11C
L [ FROM | HO | HOEZ | Kaxi10 | K1 }— (I}i%c.zlrgx?;tlir;gu;g?gaoto the second module mounted in place
Receipt of input data to the module mounted in place of
— FROM | HO | HOE4 | K4xi20 | K2 |—the ex?sting£X41C P
Receipt of input data to the module mounted in place of
—__FROM | HO | HOE6 [ Kax140 | K1 |— 40 exFi)sting AJ35TB2-16D P
Receipt of input data to the module mounted in place of
Datatransier —|_FROM | HO | HOE8 | K4X150 | K1 [— 0 ex?sting £X1OY1OC on the input side P
ﬂma&_' 70 ] Ho | HieA [ Kavieo | Ki }— Sending of output data from the module mounted in place of
the existing AX10Y10C on the output side
Sending of output data from the module mounted in place of
‘4 TO | HO | HI16C | K4Y170 | K2 |— the existing AY13C
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7.6 Replace pulse catch module

7.6 Replace pulse catch module

There are no available replacement modules for AnS (Small Type) Series pulse catch module A1SP60.
Replace it with one of the followings.

+ L Series CPU : Built-in 1/0 pulse catch function

+ Q Series CPU: Interrupt module QI60

7.6.1 Replace with LCPU built-in 1/0 pulse catch function

The address of the LCPU built-in 1/0 pulse catch function is determined by the I/O assignment
parameter and the built-in 1/0 function setting. Therefore, it is necessary to change the existing
address Xn to the address set for the LCPU built-in I/O pulse catch function.

® Replacement example

| Example of existing configuration| | Example of new configuration

.

PR Lo oo
A1S |A1SH| A1S ' /O © 10 | 10 L61P | LO2CPU ! !
61PN | CPU | P60 imoduleimoduleimodule Replace Di modue:modue:module

RIS, D
i & 5
T

The address depends on the module position The address (16 points occupied) and built-in
(16 points occupied). /0 function are set by the PC parameters.

(1) Example of LCPU parameter setting
The following parameters must be set to use the LCPU built-in 1/0O function.
Select "L parameter setting" -> "I/O assignment setting," and set the first XY to 0.

FLG rame | PIG systam |PLG e |PLG RASLH |PAc RASKD | Davice Frogeam | Bt fike |G
D pssignmant |Buitt-in Extmersat port | Buitt-in L0 function setting

Select "L parameter setting" -> "Built-in I/O function setting," and specify the pulse catch function
for the input signal XnO.

PLC rame |PLO wiem | PL fie | PL0 RAS(T |PLC RASID) |Desie  |Powes  |Seotfie  |SFC |
0 astnment | Bt Esrerat pert i U/ Rirtion saiting
Fonitionng. - gt sgomec courter
o | Hatrwend counber GH1 ssttrs | Mot ad -/ 3
va tor 0 | Hap—stmed counben CH. |
Tt nagrnad - Oupait wagnadl
I ma Py
Garmmal rgadt s [TT] = | Cowr
Geness gt ma G =[O
iy G Do
Genmal s = [ina G = | Cieas
(snessl rput = ilma Geneisl = | Closs
r = [T = [
Dot ryad = [ [rrr | T
Goonend gt =
s =
el rgnt =
ol g .
ol g s
Gered =
T ]
Acknomiedge XY nesigremet | Mitpn CPUsetirgs | Dwtwh | Chesk | B | Carest
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7.6 Replace pulse catch module

(2) Example of program modification

Xn—X0 "1
0 [ Program to be processed when
[ | the pulse catch input is turned on

*1: Change the existing pulse catch input Xn to the address set for the built-in I/O function.

Deleted program
*2

*2: Only in the case of direct input/output processing by the existing CPU module
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7.6 Replace pulse catch module

7.6.2 Replace with QCPU interrupt module

It is necessary to change the existing program to an interrupt program.

® Replacement example

| Example of existing configuration|

A1S |A1SH| A1S 1 /0O 1+ 1O 1 10
61PN | CPU | P60 :moduleimodule module Replace

The address depends on the module position

| Example of new configuration

Q61P Q02U Q160 | /O | 1/O | 110
CPU module|module | module

T

Create an interrupt program with “I0 to 115”

(16 points occupied). regardless of the module position address
(16 points occupied).
(1) Sample program after replacement
Il— Interrupt enable
CFE |
SM400 o
0 | } Program to pe prqcessed when The program to be processeq when thevpulse catch mput is
! pulse catch input is turned on turned on is executed by turning on the interrupt condition.
IRET
END

Interrupt point after replacement of pulse catch module

(2) Pulse catch processing procedure

Processing procedure of existing pulse catch module (refresh system)

Pulse catch
external input ’—‘
signal

\ ON data is captured by I/O refresh. \

Scan execution o] o] o]
program
\ 1

[END processing] [END processing] [END processing]

1

Pulse catch

input signal: Xn l
Program to be processed when pulse
catch input signal is turned on

Processing procedure of newly mounted interrupt module
I
external input T
s:i)zr::r)r(‘ecution @ END] [O] (0]
\ 1

END processing l T END processing END processing

Interrupt program operation
(Program to be processed when pulse catch input is turned on)
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8.1 Replace AD75(P/M) with QD75(P/D/M/MH) while utilizing existing positioning parameters and data

8. Utilize existing ACPU data

8.1 Replace AD75(P/M) with QD75(P/D/M/MH) while utilizing existing positioning
parameters and data

Solution and Benefit

« Existing positioning parameters and data of the AD75(P0(-S3)/M0O) can be used for the QD75(P0/
DO/MO/MHO) with minimal modifications, reducing upgrade time.

+ Although the AD75(PO(-S3)/MO) and QD75(PO/DO/MO/MHO) may have different addresses even in

the same setting item, mistakes can be prevented because parameters and data can be used

without having to worry about buffer memory address.

The following is an example of replacing an existing A (Large Type) positioning module with the Q Series while
utilizing existing parameters and data.

@ Instructions
After replacing the A (Large Type) modules with the Q Series, reuse/convert positioning parameters and data
of the AD75 using GX Configurator software package for positioning modules.

Software packages to be used are as follows:
« For AD75 models: GX Configurator-AP Version 1 (SWOD5C-AD75P-E)
« For QD75 models: GX Configurator-QP Version 2 (SWOD5C-QD75P-E)

(1) System configuration example

| Current configuration | | After replacement
® e o =
> g —
= — DB I
g =) = z L |ws
=1 o % O ~S
0| & | F 2 | @ g2
821 < | 5§ Replace 53 o9
o] =
Qe T < Qe

*Utilize existing positioning parameters and data when replacing.
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8.1 Replace AD75(P/M) with QD75(P/D/M/MH) while utilizing existing positioning parameters and data

(2) How to use existing positioning parameters and data

Read positioning parameters and data from the AD75 using "GX Configurator-AP".

OS memory Flash ROM
N
. ( Parameters OS memory
GX Configurator-AP

(SWCD5C-AD75P-E) Positioning data Positioning data

<—l\ 2 No. 1 to 100 . “ No. 1 to 100
d Start block data Start block data
Positioning data Positioning data
L No. 10110600 | ) No. 101 to 600

Buffer memory

Write to AD75/read from AD75/verify (

AD75 data Parameters

» —'\ < Positioning data
—l/ No. 1 to 100

Write to/read from Flash ROM
Start block data

Monitor data,
control data area, etc.

AD750 poisoning module

Save positioning parameters and data using "GX Configurator-AP". (Creating a AD75 file)
* Save in the file format to be read by "GX Configurator-QP".

Save As

Savein: |3 Sample [ g’ =

File name:  [SAMPLET | Save |
Save as lype: [ Sw/1RX/NVD/NK-AD75P File (*.D75) ~| Cancel |
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8.1 Replace AD75(P/M) with QD75(P/D/M/MH) while utilizing existing positioning parameters and data

Read the AD75 file using "GX Configurator-QP".

GX Configurator-QP
(SWOD5C-QD75P-E)

File name: |backw.‘w‘?5 Open

Fies of type:  [SWODSC-AD75P File [*w75) =l

Example of reading a file created with GX Configurator-AP.

Specify item(s) that need to be changed in "GX Configurator-QP".

#= sample01 7 QD75D4 7 Parameter data (1/0 : 0)
Kind e Axis #1 Byis #2 Ia
Unit Jpulse Fpulse
Pulse per rotation 20000 pls 20000 pls
Travel per rotation 20000 pls 20000 pls
Basic T
parameter 1 Unit magnification 1:1times 1:1 times
Pulse output mode 1:CVWWICCW mode 1:CWICCW mode 11
S O:Forward pulsesto|  O:Forward pulsesto|  0Fo
Rotation diraction increase address increase address int
Bias speed at start 0 plsis 0 plsis
Speed limit 200000 plsfs 200000 plsis
Basic
parameter 2 ACC time 20 1000 ms 1000 ms
DEC time #0 1000 ms 1000 ms
vtandad e
o | v
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8.1 Replace AD75(P/M) with QD75(P/D/M/MH) while utilizing existing positioning parameters and data

Write all positioning parameters and data, including modified data, to the "QD75 using GX Configurator-QP".

Buffer memory

Parameters
Via QCPU, Q Series compatible serial
communication module, or > Servo parameters

MELSECNET/H network remote 1/0
module* Positioning data

*Only when directly connected to the Block start data

remote 1/0O module.

Flash ROM

Parameters

Write to module/read from module/verify module data Servo parameters

» Positioning data

Write to Flash ROM Block start data

 Tip

« To use GX Configurator-AP data in GX Configurator-QP, it is necessary to save the file in a format that can
be read by GX Configurator-QP. Files saved in GX Configurator-AP format cannot be read by GX
Configurator-QP.

+ Due to specification differences between the AD75 and QD75, some positioning parameters may require
setting changes. Refer to the related manuals for details on the modifications. Note that positioning data
does not require any modifications.

* Related manuals

(a) AD75

Title | Manual No.

A1SD75P1-S3/P2-S3/P3-S3, AD75P1-S3/P2-S3/P3-S3 Positioning Module IB-66716
User's Manual (Details)

A1SD75M1/M2/M3, AD75M1/M2/75M Positioning Module User's Manual (Details) IB-66715

GX Configurator-AP Version 1 Operating Manual IB-66900
(b) QD75
Title | Manual No.
Type QD75P/QD75D Positioning Module User's Manual (Details) SH-080058
Type QD75M Positioning Module User's Manual (Details) IB-0300062
Type QD75MH Positioning Module User's Manual (Details) IB-0300117
GX Configurator-QP Version 2 Operating Manual SH-080172
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8.2 Procedures for replacing when file registers are used in blocks

8.2 Procedures for replacing when file registers are used in blocks

This section explains the procedures for using existing data in the file registers used in more than one
block in the ACPU.

8.2.1 When block switch command is used
Solution and Benefit

File registers can be replaced only by modifying commands and using the existing data.

(1) Procedures for using existing ACPU projects
When file registers in more than one block are used in ACPU, it is necessary to save the projects
with different names for the blocks.

Step 1: Retrieve the program, parameters and device comment data from ACPU using GX
Developer. Retrieve the data to the PC with the specified file register block number, and
save the data as a project.

4

Step 2: Retrieve the data in another specified file register block number to the PC, and save the
data with a project name different from that used in Step 1.

2
Step 3: Change the type of the ACPU project file saved in Step 1 to QCPU/LCPU by "Change PLC
type."
2

Step 4: Open the ACPU project file saved in Step 1, and display the device memory R. Open the
QCPU/LCPU project file which has been changed in the PLC type in Step 3, and display
the device memory ZR.

4

Step 5: Drag the mouse in the device memory R of ACPU to copy all range, and paste it from the
beginning of each block in the device memory ZR of QCPU/LCPU.

For the beginning of each block, see "Tip."

4

Step 6: Open each project saved in Step 2, copy all range of the file register R, and paste it from
the beginning of each block in the device memory ZR of the QCPU/LCPU project created
in Step 4.
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8.2 Procedures for replacing when file registers are used in blocks

* ACPU project file * * Q/LCPU project file *
(Some project files are necessary for each block.) (1 project file)
ACPU | Operation to retrieve data in block No.0|—9| ACPU —M—P | _ROto8191 | ZRO
project file(1) . *Block No.0 * |to
. ZR32767
[ Operation to retrieve data in block No.1 9 ACPU —{Copy|—»| _R0to8191 _ | ZR32768
project file(2) . *Block No{ * |to
ZR65535
ZR65536
to
Operation to retrieve data in block No.n || ACPU —M—} | _ R0Oto 8191 _ | ZR98303
project file (n) . * Block No.n * .

(2) File register block switch command
When executing "Change PLC type" by using GX Developer, the file register block switch
command is considered to be unreplaceable and replaced with "SM1255." Therefore, the program
must be modified.
Modify the program as shown below.

B Example of program for comparing RO in block No.0 and RO in block No.1
* Program for switching file register block of ACPU (command dedicated to AnA/AnU)

E'Hgl?“ ~CLEDA RSET 3
- {5UB g 3 Specification of block No.0
- {LEDR H
L {MOU RA p@ H Retrieve of RO in block No.0O
- —{LEDR RSET I
o {SUB '1< H Specification of block No.1
= {LEDR H
» CNOY RA D1 H Retrieve of RO in block No.1
4= 0O 012 CYede o

SIHC DB D1 @41 3 | Comparison of retrieved values

[

sl oo D1

{Yad?

[}
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8.2 Procedures for replacing when file registers are used in blocks

* Program for switching file register block of QCPU/LCPU

o— | {RSET KO Specification of block No.0
{wov RO Do Retrieve of RO in block No.0
{RSET K1 Specification of block No.1
{uov RO D1 Retrieve of RO in block No.1
of= D00 DI ] (Y40
13f¢ 0o D1 ] {r4 Comparison of retrieved values
17> oo b1} (v42
21 (END

 Tip

1. Number of points in one file register block
ACPU and QCPU/LCPU vary in the number of points in one file register block.
* ACPU: 8K points (8192 points) per block
* QCPU/LCPU: 32K points (32768 points) per block
When copying the data in the ACPU file registers into QCPU/LCPU, display the QCPU/LCPU file registers
in the ZR mode, calculate the ZR number corresponding to RO of each ACPU, and copy the data.
Examples) ¢ RO of ACPU block No.0—Position of RO in QCPU/LCPU
* RO of ACPU block No.1—Position of ZR32768 in QCPU/LCPU
* RO of ACPU block No.2—Position of ZR65536 in QCPU/LCPU
2. The number of file register blocks which can be handled by QCPU/LCPU Series depends on the memory
capacities of the standard RAM and memory card.
[
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8.2 Procedures for replacing when file registers are used in blocks

8.2.2 When file registers are used with consecutive numbers regardless of block numbers

Solution and Benefit

File registers can be replaced only by replacing the devices (R -> ZR) and using the existing data.

(1) Procedures for using data of ACPU
The procedures are the same as in 8.2.1(1).

* ACPU project file * * Q/LCPU project file *
(Some project files are necessary for each block.) (1 project file)

ACPU [ Operation to retrieve data in block No.o}—9{ ACPU ZRO to ZR8191 ZRo
project file(1) ZR8192 to ZR16383| Block No.0 * | t©

ZR16384 to ZR24575

| Operation to retrieve data in block No.1 |—P ACPU ZR24576 to ZR32767 ZR32767
project file(2 [ZR32768 to ZR40959 ZR32768
Cop
project file(3,
0|

‘| Operation to retrieve data in block No.2|—> ACPU

m . *Block No.1* | to

ZR65535

ZR65536

‘| Operation to retrieve data in block No.SI—P ACPU
project file(4;

C

)
)
) to

ZRm  to ZRm+8191 ZR98303
Operation to retrieve data in block No.n|—| ACPU . * Block No.n *
project file (n) )

(2) Example of program for retrieving the contents of R8200 to R8209 (R8 to R17 in block No.1) to
D100 to D109
* Program of existing ACPU

¥o
0 3-F {GJ Py
N3026
4 [RsT z
Designating head device number of extension file
L e L registers
] NP6 . . o R .
15 o0 D200 06036 ~ Designating extension file registers device number
{ LEDA b . Reading
Wy L] Moz - Storing read data to data register
{ 1N z -\ Setting device number which is to be processed
following the data register and extension file
T D200 - / register
B[O K10 z ] {e ]

* Program of QCPU/LCPU

40
L] ’_‘ | = e a3l 2]
5 [eMo

 Tip

1. Number of points in one file register block
ACPU and QCPU/LCPU vary in the number of points in one file register block.
* ACPU: 8K points (8192 points) per block
* QCPU/LCPU: 32K points (32768 points)per block
When copying the data in the ACPU file registers into QCPU/LCPU, display the QCPU/LCPU file
registers in the ZR mode on the device memory screen of GX Developer. Calculate the ZR number of the
destination QCPU/LCPU based on the number of points per block of ACPU, and copy the data.
Examples) < RO to R8191 in ACPU block No.0 — Positions of ZR0 to ZR8191 in QCPU/LCPU
* RO to R8191 in ACPU block No.1 e Positions of ZR8192 to ZR16383 in QCPU/LCPU
* RO to R8191 in ACPU block No.0 e Positions of ZR16384 to ZR24575 in QCPU/LCPU
2. The number of file register blocks which can be handled by QCPU/LCPU depends on the memory
capacities of the standard RAM and memory card.
[
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8.3 Copy device memory data

8.3 Copy device memory data

Solution and Benefit

The data in file registers and data registers can be copied between different CPU types, so that the

existing data can be used easily.

(1) Example of copy operation
The following is an example of operation to copy file register data between different CPU types.

Step 1: Display the device memory RO in the existing ACPU program file using GX Developer, drag
the mouse to select the range to be copied into QCPU after replacement, and store the
data in the copy buffer.

To store, select "GX Developer edit menu" -> "Copy" or "Ctrl+C."

Device Label [R0 -] Display | | 16-bit integer ~| |DEC ~| RI--R4085
chvioe name 0 1 2 3 4 S 6 7 Character strin
RO 123 {.E...EE8.C.e.
RE “d).€ ...,
R16 YVEEEQYIvAYe¥
R24 L
R32

_| |r40
R4E 0 0 0 0 0 0 0
|rs6 0 0 0 0 0 0 0
|R64 0 0 0 0 0 0 0

Step 2: Start up GX Developer separately from the existing ACPU program file, display the device
memory RO, and specify the top position in QCPU into which the data will be pasted.

Device Label [R0 ] Display | | 16-bit inteeer ~| |DEC ~| [RO--R32767
|Device name 0 il 2 3 4 5 & 7 Character string
}n_n 0 0 0 0 0 0 0

RE 0 0 0 0 0 0 0

P‘ 0 0 0 0 0 0 0

R24 0 0 0 0 0 0 0

[r3z 0 0 0 0 0 0 [

Pm 0 0 0 0 0 0 0 ]
R4E 0 0 0 0 0 0 0 [
[Rs6 0 0 0 0 0 0 0 0] eeiennninannnns
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8.3 Copy device memory data

Step 3: Paste the data in the device memory RO stored in the copy buffer into the specified position
of the device memory of the QCPU.
To paste, select "GX Developer edit menu" -> "Paste" or "Ctrl+V."

Device Label [R0  ~+]  Disphy | [16-bit integer =] [oec ~] [RO--R32’T
Device name 0 1 2 3 4 5 6 7 Character Str:
123 456 789 135 246 462 579 357|{.E...EED.C.e.
680 1234] 2385|3456 0 0 0 0[~.0.).€ciunnn..
-1 -10 -20 -30 -40 -50 -60 -70|yyEEE@YIgAFY
4567|9276 0 0 0 0 0 [ E
0 o 3333 0 0 777 0 [
0 0 0 0 0 0 0 [
0 0 0 0 0 0 0 [
0 0 0 0 0 0 0 [ T

(2) Allowable destinations
The data in the device memories can be copied not only between GX Developers, but also
between GX Developer and Excel or Word.
However, the number of strings in Excel or Word is the same as that in GX Developer.
The data in the device name field cannot be copied.

GX Developer < 14 GX Developer
(ACPU file) (Q or LCPU file)



9.1 Utilize programs of PC type incompatible with GX Developer

9. utilize A/QnA -> Q conversion support tool

A/QnA -> Q conversion support tool

This tool is designed to reduce the work load when replacing A/QnA (Larege Type) Series modules with Q
Series modules. The tool contains the following functions.
e Extracts parts of the program that were not automatically converted and displays the appropriate
modification procedures.
(Reduces program modification time.)
* Automatically creates link refresh sample program when using MELSECNET (II)/B local station data link
module (A1SJ71A[123(B)Q).
(Program creation is unnecessary as it is automatically generated)
* The PLC type of ACPU parameter programs incompatible with GX Developer can be changed to ACPU.
(Special peripherals are not required.)
The "A/QnA -> Q conversion support tool" can be downloaded for free from the "MELFANSweb".
e

9.1 Utilize programs of PC type incompatible with GX Developer

Solution and Benefit
Programs of PC type incompatible with GX Developer can be utilized by using the A/QnA
-> Q conversion support tool in accordance with the following procedures.

(1) CPU incompatible with GX Developer
The following CPU types are incompatible with GX Developer.
+ AOJ2CPU + AICPU + A2CPU(-S1) + A3CPU
+ ASHCPU + ABMCPU + A52GCPU + A3VCPU + A73CPU

(2) Operation procedures

| Step 1: Start up |

* Click the icon.

| Step 2: Menu selection |

Start the A/QnA -> Q conversion support tool. Select "A0J2 conversion support tool execute."

m

AONA->Q conversion support tool Version.1.14

[ AQnA->Q program conversion support tool execute |
This tool supports AQnA->Q program conversion

Refresh program generalion lool for MELSECNET(II) local station execute J
Thig tool gansratas tha refrash program generalion for MELSECNET(N) local station

MELSECNET(ll}>MELSECNETMD(H) parameler conversion lool exacute I

This tool converts the MELSECNET(I}->MELSE CNETHO{H) parameter and supports AQnA->Q program
COMVEersion

ADJ2 conversion support tool execute |
This tool converis the program of ACPU not supported by GX Developer into the supported program.

The program corwersion tool for AnS-Q Module Conversion Adapler execule |
Convert the XY device and No. of buffer memory with the compatible one.

_ e |

COPYRIGHT(C) 2005 MITSUBISHI ELECTRIC CORPORATION ALL RIGHTS RESERVED
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9.1 Utilize programs of PC type incompatible with GX Developer

| Step 3: Select PLC type|

Select "File" -> "New," and select the PLC type.

SelectPiCtype @
& or
© AIN)
" A2C A2JC A52G
 A2(N)A2S
¢ A3(N)A1S(J)HA2SH A3VAT3
" A3HA3M

Latest files

OK Cancel

Exit

| Step 4: Read from programs |

Select "Online" -> "Read from PLC," and the programs in the CPU will be read out.

Aodlory Wndew fep = pamgesion P ==
PC > Read from PLC...  parameter ——
Regist " Main Program iRt e i |
McesE Ll ’ e =  Bubprogrami i—t?1il--lllf1
Error Check... e i o subpragramz. | © 890 Ranaefo — ~ a7
Remote operation... € Subprograma
" Kana Comment
Device SET/RST... Fa
 Kanji Commant Progress
i Chunge... 5!1'&+Fg  Estensiop Comment I |
Set Time cFU
Communication Channal Built-n port
CPUType  AlJ CPUType ALJ
Communication Port Setting... all cruT

i
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9.1 Utilize programs of PC type incompatible with GX Developer

| Step 5: Change PC type |

Select "Auxiliary" ->"Change PC type," and select a PLC type compatible with GX Developer.

[Auxiliary] window Help [changeplcType @

Parameter Setting... C AJ2

" ADJ2H

 AIS,AISJ

Change Mode... AN

Options " A20.A2JC.A52G

" A2AN)LA2S

" AANLAIS(DHAEHAIV.ATS
" A3HA3M

Change PC Type ...

NOP Operation »

" A2UA2US
" A3U.A2USH
ALl

OK Cancel

| Step 6: Save programs |

Select "File" -> "Save As."
The set system name and machine name will be used as the name of the imported file stated at item 7.4.

[File] Edit View Change mode Online Aux

New... Ctrl+N
open.. ci+o = B B
Close SystemName  Title
Save ctrl+s [TEMP [
Save as... Machine Name Title

[TENP [
Open sub porgram » Menu Title
1 C:¥gpp¥usr¥TEMP¥TEMP

ok |  cancel |

Exit

 Tip

+ For details, refer to "A/QnA -> Q conversion support tool: AOJ2 Conversion Support Tool Operation Guide."
+ The "A/QnA -> Q conversion support tool" can be downloaded for free from the "FA Site."
e
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9.2 Create a sample program for MELSECNET(1I) or MELSECNET/B link refresh using A/QnA -> Q conversion support tool

9.2 Create a sample program for MELSECNET(II) or MELSECNET/B link refresh using
A/QnA -> Q conversion support tool

Solution and Benefit
A sequence program (sample program) can be created to automatically perform link refresh by
entering the existing network conditions in the A/QnA -> Q conversion support tool.

@ Conditions for program creation

(1) System configuration example

Master station(M)

...
> | =
g | 2| oo
S5 | 5| 3| 3|3
ol @ | | ©T| T
53518 8 ¢
28 &
£ele|el9QQ

MELSECNET(1I) (optical)

Local station 1

The A/QnA -> Q conversion support tool creates
a link refresh sequence program for this module.

QA1S65B

Local station 2 Local station 1

® e o ® e o

= - > -

g |8 22 @ g 8|2 o

= =) = > > =] D -8 _g _g

g 2 5 81 8| 8 g 2 5 | 6| o

22315l o o HERARAR:

gc_’ £ < = = = ch gl < = = =

Third tier's

Local station 3 master station(m) Local station 2

(] e o ® e o

2= b = -

Q. o [V

o) o Q Q - . . =) o Q 2 Qo

3 S|z 3¢ Third tier 2 > | 3| 3| 3
o O 9 9 2ol o o kel °

=20 5 o s} < 521 O o] o) 1]

o> IS g | - 23 1S £ £

538 &l ol o5 58 &

o gl < = = < o E| < g g g
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9.2 Create a sample program for MELSECNET(II) or MELSECNET/B link refresh using A/QnA -> Q conversion support tool

(2) Master station network parameter (Master station(M) for the second tier)
The following are examples of the master station's network parameters and transient communication
program.
The parameter settings for the master station are the conditions used to create a link refresh sequence
program for the local station data link module.
(a) Network type selection

Neressay setting] Nosefting / Alieadyset | Setilitiz needed] Mo setfing / Aleady set ]

Shart 10 Mo.: Valdmoduls
; ; e 5 during other station access Il 32 I
Ik ansissin prieneters|  Ingt the stat 140 No. instolled in the module in 16-point it g
Acknowledge XY assignment | Fouting parametess I Check. | Erd l Cangel I

(b) Setting examples for each network type
1) MELSECNET mode (Network range assignment: set for the first half only)

[ Woddenar ]
T S |
,_7.

Setup common pararmeters

Azsignment method o
" Painks/Start Manitaring time {200 3¢ 10ms
@ Stat/End i e Switch scieens | LB/LW seftings =]
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9.2 Create a sample program for MELSECNET(1I) or MELSECNET/B link refresh using A/QnA -> Q conversion support tool

2) MELSECNET II composite mode (Network range assignment: set for the first half and second half)

Setup common parameters

Agzighment method o
" Paints/Start Maonitoring time 1200 * 10ms
& Stat/End leclp o S Switch screens  [First hall LB/Lw/ setting v ]

(c) Program example of transient instruction
Transient communication is being performed if the following instructions are in the master station's
sequence program.
The use of transient communication is one of the conditions that should be taken into account when
creating a link refresh sequence program.

X0 M9200  M9201  M9202  M9202

[ [ [ [ | [ | [LRDP K1 DO D100 K10 H
Readfrom LRDP ~ LRDP  LWTP  LWTP Other station  Read data
other station instruction instruction instruction instruction read device  storage

received completed received completed
X1 M9200  M9201  M9202  M9202
[ |} |} [} [} [lwTP K1 D20 D300 K10 H
Write to LRDP LRDP  LWTP  LWTP Other station

other station instruction instruction instruction instruction write destination
received completed received completed device
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9.2 Create a sample program for MELSECNET(II) or MELSECNET/B link refresh using A/QnA -> Q conversion support tool

(3) Procedure for creating link refresh sequence program
The following are the procedures for creating a link refresh sequence program using the A/QnA -> Q
conversion support tool.

| Step 1: Start up |

Start the "A/QnA -> Q conversion support tool".
Click the "A/QnA -> Q conversion support tool" icon.

AQCnvSupport.Ink

| Step 2: Menu selection |
Select the "A/QnA -> Q conversion support tool" menu.

AlQnA->Q conversion support tool Version.1.14

| AIQnA->Q program conversion support tool execute |
This tool supports AQnA->Q program conversion,

Refresh program generation tool for MELSECNET(H) local station execute |
This tool generates the refresh program generation for MELSECNET(N) local station.

MELSECNET(I}->MELSECNET/MO(H) parameter comversion tool exacute I

This tool convens the MELSECNET(II)->MELSECNET/10(H) parameter and suppors A'QnA->Q program
conversion.

ADJ2 conversion support tool execute I
This tool converts the program of ACPU not supported by GX Di into the 9

The program conversion tool for AnS-C Module Conversion Adapter execute |
Convert the XY device and No. of buffer memaory with the compalible one.

e |

COPYRIGHT(C) 2005 MITSUBISHI ELECTRIC CORPORATION ALL RIGHTS RESERVED

(a) Click "MELSECNET (II) local station refresh program generation tool start" on the Menu screen.
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9.2 Create a sample program for MELSECNET(1I) or MELSECNET/B link refresh using A/QnA -> Q conversion support tool

Step 3: Enter conditions for program creation
Enter conditions for program creation in the "Refresh program generation tool for MELSECNET(II) local
station" screen.

Refresh program generation tool for MELSECHNET{D local station

~ QCPU{@mode) new program
PLC type

[fO Mo, of ATSJT1AP2ICIAT SIT1ARZ3QAT SITTATZ3IBA

(b) ,||—znn|u--FEu

| — Metwork typedmode)
(C) —>I {* MELSECHET " MELSECHKET Il {including MMNET Il comp. mode)

—Bedquence program to he created

Creates the checked sequence programs.

¥ Refresh proorarm [~ LRDP instruction receive prograrm

(d) ,[I_ B receive program of master station in third 1ier] [~ LWTP instruction receive prograrm

cona_|

!
(e) (f)

(a) Select a Q Series CPU type to which MELSECNET(II) local station module is mounted.

For the case shown in "A. System configuration example", found under "® Conditions for program
creation", select "Q02H".

(b) Enter the 1/0 number of the slot on which MELSECNET(II) local station module is mounted.

This setting determines the start number of the FROM/TO instruction's access target.
Enter the 1/0 number after checking the actual system.
The CPU may stop if the I/O number differs from the one that is actually mounted.

(c) Set the network type (mode) to match the one set in the master station (M) network parameters.
Refer to "B. Master station network parameter (Master station (M) for the second tier)" under
"@ Conditions for program creation" for an example.

(d) Check this box if the station which contains the refresh program is a local station in the third tier.

(e) Refer to "(c) Program example of transient instruction" found in section B of "® Conditions for program
creation", and select the check boxes if the transient instructions corresponding to "local station data link
module mounted station" exist in the master station program.

(f) Select this button to move on to "Step 4", link refresh device setting.

Make sure the settings are correct.
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9.2 Create a sample program for MELSECNET(II) or MELSECNET/B link refresh using A/QnA -> Q conversion support tool

| Step 4: Link refresh device settingﬂ
Set link refresh devices for the CPU module side.

Refresh proeram eeneration tool for MELSEGNET{D local station

—Refresh program setting

MRefreshes all points on the link side when a Dev. Mame is set. They are not retreshed wihean

the setting is blank.

omer_|
A

(c)

(a) Set MELSECNET(II) local station's special link relay and link special registers as the link refresh devices
on the CPU module side.
Device numbers are fixed when the device name is SM or SD.
For other device names, device numbers can be specified.
Link refresh is not performed if the "Device name" column is blank.
(b) Set link devices to be refreshed on the CPU module side.
When the start number is set, the following points are automatically occupied.
B/W: 1024 points (for MELSECNET mode)
4096 points (for MELSECNET II composite mode)
X/Y: 2048 points
Note that the actual link refresh points are the ones set for "Network range assignment" in the master
station (M) network parameter.
(c) Create a link refresh sample program using the settings in "Step 3" and "Step 4".
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9.2 Create a sample program for MELSECNET(1I) or MELSECNET/B link refresh using A/QnA -> Q conversion support tool

| Step 5: Save the program |

Confirm the save destination for the link refresh sample program.

Refresh proeram eeneration tool for MELSEGHNET{D local station |§|

L] J The following projects generation completed.
(a) ——»[ CH¥MELSEC# ARGy Support¥025H_200 ]

(a) The save destination cannot be specified by the user.
The folder name is created according to "PLC type" and "I/O number" entered in (a) and (b) of "Step 3".
(Example) When the programmable controller type is Q25H, and the 1/0 number is 200, the folder name
is "Q25H_200".
If the same folder name already exists, it is overwritten.

When creating a link refresh sample program for multiple devices that have the same
programmable controller type and 1/O number, move the project to a different location, or
rename and save the created project using GX Developer.

| Step 6: Complete the creation of sample program |

End the operation of "A/QnA -> Q conversion support tool".

ANNA->Q conversion support tool Version.1.14

| ANnA->Q program conversion support tool execute |
This tool supports AQnA->Q program conversion,

Refresh program generation tool for MELSECNET(N) local station execute |
This tool g the refresh prog for MELSECNET(ll) local station.

MELSECMNET(II)}->MELSECNET/10(H) parameter conversion tool execute

This tool converts the MELSECNET(Il->*MELSECNET/10(H) parameter and suppons A/QnA-»Q program
conversion.

ADJ2 conversion support tool execute |
This tool converts the prog of ACPU not d by GX Developer into the supported program.

The program conversion tool for AnS-Q Module Conversion Adapter execute |
Convert the XY device and No. of buffer memory with the compatible one.

COPYRIGHT(C) 2005 MITSUBISHI ELECTRIC CORPORATION ALL RIGHTS RESERVEU

(a) Select "Exit" to end the operation of the "A/QnA -> Q conversion support tool".
The "A/QnA -> Q conversion support tool" screen will close.
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9.2 Create a sample program for MELSECNET(II) or MELSECNET/B link refresh using A/QnA -> Q conversion support tool

| Step 7: Check the created sample program file |

Check the sample program file created by the "A/QnA -> Q conversion support tool".
Open the folder in which the sample program file is stored.
(Example) C\MELSEC\AQCnvSupport\Q25H_200

Address |[C3) CHMELSEC) AQChwSupportQ25H_200 4

GPpw. gpi
¥ Developer Project

_\:
File and Folder Tasks @ Ir::J Resource

@ Make a new Folder

g (@)

&3 Publish this Folder to the Gppw.gps = 4, Projectinf
wieh Gy Developer Project Setup Information

&2 share this Folder 1KE

E ProjectDE.mdb
e Microsoft Office Access Applic, ..
Other Places e TaKE

= AQCnvSuppork

| Step 8: Open the created sample program |

Start GX Developer, and open the sample program created in the "A/QnA -> Q conversion support tool".
(Example) Click Gppw.gpj in "C\MELSEC\AQCnvSupport\Q25H_200"

GRpw. O
iz Developer Project

| Step 9: Check the sample program |

Open the created sample program.
Display the statements through the View menu and check the program.
(Example) Display of program and its statements

© MELSOF | savirs G

[ webipur € 700 - [LINEiL wuddu) 075700 1 Stap]
T fuict B Pemifviecn Comwt

1.7
irwowy el B

o — - R T T DA LA A r s e A e P A b
D[ d| &) % [|@| -]~ niGin] s alnl mEe | &l =R ola G mee) s mel £]z] 0 e #nw] el
| M) [ Saves the relevant device daca in the save ares. e
B .
m o | ] sz
3 s a0
Cwvice conmand:
gw 'L A w2043
Cwvice mawery
[T
[y a2 nands
When poamrad (8, Initinlizes B/W devices.
xi01 o
1 i} [t w0 1024 E1024 1
may,
[ty pApd  o80R E4 1
[sx S0 1
{ser ex216
In cefresh ready stetus, stests cefresh.
et
17— | ] saoio
x0T
swifi x16%
188 —F— | [ser [I-IT
oy
{zuew  ou swensn Y
W teansmission(First halfliSeare ¥o.<i0, Ko. of worde=Zl
22040.0 mo
i |} [y @ w 1
WL
[ w00 GlOB4z0 31 1
¥ device LransmissioniStact No.wi0, Wo. of wocdseEl
T4 6 mo,
Prcpet | :sal_| — [om 614 af 1 &
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9.2 Create a sample program for MELSECNET(1I) or MELSECNET/B link refresh using A/QnA -> Q conversion support tool

| Step 10: Configure and write the sample program to the programmable controller CPU
Perform the following operations using GX Developer.

(a) Rename and save the sample program project.

(b) In order to use the renamed and saved sample program in the specified Q Series CPU's program file,
select "Project" -> "Copy", and paste the sample program to the "Program" of the specified Q Series CPU.

(c) Select "PLC parameter" -> "Program", and set the "Execute type" of the added program to "Scan".

(d) Write the parameters and the sequence program to the specified Q Series CPU.
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10.1 Select replacement module for DC input module

10.

Notes for selection of replacement modules

When selecting a module to be used in place of an existing module, it is necessary to check the
specifications. This section explains the notes for selection of replacement modules for major modules.
10.1 Select replacement module for DC input module
When selecting a module to be used in place of an existing DC input module, it is necessary to confirm
the working voltage and common terminal arrangement of the existing module.

(1)

3)

Rated input voltage

Most of the existing A (Large Type)/A (Small Type) modules have a rated input voltage of 5, 12 or
24 V DC.

The rated input voltage of replacement Q Series modules is 12 V DC (that of part of the modules is
50r12 V DC) or 24 V DC, and that of L Series modules is 24 V DC only. Therefore, the module to
be selected varies depending on the working condition of the existing module.

When selecting a replacement module, confirm the working condition of the existing module.

(*Excerpt from transition handbook L(NA)-08043ENG)

©: Compatible, A : Partial change required, =: Incompatible

Compat-

Specification bility Precautions for replacement
ibility

Number of input paints 32 points 32 points. o
Eholecoupier Eholgssucier
Rated input voltage 12Vi24VDC 24VDC A 12VDC are not applicable. "'
Rated input current Approx. 4mA/Apprex, 10mA Approx. 4mA A Reduced. 2
10.2 to 26.4VDC 20.4 10 28.8VDC
N "
BTSN LTI (Ripple ratic within 5%) (Ripple ratio within 5%) 4 |12VDC are nct applicabie.

Common terminal arrangement

DC input modules are available in two types: positive common and negative common. Some of the
existing A (Large Type) and A (Small Type) modules can be shared between these two types.
When selecting a replacement for such a shared type module, a positive common type or negative
common type must be selected because shared type modules are not available in Q Series.

When selecting a replacement, confirm the working condition of the existing module.

Refer to the following handbooks for detailed specifications for each module.

* Transition from MELSEC-AnS/QnAS (Large Type) Series to Q Series Handbook (Fundamentals) : L(NA)-08043ENG
* Transition from MELSEC-AnS/QnAS (Small Type) Series to Q Series Handbook (Fundamentals) : L(NA)-08219ENG
* Transition from MELSEC-AnS/QnAS (Small Type) Series to L Series Handbook (Fundamentals) : L(NA)-08258ENG
Also refer to the 1/0 Module User's Guide for the relevant module.

(*Excerpt from Building Type I/O Module User's Manual IB-66140 and Small Building
Type 1/0 Module User’s Manual IB-66541)

— —

- External -
External Internal circuit switch Internal circuit
— 1

o— R}
:
[ —20
.
o
12/24 V DC

S 10,

+
12/24V DC

Using existing wiring

(1) Terminal block type module
When replacing a terminal block type module, the existing A (Large Type) or A (Small Type)
module's terminal block can be used in the wired state by using the conversion adapter. This
eliminates the need to change the wiring.

(2) Connector type module
If the connector type on a connector type module is the same as that on the replacement
module (e.g. 40-pin connector and 40-pin connector), the existing wiring can be used.
If the connector type differs (e.g. D-sub 37-pin connector and 40-pin connector), the wiring
must be changed.
When the module is replaced with L Series, it is unnecessary to change the wiring if the D-sub
37-pin connector -> 40-pin connector conversion adapter is used.
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10.1 Select replacement module for DC input module

(1) Examples of replacement of A (Large Type) modules with Q Series modules
Replacement module

Existing module

Working conditions
Module model Working ?:rrrr:lﬁg? Module model Conversion adapter FSMarkS
Vel arrangement
AX40 24V Positive | QX40
AX40-UL (Positive common) 12V Positive | QX70 ERNT-AQTX40
Qx41 * Terminal block -> 40-pin connector
AX41 4V Posit * Rated current: Approx. 4 mA
Positi ositive
,&)8;81' j\l/Jcicommon) Qx41-S2 ERNT-AQTX41 * Terminal block -> 40-pin connector
(Positive common) * Rated current: Approx. 6 mA
12V Common | QX71 * Terminal block -> 40-pin connector
* Terminal block -> 40-pin connector
AXA1-S1 Y Positive QX41-51 * Rated current: Approx. 4 mA
(Positive common) QX41-52 ERNT-AQTX41 » Terminal block -> 40-pin connector
* Rated current: Approx. 6 mA
12V Common | QX71 * Terminal block -> 40-pin connector
QXx42
24V Positi
AX42 (Positive common) ositive QX41-S2 (2 modules required) — * Rated current: Approx. 6 mA
122V Positive | QX72
AX42-S1 (Positive common) 24V Positive | QX42-S1 —
AX50 (Positive common) Positive
AX50-S1
48V X50 ERNT-AQTX40
(Shared by positive common Common Q Q
and negative common types)
AX60 (Positive common)
AX60-S1 . * Examine whether to replace with
(Shared by positive common 100 V (No replacement model) QX40 and FA-TH16X100D31L
and negative common types)
AX70 o4V Positive | QX40-S1 ERNT-AQTX40
(Shared by positive common Negative | QX80 ERNT-AQTX80
and negative common types) | 512V | Common | QX70 ERNT-AQTX40
AX71 YR Positive | QX41-S1 ERNT-AQTX41
(Shared by positive common Negative | QX81-S2 ERNT-AQTX81 * Terminal block -> D-sub 37-pin connector
and negative common types) | 512V | Common | QX71 ERNT-AQTX41
AX80 (Negative common) 24V Negative | QX80 ERNT-AQTX80
AXBOE (Negative common) 512V | Common |QX70 ERNT-AQTX40 5V DC: AX80 only
Qxs1 * Rated current: Approx. 4 mA
Y Negati ERNT-AQTX81 e Terminal block -> D-sub 37-pin connector
AX81 egative -
(Nesgative common) 9 QX81-S2 * Rated current: Approx. 6 mA
* Terminal block -> D-sub 37-pin connector
12V Common | QX71 ERNT-AQTX41 * Terminal block -> 40-pin connector
AX81B (Shared by positive . . .
and negative common types, 24V — (No replacement model) I(E));?grq ine whether to replace with
with wire breakage detection) )
Positive | QX41-S1 ERNT-AQTX41 * Terminal block -> 40-pin connector
* Rated current: Approx. 4 mA
AX81-S1 N 24V _ Qxs1 * Terminal block -> D-sub 37-pin connector
(Shared by positive common Negative ERNT-AQTX81
and negative common types) QX81-S2 . Rate_d current: Approx. 6 mA
* Terminal block -> D-sub 37-pin connector
12V Common | QX71 ERNT-AQTX41 * Terminal block -> 40-pin connector
48 'V QX50 (2 modules required) —
AX81-S2 Neaati . Ié);?éqine (\j/vhethcﬁr to éeglice with
- egative and install an 8.2-kQ
Negat
(Negative common) 60V (No replacement model) resistor (1 W or more) in series
on the external signal line.
aQxsi * Rated current: Approx. 4 mA
Y Negati ERNT-AQTX81 e Terminal block -> D-sub 37-pin connector
AX81-S3 egative a
(Negative common) QXx81-s2 ¢ Rated current: Approx. 6 mA
* Terminal block -> D-sub 37-pin connector
12V Common | QX71 ERNT-AQTX41 » Terminal block -> 40-pin connector
axe2 * Rated current: Approx. 4 mA
AX82 24V Negative . * D-sub 37-pin connector -> 40-pin connector
(Negative common) QX81-S2 (2 modules required) * Rated current: Approx. 6 mA
12V Common | QX72  D-sub 37-pin connector -> 40-pin connector

181




10.1 Select replacement module for DC input module

(2) Examples of replacement of A (Small Type) modules with Q Series modules

Replacement module

Existing module

Working conditions

i Remarks
. Common Conversion
Module model Wchlng psi Module model adapter
voltage arrangement
PR Positive | QX40 ERNT-ASQTX40
A1SX30 Negative | QX80 ERNT-ASQTX80
(Shared by positive common 12V Common | QX70 ERNT-ASQTX40
and negative common types) Examine whether to in
_ put to QX40 after
1224 VAC (No replacement model) externally rectifying and smoothing 24 VV AC.
A1SX40 24V Positive | QX40
o ERNT-ASQTX4
(Positive common) 12V Common | QX70 SQATX40
A1SX40-S1 (Positive common) 24V Positive | QX40-S1 ERNT-ASQTX40
A18X40-S2 (Positive common) 24V Positive | QX40 ERNT-ASQTX40
" QX41 » Rated current: Approx. 4 mA
24V Posit
A1SX41 (Positive common) ostive QX41-82 — * Rated current: Approx. 6 mA
12V Positive | QX71
A1SX41-S1 (Positive common) 24V Positive | QX41-S1 —
. . QX41 * Rated current: Approx. 4 mA
A1SX41-S2 (Posit 24V Posit —
S S2 (Positive common) ostive QX41-82 * Rated current: Approx. 6 mA
. QXx42
A1SX42 (Positive common) 24V Positive QX41-S2 (2 modules required) — * Rated current: Approx. 6 mA
122V Positive | QX72
A1SX42-S1 (Positive common) 24V Positive | QX42-S1 —
A1SX42-S2 . QXx42
(Positive common) 24V Positive QX41-52 (2 modules required) - * Rated current: Approx. 6 mA
Positive QX41-S1 * Rated current: Approx. 4 mA
A1SX71 » 24V QX41-82 * Rated current: Approx. 6 mA
(Shared by positive common - S — T -
and negative common types) Negative | QX81-S2 40-pin connector -> D-sub 37-pin connector
5112V Common | QX71
A1SX80 PR Positive | QX40 ERNT-ASQTX40
(Shared by positive common Negative | QX80 ERNT-ASQTX80
and negative common types) 12V Common | QX70 ERNT-ASQTX40
A1SX80-S1 and A1SX80-S2 Positive | QX40 ERNT-ASQTX40
(Shared by positive common 24V
and negative common types) Negative | QX80 ERNT-ASQTX80
A1SX81 o4V Positive | QX41-82
(Shared by positive common Negative | QX81-S2 —
and negative common types) 12V Common | QX71
A1SX81-S2 Positive | QX41-S2  D-sub 37-pin connector -> 40-pin connector
(Shared by positive common 24V —
and negative common types) Negative | QX81-S2 * Rated current: Approx. 6 mA
A1SX82-S1 Positive | QX42
(Shared by positive common 24V —
and negative common types) Negative | QX82-S1
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10.1 Select replacement module for DC input module

(3) Examples of replacement of A (Small Type) modules with L Series modules

Existing module Replacement module
Working conditions
i Remarks
Module model Working | Gommon Module model Cor:jvertsmn
S~ terminal adapter
9 arrangement
24vDC |2V 1) yan0cs -
A1SX30 Negative -
(Shared by positive common 12V DC | Common (No replacement model)
and negative common types) Examine whether to in
_ put to LX40C6 after
12/24 VAC (No replacement model) externally rectifying and smoothing 24 V AC.
. 24V DC Positive | LX40C6 \ ERNT-ASLTX40
A1SX40 (Positive common) 12V DC — (No replacement model)
A1SX40-S1 and A1SX40-S2 .
(Positive common) 24V DC Positive | LX40C6 ERNT-ASLTX40
. 24V DC Positive | LX41C4 —
A1SX41 (Positive common) 12V DC Positive (No replacement model)

A1SX41-S1 and A1SX41-S2

(Positive common) 24V DC Positive | LX41C4 —

24V DC Positive | LX42C4 —
12V DC Positive (No replacement model)

24V DC Positive | LX42C4 -

A1SX42 (Positive common)

A1SX42-S1 and A1SX42-S2
(Positive common)

A1SXT1 . 24V DC | Common |LX41C4 -

(Shared by positive common

and negative common types) | 5/12 V DC — (No replacement model)

A15X80 (-S1 and S2) 24V DC | Common |LX40C6 ‘ ERNT-ASLTXY80

(Shared by positive common

and negative common types) | 12V DC - (No replacement model)

A15X81 24V DC | Common |LX41C4 ‘ ERNT-ASLCXY81 | e D-sub 37-pin connector -> 40-pin connector
(Shared by positive common

and negative common types) | 12V DC - (No replacement model)

A1SX81-S1 and A1SX81-S2

(Shared by positive common 24V DC | Common |LX41C4 ERNT-ASLCXY81 | e D-sub 37-pin connector -> 40-pin connector
and negative common types)

A1SX82-S1

(Shared by positive common 24V DC | Common |LX42C4 —

and negative common types)

® Example of selection of replacement for AX71
Although AX71 can be shared by 5/12/24-V DC positive and negative common types, the module to
be selected as a replacement varies depending on the working condition.
It is necessary to confirm the current working condition and select an appropriate one.

(1) Comparison of specifications for AX71 and replacement modules

Specification | AX71 | QX71 | QX41-S2 | QX81-S2
Number of input points 32 points 32 points 32 points 32 points
Rated input voltage 5V DC/12V DC/24 V DC 5V DC/12V DC 24V DC 24V DC

3.5 mA/2 mA/4.5 mA (TYP), | 5V DC: approx. 1.2 mA

Rated input current 5.5 mA/3 mA/6 mA (MAX) | 12 V DC: approx. 3.3 mA Approx. 6 mA Approx. 6 mA
45to6V DC
. 45105.5V DC (SWON), (Ripple ratio within 5%) 20.4t028.8V DC 20.4t028.8V DC
Working voltage range | 14’54, 56 4 v DC (SW OFF) 10.2t0 14.4 V DC (Ripple ratio within 5%) | (Ripple ratio within 5%)

(Ripple ratio within 5%)
Shared by positive and Shared by positive and
negative common types | negative common types

Common terminal Positive common type Negative common type

arrangement 8 points/common terminal | 32 points/common terminal | 32 points/common terminal | 32 points/common terminal
External connection 38-point terminal block connector 40-pin connector 40-pin connector D-sub 37-pin connector
method (M3 x 6 screws) (optional) (optional) (optional)
Conversion adapter "' — ERNT-AQTX41 ERNT-AQTX41 ERNT-AQTX81

*1: Wiring conversion adapter manufactured by Mitsubishi Electric Engineering Co., Ltd.
The terminal block for AX71 with the existing wiring can be used by using the conversion adapter.
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10.2 Notes for selection of replacement for Triac output module AY22

10.2 Notes for selection of replacement for Triac output module AY22
Although QY22 can be selected as a replacement module for AY22, the modules partially differ in
specifications, and the maximum load current of QY22 is lower. Therefore, it is necessary to confirm
whether the existing connected devices meet the maximum load current specification.

(1) Comparison of specifications between AY22 and QY22 (excerpt from transition handbook)

O: Compatible, 2A: Partially changed, x: Incompatible

Specification | | Compatibility | Notes for replacement
Number of . .
output points 16 points 16 points O
Insulation
method Photocoupler Photocoupler O
Rated load 100-240 V AC 100-240 V AC O
voltage 50/60 Hz +5% 50/60 Hz +5%
Max. load
voltage 264V AC 264 V AC O
Since the maximum load
Max. load 2 A/point, 0.6 A/point, A current per point has been
current 3.3 A/common terminal 4.8 A/common terminal reduced, carefully select the
usage load.

(2) Selection examples
(1) When the load capacity of externally connected device is 0.6 A or less
Select the Triac output module QY22 as a replacement module, and utilize the wiring of the
existing module terminal block by using the conversion adapter ERNT-AQTY22.

Power
supply| ACPU | AY22 | AY22
module

A35B

Replacement example

Y22 Y22
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10.2 Notes for selection of replacement for Triac output module AY22

(2) When the load capacity of externally connected device is 0.6 Ato 1 A
Select the transistor output module QY40P/QY41P as a replacement module, and externally
provide the FA goods manufactured by Mitsubishi Electric Engineering Co., Ltd. to increase the

load capacity.

Power
supply | ACPU | AY22 | AY22

module

A35B I
‘ Replacement example(1) ‘ Replacement example(2)
Power (QCPU| QY40P | QY40P Power |QCPU| QY41P |Empty
supply supply
module H U module H
Q358 I:A-CBL**Tl\/lvzo Q358 FA-CBL#**FM2V
FA-TH16YSR11S e FA-TH16YSR11S

FA-CBL**TMV20
) FA-TH16YSR11S s FA-TH16YSR11S

(3) When the load capacity of externally connected device is 1 A or more and Triac output is
necessary for reasons of specifications
Select the transistor output module QY40P/QY41P as a replacement module, and externally
provide a commercially available Triac conversion terminal module to increase the load

capacity. (We do not introduce any product.)

(4) When the load capacity of externally connected device is 1 A or more and a change to relay

output can be made for reasons of specifications
Select QY10 as a replacement module, and use the conversion adapter ERNT-AQTY10 to use

the existing module terminal block without modifying the wiring.

Power
supply | ACPU | AY22 | AY22
module

A35B

Replacement example

Q358 AQT | AQT
Yio | Y10
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11.1 CPUs compatible with networks (MELSECNET(1I), MELSECNET/10 and MELSECNET/H)

Wr replacement of network (MELSECNET(II))

11.1 CPUs compatible with networks (MELSECNET(11), MELSECNET/10 and
MELSECNET/H)
This section shows the CPU types compatible with the network (MELSECNET(1I), MELSECNET/10 or
MELSECNET/H) to be configured and the combinations of CPU types.

11.1.1 System configuration for MELSECNET/10 and MELSECNET/H (PLC to PLC network)

The following table shows the CPU types that are compatible with MELSECNET/10 and
MELSECNET/H (PLC to PLC network) network systems.

Normal station*!

Control station AnA, AnN,
AnS(H)

MELSECNET/10 mode O O O O

MELSECNET/H mode O
Q (Q Mode) | (10 Mbps)
MELSECNET/H mode O
(25 Mbps)
O
O

QnA (MELSECNET/10 mode) O O O
AnU, Q (A Mode) *

(MELSECNET/10 mode) O O O
AnA, AnN, AnS(H)** X

O: Compatible, X: Not compatible

*1: Cannot be mixed with a remote 1/O station.
*2: Restrictions may apply to the B/W link range depending on the CPU type
AnA : B/W0O0O to FFF
AnN, AnS(H): B/W000 to 3FF
*3: CPUs other than Q Series CPU (Q mode) cannot be combined because a network system can be
configured with Q Series CPU (Q mode) only.
*4: Cannot be a control station.
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11.1 CPUs compatible with networks (MELSECNET(II), MELSECNET/10 and MELSECNET/H)

11.1.2 System configuration for existing MELSECNET(II) in combination with Q Series CPU
The following table shows combinations of Q Series CPU with the existing MELSECNET(II) data link systems.

Local station/Remote /O station

Masterstation Pe(r?o(rﬂgrrlce Q?U(:\?:ir(s:a:?ﬁ?;?el) I/ge;acﬁgn
model) (AJ72P25)
Q (High Performance model)*! X
Q (Basic model)*" X
Q (Universal model)*! X
MELSECNET II VAN A*3 O %
g::" AnU. T MELSECNET It composite Aw Ax O O
MELSECNET VAN N O O
MELSECNET I1*5 X
AnN, AnS(H) | MELSECNET II composite*® X
MELSECNET N ~ 0 \ O

O: Applicable, A: Applicable (with restrictions), X: Not applicable

*1: Cannot be a master station.

*2: Can be combined with data link system when a local station module (such as A1SJ71AP23Q) is
mounted on the extension base unit (QA1S6C1B).

*3: Can be combined with data link system when a local station module (such as A1SJ71AP23Q) is
mounted on the extension base unit (QA1S60B).
However, the extension base unit (QA1S6L1B) cannot be connected to the basic model QCPU.

*4: Alocal station and a remote 1/O station can be mixed in the data link system.

*5: MELSECNET II mode and MELSECNET II composite mode are not supported.

11.1.3 System configuration for MELSECNET/10 and MELSECNET/H (remote I/O network)
The following table shows the CPU types that are compatible with MELSECNET/10 and MELSECNET/H
(remote I/O network) network systems. (The listed network modules are for optical loop. For coaxial loop and
coaxial bus, use their respective modules)

Master station Remote /O station (compatible network module)

Network module/
Data link module

QJ72LP25-25 | A(1S)J72QLP25 | A(1S)J72LP25 | A(1S)J72P25

Q (Other than basic model) | QJ71LP21-25 @) X X
Q (Basic model) QJ71LP21-25 X X X
A(1S)J71QLP21 X O X
QnA
A(1S)J71AP21*! X X O
AnU. Q (A mod A(1S)J71LP21 X*3 O X
nU, mode
( ) A(1S)J71AP21*1 X X O
A(1S)J71LP21*2 X X X
AnA, AnN, AnS(H)
A(1S)J71AP21*! X X O

O: Compatible, X: Not compatible

*1: Module for MELSECNET(II) data link system.

*2: Compatible with normal station only.

*3: A module with a five digits of serial No. 15012 or higher can be used by setting it to the
MELSECNET/10 mode.
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11.1 CPUs compatible with networks (MELSECNET(1I), MELSECNET/10 and MELSECNET/H)

11.1.4 System configuration for redundant system network
(1) System configuration for MELSECNET/10 and MELSECNET/H (PLC to PLC network) network systems
The following table shows combinations of MELSECNET/10 and MELSECNET/H (PLC to PLC network)
network systems with redundant systems.

Normal station

Control station

MELSECNET/H mode @) O X X X
Redundant
MELSECNET/10 mode O
Q MELSECNET/H mode O ) x x | X
Standalone MELSECNET/10 mode O
Q4AR Redundant O
Standalone O
QnA, AnU*! X O X O O
AnA, AnN, AnS(H)*2 X

O: Applicable, X: Not applicable

*1: Cannot be configured for redundant systems.
*2: Cannot be a control station.

(2) System configuration for MELSECNET/10 and MELSECNET/H (remote I/0O network) network systems
The following table shows combinations of MELSECNET/10 and MELSECNET/H (remote I/O network)
network systems with redundant systems. (The network modules listed are optical loop modules. For
coaxial loop, coaxial bus, and twisted bus, replace with the appropriate modules.)

(Example)
Master station Remote 1I/O station (compatible network module)
Network module QJ72LP25-25 A(1S)J72QLP25 A(1S)J72LP25 A(1S)J72P25
QnPRH QJ71LP21-25 O X X
AJ71LP21*! -
Q4AR AJ71QLP21 X | O | X

O: Applicable, X: Not applicable
*1: Cannot be combined with Q4ARCPU.
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Warranty

Please confirm the following product warranty details before using this product.

1. Gratis Warranty Term and Gratis Warranty Range

If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of
the product within the gratis warranty term, the product shall be repaired at no cost via the sales
representative or Mitsubishi Service Company.

However, if repairs are required onsite at domestic or overseas location, expenses to send an engineer will
be solely at the customer's discretion. Mitsubishi shall not be held responsible for any re-commissioning,
maintenance, or testing on-site that involves replacement of the failed module.

[Gratis Warranty Term]
The gratis warranty term of the product shall be for three years after the date of purchase or delivery to a
designated place.
Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6)
months, and the longest gratis warranty term after manufacturing shall be fourty-two (42) months. The
gratis warranty term of repair parts shall not exceed the gratis warranty term before repairs.

[Gratis Warranty Range]

(1) As a principle, the primary fault diagnosis must be preformed by the user.
If requested by the client, Mitsubishi or Mitsubishi's service network can perform the work for a fee. In
this case, if Mitsubishi is found at fault for the cause of the fault, the service will be performed for free.

(2) The range shall be limited to normal use within the usage state, usage methods and usage
environment, etc., which follow the conditions and precautions, etc., given in the instruction manual,
user's manual and caution labels on the product.

(3) Even within the gratis warranty term, repairs shall be charged for in the following cases.

1.

2.
3. When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided

Failure occurring from inappropriate storage or handling, carelessness or negligence by the user.
Failure caused by the user's hardware or software design.
Failure caused by unapproved modifications, etc., to the product by the user.

if functions or structures, judged as necessary in the legal safety measures the user's device is
subject to or as necessary by industry standards, had been provided.

. Failure that could have been avoided if consumable parts designated in the instruction manual had

been correctly serviced or replaced.

. Replacement of consumable parts (battery, relay, fuse, etc.).
. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused

by force majeure such as earthquakes, lightning, wind and water damage.

. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from

Mitsubishi.

. Any other failure found not to be the responsibility of Mitsubishi or that admitted not to be so by the

user.

2. Onerous repair term after discontinuation of production
(1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is

discontinued.
Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.
(2) Product supply (including repair parts) is not available after production is discontinued.

3. Overseas service
Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions
at each FA Center may differ.

4. Exclusion of loss in opportunity and secondary loss from warranty liability
Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation of damages caused by

any cause found not to be the responsibility of Mitsubishi, loss in opportunity, lost profits incurred to the user
by Failures of Mitsubishi products, special damages and secondary damages whether foreseeable or not,
compensation for accidents, and compensation for damages to products other than Mitsubishi products,
replacement by the user, maintenance of on-site equipment, start-up test run and other tasks.

5. Changes in product specifications
The specifications given in the catalogs, manuals or technical documents are subject to change without prior

notice.
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Precautions before use

This publication explains the typical features and functions of the products herein and
does not provide restrictions and other information related to usage and module
combinations. Before using the products, always read the product user manuals.
Mitsubishi Electric will not be held liable for damage caused by factors found not to be
the cause of Mitsubishi Electric; opportunity loss or lost profits caused by faults in
Mitsubishi Electric products; damage, secondary damage, or accident compensation,
whether foreseeable or not, caused by special factors; damage to products other than
Mitsubishi Electric products; and to other duties.
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/\ For safe use

 To use the products given in this publication properly, always read the relevant manuals
before use.

* The products have been manufactured as general-purpose parts for general industries,
and have not been designed or manufactured to be incorporated in a device or system
used in purposes related to human life.

» Before using the products for special purposes such as nuclear power, electric power,
aerospace, medicine or passenger movement vehicles, consult with Mitsubishi.

* The products have been manufactured under strict quality control. However, when
installing the products where major accidents or losses could occur if the products fail,
install appropriate backup or fail-safe functions in the system.




Mitsubishi Electric Programmable Controllers
MELSEC-A/QnA Series Transition Examples
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